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Chapter 1
1.1

Software Installation & Hardware Setting

Installing the Win-GRAF Workbench

Before installing the Win-GRAF Workbench, check the installation environment on your PC.
System requirements:
 O.S.: Windows XP, Windows Vista, Windows 7, Windows 8 (32-bits or 64-bits)
 Microsoft .Net Framework 3.5 (Download it on the Microsoft web site:
http://www.microsoft.com/zh-tw/download/details.aspx?id=22)
 RAM: 1 GB minimum (Recommended: 2 GB or more)
 Available hard-disk space: 200 MB minimum

Installation Steps:
1. Double-click the “Win-GRAF-setup-ver-x.xx.exe” file in the Win-GRAF installation CD (or download
the latest version of the Win-GRAF Workbench on the website: http://www.icpdas.com/root/
product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html) to begin the
process.

2. Click “Next” to continue and then select “I accept the agreement”, then click “Next” to continue.
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3. Recommend to use the default installation path (i.e., “C:\Win-GRAF”) and then click “Next” to
continue.

4. Click “Next” to add a “Win-GRAF” folder shortcut in the “Start” menu, and then select “Create a
desktop icon” to add a desktop shortcut, then click “Next” to continue.
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5. Click “Install” to begin installing the Win-GRAF Workbench.

6. Before the end of the installation, you will see a pop up window and it displays:
a. The legal Win-GRAF Workbench is delivered with a legal Win-GRAF Dongle distributed by ICP DAS.
Please always plug the Win-GRAF Dongle in your PC while running it.
b. To run the Win-GRAF, require Microsoft “.Net FrameWork 3.5” installed in your PC.
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7. By now, you have completed the Win-GRAF installation, then click “Finish” to exit this window.
(Select “Launch Win-GRAF” to auto-run the Win-GRAF after completing the setup. If there is no
Win-GRAF Dongle in your PC, the Win-GRAF Workbench will run in Demo mode.)

1.2

Run the Win-GRAF Workbench

Before running the Win-GRAF Workbench, make sure the Win-GRAF Dongle is plugged into your PC.
Without using a Win-GRAF Dongle, the Win-GRAF Workbench will run in Demo Mode. Open the
Windows Start menu, click on “Win-GRAF” folder and “Win-GRAF” to open this software.

Description of the “Win-GRAF” folder:
Libraries: For users to create their own function or modify an exist function.
Handbook: The manual details the software interface, programming environment, programming
languages, and so on, provided by COPALP.
(Or click the [Help] > [Topics] from the Win-GRAF menu bar)
History:
The modification history and features added of the Win-GRAF Workbench.
Manual: The Win-GRAF manual provided by ICP DAS.
(Or click the [Help] > [Tutorials] from the Win-GRAF menu bar,
the manual is located in the path “C:\Win-GRAF\Tutorials”)
ReadMe: The notice for the Win-GRAF Workbench.
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1.2.1

Win-GRAF Operating Mode

The Win-GRAF Workbench provides two operating modes:
“Demo Mode”: Without using a Win-GRAF Dongle. The compiled Win-GRAF project can run for 15
minutes in the PAC. Once the time limit has expired, users must Stop/Start this
project again and it only supports up to 40 I/O tags.
“Large Mode”: Using a Win-GRAF Dongle. The project can run in the PAC without the time limit.
Demo Mode - Without using a Win-GRAF Dongle.
The start screen will show as below after running the Win-GRAF Workbench.

No Win-GRAF Dongle found. Demo mode!

It describes the limitations in
demo mode, you can also
click the main menu [Help] >
[About] to see this content.

Note: If you install the Win-GRAF Dongle in the Demo Mode, you must close Win-GRAF Workbench and
then start it again to make it become Large Mode.
Large Mode - Using a Win-GRAF Dongle.
The start screen will show as below after running the Win-GRAF Workbench.
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1.2.2

Win-GRAF Operating Environment

Run the Win-GRAF and then the main screen will show as below:

Menu / Tool bar
Right-click
B

Program Area
A

Workspace

C

Message Area

Note: Mouse right-click on the top of the Window to Show/Hide the menu bar.
A. The Workspace:

It allows users to create project lists, and add/open the Win-GRAF program as
well as the related settings. Moreover, the new project can be created by using a
project template.
B. The Program Area: It used to show/edit the program and can be divided into more function area.
(Refer the Section 2.2.1)
C. The Message Area: It used to show compiler messages and provides more diagnostic tools.

Tips:
1. To resize a window, click and drag the side or corner of the window to change its size.
2. Press the “F1” key to open the user manual (i.e., HTML Help).
Hind or Show the window
If you carelessly closed the Variables pane or the Message Area during the programming, you can click
the menu bar "View" and select the following options to open this window again.

Output:
It means the Message Area.
Infos Tab1: It means the Program Area – Variables pane (refer the Section 2.2.1).
Infos Tab2: It means the Program Area - Function Blocks pane (refer the Section 2.2.1).
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1.2.3

Win-GRAF Library Manager

Win-GRAF Workbench provides a Library Manager that can be used to look up all descriptions for
Functions, Function Blocks and I/O Boards. The user can refer Section 11.1 to upgrade the Win-GRAF Lib.
1. To begin this, click the Start button and click "All Programs" > "Win-GRAF" > "Libraries" > “OEM”.

2. In the “Library Manager” window, click the menu bar “File” > “Open Library” and select “ICP DAS –
XP-WP-VP” then click “OK”.
3. Select any title in the “Function and FBs” tab and click the “Description” to view the usage of this
Function or Function Block; Select any title in the “I/Os” tab and click the “Description” to view the
usage of this I/O Boards.
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1.3

Setting the Win-GRAF PAC’s IP Address

For connecting with the PAC, the Win-GRAF Workbench needs to know the PAC IP. The following will
show you how to set up the PAC IP. Using the XPAC (XP-8xx8-CE6, XP-9xx8-CE6) and the WinPAC
(WP-8xx8, WP-5xx8) as the example:
Hardware Wiring Diagram

PAC Side
Using the USB mouse that connected to the PAC, and click “Start” > “Settings” > “Network and Dial-up
Connections” on the lower left corner of the monitor, then double-click the “LAN1” (or LAN2), then fill in
a proper IP address.

2

3

1

Click to use the keyboard
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Open the “WinPAC_Utility.exe” (or “XPAC_Utility.exe”) on the desktop (or \System Disk\tools\).Then,
click “File” > “Save and Reboot” to reboot the PAC.
Notice:
For connecting properly, the PC/Win-GRAF IP and the PAC IP must on the same network segment.
For example, set the PC’s IP to “192.168.1.20” (Mask: 255.255.255.0).
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Chapter 2
2.1

A Simple Win-GRAF Program

Creating a New Win-GRAF Project

The following sections will introduce you to a simple template project that used to get/set (read/write)
the Win-GRAF PAC‘s system time. Follow the steps below to complete this demo program.

2.1.1

Creating a Template Project (Demo01)

1. Run the Win-GRAF Workbench (refer the Section 1.2), and click "File / Add New Project..." from the
menu bar.

2. Click “From template” to create a project from a template, enter a project name (e.g., "Demo01") in
the Name field and add a simple note in the Comment field, then click "Next". By default, it will
show a "ICPDAS_template" option provided by Win-GRAF Workbench, just click "Next" to continue.

Recommend to use the default folder.
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3. Now, you have created the “Demo01” template project.

Note: In the demo01, we use a “From template” way to create this project. If you select "Project" in the
step2, click the "Release" in the “Compiling options" setting. The others setting can be done in
the following sections, just click "Next" and then "OK" button to end the settings.

“PAC IP:502”,
See Section 2.3.5
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2.1.2

Important Project Settings

There are two important settings must be done after creating the project.
1. In the "Workspace", mouse right-click the project name (e.g., "Demo01") and then uncheck the
"Alphanumeric Sorting" option (the last one). If unchecked, means the programs are in execution
order ; If checked, means the programs are in alphanumeric order (e.g., FBD1, LD1, ST1).

Right-click

Unchecked,
In execution order

Checked,
In alphanumeric order

Change the execution order of programs:
Note: If you want to change the execution order of programs, mouse right-click the project name
(e.g., "Demo01") and click "Cycle" (as the screenshot above) to open the settings window,
then click the "Move Up" or "Move Down" button to change the order.

2. If using the "Project" way to create a new project (in this example, we use the “From template” way,
refer the Section 2.1.1 - Step 2), click the"Project" > "Settings..." from the menu bar to open the
"Project settings" window. Click the "General" option and set the "Complex variables in a separate
segment" to "Yes" to allow the using of complex data structures, such as arrays. Finally, click "OK" to
exit the window.
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(Note: The "Code Generation" must be set to "Release".)
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2.2
2.2.1

Introduction of the Project
Demo01 - LD Program

This program is used to read/write the Win-GRAF PAC‘s system time. In the Workspace, double-click the
LD program name (i.e., “PAC_Time") to open all relevant windows. As the screenshot below, the
Program Area has three main parts:

Program Area

B. Variables
Area

Note:
, means the
program is locked and
cannot be deleted.

A. Program Editor
Area (LD)

C. Function
Blocks Area

Tips: Mouse click the Program Editor Area, and press the "+“ or “-” key to zoom in or zoom out the
content.

(E.g., press "-” key twice to
zoom out the content.)

A. Program Editor Area (LD):
This area allows to edit or display this LD program, you can click the object button (on the left of
Program Area) to add a program, and then drag-and-drop variables (in the Variables Area) onto the
function block one-by-one.
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R1: Get current time of the PAC

R2: Set “Set_new_time” to “True” to set the new time

R3: Reset it to “False”
B. Variables Area:
This area shows the function blocks and variables that used in this program. Mouse double-click the
“Name” or “Type” item to modify its name or data type, then click “Enter” to complete the setting.
(Refer the Section 2.3.1 for the details about variable declaration.)
Note: For the function block can work correctly, the
“Inst_xxx..” FB instance variable will be automatically
added when using one function block. For the safety
reasons, this FB instance variable will not be automatically
deleted even if the function block has been removed in the
editor area. So, users can right-click the unwanted variable
and select “Clear” to manually remove it.

FB instance variable
variable

C. Function Blocks Area:
In the “Blocks” tab, it provides many types of the function block for users to drag and drop them to
the editor area.

Tips:
After selecting the function
block, press “F1” key to open
the HTML Help.
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2.2.2

Demo01 - Variables

In the workspace, mouse double-click the “Variables” item to open the Variables window. The following
screenshot shows all the needed and defined variables in this “Demo01” project.

Click it to sort by name.

Tips: In the Variables window, users can click any title field (e.g., “Name”) for sorting.
If you want to go back to the original sort order, mouse right-click anywhere and select the
“Cancel Sorting” option.

Field description: (Press the “F1” key to look up the details)
Mouse double-click any field item to set or modify the data.
Name:

A valid variable name starts with a letter (e.g., "A to Z" or "a to z") followed by any
number of letters, numbers (e.g., "0 to 9"), or an underscore (i.e., “_”).
Type:
Data type. (Refer the Appendix A for the value range)
Dim.:
To specify the range of an array.
(E.g., enter “10”, means the use of the Counter [0] to [9]).
Attrib.:
Double-click this field item to set it to “Read Olny” that means users can only read this
variable but cannot modify it.
Syb.:
If checked, the variable name will also be downloaded into the PAC.
Init value:
To set the initial value of the variable.
User Group: All the variables can be divided into some groups (e.g., “Group1”, “Group2”) and it is
convenient for users to look up or search these variables.
Tag:
To enter a nickname for the variable.
Description: To enter a simple note for the variable.
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2.3

Give it a Try

As mentioned before, we have described the LD program (Section 2.2.1) and variables (Section 2.2.2) in
the "Demo01” project. The following sections will show you how to declare variables and add an LD
program with the blinking function in this project.
Note: All the Win-GRAF PAC does not support the “ULINT” and “LWORD” data type.

2.3.1

Declaring the Win-GRAF Project Variables

First, we will declare two boolean variables (i.e., "LED1" and "LED2") that used in the program.
1. In the “Variables” window, mouse right-click any item in the “Name” field and select “Add Variable”
(or press the "Ins" key or click the

tool button) to add a variable.

2. Double-click the new “NewVar” item and change its name to “LED1”, then click “Enter” to finish the
setting. In this case, the data type is "BOOL".

Note: The settings will be done only after clicking the “Enter” key.
3. Follow the previous steps to add the “LED2” boolean variable.

Tips: To set up multiple ordinal variables, enter the name “LED” (as the step2) and then press “Ctrl+C”
and “Ctrl+V” twice to create “LED1” and “LED2” (auto sequential numbering), finally, delete the
first variable (i.e., “LED”).
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Tip #2:
1. If you need to add multiple variables (e.g., “Boo_01 to Boo_16”), simply right-click the “Global
variables” and select the “Add Multi Variables”.

Mouse right-click

2. Follow the settings like the figure below (Name: “Bool_%%”; Type: “BOOL”; From: 1; To: 16) to
create Boolean variables (i.e., “Bool_01” to “Boo_16”) and then click “Create all” button to complete
the settings.
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2.3.2

Declaring the I/O Variables

In this example, the I-8055W module that used to show the blinking feature must be plugged in the
PAC‘s slot1. So, we need to add an I/O link to correspond to the real I/O module.
1. Click the "Open I/Os" tool button to add an I/O link.

2. Mouse double-click on "Slot 1” and then double-click the "i_8055" to select this I/O board.

3. Click the “Close” button to exit the “I/O Boards” window.
Note: Click the “Virtual/Real” button to change to the Virtual l/O (for testing) or the Real I/O.
(The Real I/O is used in this example).

Virtual I/O: (It shows in blue)

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

2-10

After linking the “i_8055” I/O board, it will automatically add 8 input & output variables in the
“Variables” window.

%IX1.0 – i_8055_DI

%QX1.1 – i_8055_DO

“I” means “Input”
“X” means “Boolean”
“1” means “Slot 1”

“Q” means “Output”
“X” means “Boolean”
“1” means “Slot 1”

%ID or %QD
“D” means “Integer/Real”
There are three output variables are used in this example, and you can modify the name for easy use.
Mouse double-click the item and fill in a name, then press “Enter” key to finish the setting.
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2.3.3

Creating an LD Program

In the “Demo01” project, we want to create a “LD1” program to show the blinking. To begin, follow
these steps:
1. In the workspace, mouse right-click the “Programs” folder and select “Insert New Program…”.

2. Fill in a program name in the “Name” field and enter a simple note in the “Description” field, and
then select the “LD – Ladder Diagram” as the programming language and click the “OK” button.

3. Double-click the “LD1” program to open the editor window.
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4. Click the “Insert FB..” button on the left of the “LD1” window to add a function block.

Tips:
You can also drag and drop
the “BLINK” function block
into the “LD1” window.

5. Double-click this function block and select the “BLINK”, then
click the “OK” button.

Tips:
You can press the “BL” key
to quickly find out the name.

Tips: (Refer Section 2.2.1 – B)
Click the upper area, to change a FB instance variable.
Click the lower area, to change a function block.
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Important Notice:
When programming, users may copy & paste an existing function block to create a new one. But,
this way will cause a function exception due to the same function instances. Therefore, users must
create a new name for the function instance.
1. Mouse double-click the function block and enter a new name (e.g., “Inst_BLINK1”), then click the
button to complete the setting.

1

2. In the “Inst_BLINK1” window, click “Yes” to create this function instance.

2

Tips:
You can also use the same way to
double-click on the right-side of the
“Coil” to create or assign a variable.
(See Step7)

3. Now, there is an “Inst_BLINK1” function instance added in the Variables Area.

3
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6. Click the “Coil” on the right of the “BLINK” function block, and continuously click the “Insert Coil”
button to add four “Coil”.

1

Tips: press the “+” key to zoom in the content.

2

7. Mouse double-click the first “Coil” and double-click “LED1” to assign it. Follow the same way to
assign the “LED2” variable to the second “Coil”.

8. As the screenshot below, mouse drag-and-drop the “Output1”, “Output2” and “Output3” variables
to the 3th, 4th and 5th “Coil”.
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9. Mouse double-click on the left of the “CYCLE” and enter “T#2S” (to blink every two seconds), and
then click

to finish the setting.

10. Finally, click the “Save” button to save the “LD1” program.

Note: “

” means this program is opened (locked, cannot be deleted). Click the “X” in upper-right

corner of window to close this program (un-locked, “

”).

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

2-16

If you want to add a program to the first line after completing the programming, follow these steps:
1. Click the upper-left corner of the Program Editor Area, and you will see the selectable items on the
Object bar. Select an object (4 to 7, as the screenshot below) to add a program to the first line.
Note: You can also select an object (1 to 3) to add it on the left of the current program.

Add a object on the left of the current program:
1. Insert contact before (shift + F4)
2. Insert horizontal line (shift + space)
3. Insert FB before (shift + F8)

Add a object on the left of the program:
4. Insert jump (shift + F9)
5. Insert Coil (F9)
6. Insert new rung
7. Insert commecnt line

2. In this case, click “Insert new rung” to add it to the first line.
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2.3.4

Compiling the Program

In the previous section, we have added and saved the LD program. For the Win-GRAF project can
function properly in the PAC, we need to compile the programs. To begin, follow these steps:
1. On the menu bar, click “Project > Build All Projects” to compile all programs.

2. If a “No error detected” message is appear that means the project was successfully compiled.
Note: If you modify and save the program after compiling it, click the “Clean All Projects” to clean
the previous results and then do the step1 again.

Check to see if there is any
error message here.

If the Win-GRAF is running in Demo
Mode, this message means the
Win-GRAF project can run for up to
15 minutes in the PAC.
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2.3.5

Download the Program to PAC

Before downloading the program, you need to set up the communication parameters. (By now, it only
supports the Ethernet TCP/IP).
1. Mouse right-click the project name (i.e., "Demo01") and select “Communication Parameters…” to
open the settings window.

2. Enter the “PAC IP:502” (e.g., “192.168.255.1:502”) to add an IP address and then click “OK”.
It can also click the
button to add/modify the IP address.
(Note: the default PAC IP is “192.168.255.1” and the fixed port number of Win-GRAF PAC is “502”)

Tips: All the configured IP will be listed here. You
can select the unwanted IP and press “Del” key to
delete it (e.g., “192.168.78.8: 502”).

3. Before establishing a connection, make sure the PAC and the network are working properly.
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4. Click the menu bar “Project” and select “On Line”, or click the
connection.

tool button to establish a

5. As the screenshot, if it shows “App: TEST”, different to the current project name (i.e., “Demo01”),
that means there is a project (name: “TEST”) running in the PAC. Click “Stop application” tool button
to stop the “TEST” project.

6. Click the “Download” tool button to download the “Demo01” project.

7. If it shows “RUN” that means the "Demo01" project is successfully running in the PAC.

It shows the current
time of the PAC.
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Note: If there is any error message show up during the download process, refer the Appendix B to get
the solution.
Cycle time
When on-line with the PAC, move your mouse over the “RUN” position on the toolbar to view the
current cycle time of the program in the PAC. You can also view the cycle time in the bottom-right
corner of the message area.

When doing the “On Line” (
) operation, it will automatically switch to the “Runtime” tab and you
can see if there is any error message for the downloaded program. (E.g., in this example, we need to
plug the I-8055W module in the Slot1 of the PAC, and the message “Board error in the slot No. 1 !”
means there is no I/O module in the Slot1 or an I/O exception.)
Shutting down the PAC, and plug one I-8055W module in the PAC’s Slot1 then reboots. Then, click
“On Line” (

) button to connect to the PAC.
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2.3.6

Testing the Program

In the previous section, you have successfully downloaded the “Demo01” project and the following will
describe how to test the program.
The “PAC_Time” Program:
1. Mouse double-click the variable name (e.g., “new_Year”) in the “TIME_SET” function block (or the
Variables Area) one-by-one to change the PAC’s system time (e.g., to change it as January 1, 2015
12:30:35).

2. Set the “Set_new_time” variable to “TRUE” to write the new system time.
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3. Then, the new system time will show on the “TIME_GET” function block (or the Variables Area),
and the “Set_new_time” variable will be reset to “FALSE” automatically.

The new system time.

The “LD1” program:
4. When the “Demo01” project is running, you can check to see if the DO0, DO1 and DO2 tags of the
I-8055W I/O module that plugged in the slot1 of the PAC is blinking every two seconds (like the
value "T#2S” we set before). You can also assign a “TIME” variable on the left side of the “CYCLE”
for easy to change the time setting. Refer the Section 2.3.1 for the setting way.
5. If the “%QX1.1.3” variable is set to “TURE” in the Variable Area, the LED4 (i.e., “DO3”, at the top of
the I-8055W I/O module) will light up.

顯示 PAC 系統時間。

6. Click the
tool button again to cancel the PAC connection.
Note: Do NOT click the “Stop Application” button; it will stop the running project in the PAC.
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Chapter 3

Modbus Slave: Allow the SCADA/HMI Software to
Access Win-GRAF Variables

In Chapter2, we have described how to get/set the PAC system time (i.e., the “PAC_Time” program) and
create a blinking function (i.e., the “LD1” program) in the “Demo01” project. The following sections
describe how to allow the SCADA/HMI software (e.g., “InduSoft”) to access Win-GRAF variables that
defined in the "Demo01" project. The Win-GRAF Workbench provides two ways to open the PAC data,
one way is to enable the Win-GRAF PAC as a Modbus TCP Slave and the second way is to enable the
Win-GRAF PAC as a Modbus RTU Slave (you must first complete all the Modbus Slave settings in Section
3.1, and then refer the Section 3.2). To begin, follow these steps:

3.1

To Enable the Win-GRAF PAC as a Modbus TCP Slave

1. Click the “Open Fieldbus Configuration” tool button to open the “IO Drivers” window.

2. Click the “Insert Configuration” button on the left side of the “IO Drivers” window and then select the
“MOSBUS Slave” and click “OK” to enable a Modbus TCP Slave.
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3. Click the “Insert Master/Port” button on the left side to set the “Slave number” (In this case, the
value is “1”), and click the “OK” button.

4. Click the “Insert Slave/Data Block” button on the left side to open the “MODBUS Slave Request”
window.

Tips:
1. Press the “F1” key to open the Help on this subject.
2. If you add two or more “Server - …” settings, type a
“Server ID” for easier use (a string, e.g., `SVR1’)

5. Enter a simple note in the “Description”
field and then click the "Input Registers”
option.
For Modbus Master to Read data:
Options
Data types
Input-bits
BOOL
BYTE, INT, DINT,
Input Registers
REAL, etc.

Enter a simple note.

For Modbus Master to Write data:
Options
Data types
Coil-bits
BOOL
Holding
BYTE, INT, DINT,
Registers
REAL, etc.
(Refer the Appendix A to see more data type)
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6. As the screenshot above, it’s recommended to set the “Base address” to “1” and the “Nb items”
refers to how much variable data can be provided by one “data block”. If the data address requested
from the Modbus Master (e.g., the SCADA software) is greater than this value (in this example, the
value is “2000”), the Modbus Slave (i.e., Win-GRAF PAC) will not respond.
7. Mouse drags all the needed variables (e.g., “PAC_xxx”, data type: “DINT”) one-by-one from the
Variables area and then drop it to the “Symbol” field.

8. Mouse double-click the “Offset” field and fill in a value, then press “Enter” key to finish the setting.
Note: (1) The “Offset” value starts at “0” and the Modbus address of variable is equal to this value
plus 1 (Base address).
(2) If using a 32-bits (or more than 32-bits) data type (e.g., “DINT”, refer the Appendix A), it
requires two Modbus addresses, as the table below, the “Offset” values are 0, 2, 4, 6, etc.

Enter

Tips:
Mouse click the “Offset” field and press the keyboard “Ctrl+A” to select all items, and then click the
“Iterate Property” button at the left-side to open the settings window.

Ctrl+A
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Keep the “Name” setting, enter “0” into “From” field and enter “2” into “By” field, then click “OK”.
(If setting the “Name” to “%%”, it will show “00, 22,
44, 66, 88, 1010, 1212” in this example. To modify it
depends on the required settings and then check
the value in the “Results” area.)

9. Click “Storage” to select entire columns and then press “Enter” key to display a drop-down menu.
Then, select “DWORD (Low – High)” and press “Enter” key to complete the setting. (If using a 16-bits
or below, it’s no need to set the “Storage” item.)

To expand this “Data Block” and you can see the Modbus addresses of all variables. It equals to the
“Offset” value plus 1 (Base address).
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10. Then, we need to add the second “Data Block” for the Modbus Master to read the Boolean data.
This configure way is similar to the step 4 to 8:
(1) Click the “Server - …” item and click the “Insert Slave/Data Block” button at the left side to open
the settings window.
(2) In the “MODBUS Slave Request” window, enter a simple note and select the “Input-bits” option,
then set “Base address” to “1” and set “Nb items” to “2000”.

Enter a simple note
For the Modbus Master to Read data:
Option
Data Type
Input Bits
BOOL
BYTE, INT, DWORD,
Input Registers
REAL, LINT, etc.
(Refer Appendix A to see more data type)

(3) Mouse drags the Boolean variables (i.e., “LED1”, “LED2”; data type: BOOL) one-by-one and drop
them to the “Symbol” area, and then set the “Offset” to “0” and to “1”.

You have completed the settings for the Modbus Slave. Finally, follow the way below to re-compile
the program and download it to the Win-GRAF PAC.
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11. Click “Project” > “Build All Projects” from the menu bar to compile this program again (refer the
Section 2.3.4). If a message informs you “No error detected” that means this process is successful.

This version information can be ignored.

12. Mouse right-click the project name (i.e., “Demo01”) and select the “Communication Parameters…”
to set the PAC IP (e.g., “192.168.71.19:502”) and then click the menu bar “Project” > “On Line” (or
) to establish a connection and download this project to the Win-GRAF PAC. (Refer the Section
2.3.5).

SCADA / HMI

Win-GRAF PAC
IP: 192.168.71.19
Port: 502

InduSoft
Slave number = 1
WP-5xx8
Modbus TCP Master

WP-8xx8

Modbus TCP Slave
(Refer the P1-1 to view all PAC models)

After completing all the steps, the HMI/SCADA software can access to all the Win-GRAF variables listed
above via Modbus TCP protocol.
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3.2

To Enable the Win-GRAF PAC as a Modbus RTU Slave

Before doing this, you must complete all the content that described in Section 3.1 to open the Modbus
Slave data. The way to enable the Win-GRAF PAC as the Modbus RTU Slave is to add the “MBSLAVERTU”
or the “MBSLAVERTUEX” function block in the program. To begin, follow these steps:
Add the “MBSLAVERTU” function block
1. In the “LD1” window, mouse click the place where you want to add this function block and then click
the “Insert FB..” button on the left side of the window.

3

2

1

2. Double-click on this function block and select the name “MBSLAVERTU”, then click “OK”.

Tips:
Press “MBSL” key to quickly
find out the function name.
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3. In the “MBSLAVERTU” function block, mouse double-click the left side of the “PORT” and enter a
string 'COM2:9600,N,8,1' (it means using the Win-GRAF PAC’s COM2 to communication with the
Modbus Master) and then click

to complete the settings.

Tips:
Press the “F1” key on this
function block to show up
the related Help.

4. Double-click the left side of the “SLV” and then enter “1” (the value set in the Section 3.1 - Step 3),
then click

to finish the setting.

Now, you have completed the setting of the “MBSLAVERTU” function block, then re-compile the
program and download it to the Win-GRAF PAC. (Refer the Section 2.3.4, Section 2.3.5)
Note: Users can enable multiple Modbus RTU Slave ports for each PAC (recommend not over 16 Ports),
the way is to add multiple “MBSLAVERTU” function blocks and set the different “Port” value.
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SCADA / HMI

Win-GRAF PAC
COM2: RS-232
9600,N,8,1

InduSoft
Slave number = 1
Modbus RTU Master

WP-5xx8

WP-8xx8

Modbus RTU Slave
(Refer the P1-1 to view all PAC models)

Add the “MBSLAVERTUEX” function block
If you have added multiple “Server - …” settings (recommend to set one) in the “IO Drivers” window, the
“MBSLAVERTUEX” function block must be used.

1. Follow the step1 to 4 described above to add the “MBSLAVERTUEX” function block. If you want to
change the usage for existing function block, mouse double-click the “MBSLAVERTU” and change it
to the“MBSLAVERTUEX”, and then click the “OK” button.

Function

Function Block
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2. The “MBSLAVERTUEX” has a “SrvID” setting. Double click the left side of the “SrvID” and enter a
needed “Server ID” (using a string format, e.g., ‘Svr1’).
Note:
Using the “MBSLAVERTU” function block means the first Mobus Slave setting will be enabled.
Using the “MBSLAVERTUEX” function block means to enable the Modbus Slave setting depends on
the “Server ID”.

Tips:
Press the “F1” on this
function block to show
up the related Help.

Now, you have finished the settings for the “MBSLAVERTUEX” function block and then re-compile
the program and download it to the Win-GRAF PAC. (Refer the Section 2.3.4, Section 2.3.5)
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Chapter 4

Linking “I/O Boards”

This section lists the usage of the “I/O Boards” function in the Win-GRAF Workbench to link the Real I/O
modules or to enable other I/O functions. First, you need to know the slot numbering and supported I/O
modules for each PAC:
PAC Model
WP-8xx8
XP-8x48-CE6 (*)
XP-9x48-CE6
VP-25W8
VP-4138

WP-5xx8

Slot No. (from the
left to the right)
0 to 7
1 to 7
0 to 2

-

The supported PAC I/O modules

Supported:
I-8K and I-87K series (High Profile) I/O modules.
(E.g., I-8017HW and I-87055W)
Not Supported:
I-8K and I-87K series (Low Profile) I/O modules.
(E.g., I-8017H and I-87055)
Palm-size PAC, it can support one XV board.
(E.g., XV107, XV116, XV308, etc.)
The XV board belongs to the Modbus slave I/O board.
(Refer the Section 5.1.6 to 5.1.12 for using XV-boards.)

(*) : The XP-8048-CE6 is the 0-slot PAC.

(Refer P1-1 for all PAC models)

Add the “I/O board”
“I/O board” refers to the I/O functionality in the Win-GRAF (e.g., “i_8037_DO“) and
“I/O module” refers to the hardware device (e.g., “I-8037W“).
Notice:
Besides the software setting for the I/O board, there are some kinds of I/O modules need to set the
hardware Jumper (e.g., Single-ended and Differential Jumper). So, go to the website to look up the
product information, or the description printed on the module cover, or the attached shipment
document.
I-8K and I-87K series product website:
http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html

1. In the Win-GRAF, click the "Open I/Os" button from the toolbar to open the “I/O Boards” window.

2. As the figure below, mouse double click the slot number that corresponds to the real I/O module
and then select the proper I/O board (e.g., i_8037_DO).
Note: The Slot 0 to Slot 7 are reserved for real I/O modules that plugged into the PAC, and the slot
8 or above are for other usage.
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Select and to see the
setting description.

Buttons Description: (Click the following buttons to modify the settings)
“Close”:
Close this window.
“Select”:
Open the I/O selecting window.
( Hot Key - “Enter”: to open ;
Hot Key - “ESC” : to exit)
“Delete”:
Delete this I/O board.
“Rename”:
Rename this I/O board.

“Properties”:
“Virtual/Real”:
“Move Up”:
“Move Down”:
“Help”:

Look up the usage of this I/O board.
Swith the I/O board to a Virtual I/O (for testing) or a Real I/O. (Hot Key – “Space”)
Move up this I/O board.
Move down this I/O board.
To see the description on “I/O devices”.
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4.1

DI/DO Boards

Here use the "I-8055W" as an example, users can refer the Chapter 4 (P4-1) to add this I/O board.
1. Double-click the “i_8055_DI” (or the “i_8055_DO”) to open the “Properties” window.
Note: A mouse-over showing the details on the “i_8055_DI” (or the “i_8055_DO”).

Setting Description

2. After linking the “i_8055” I/O board, it will auto add 8 Input and 8 output variables in the
“Variables” window that can be used in the program.

%IX1.0 – i_8055_DI
%QX1.1 – i_8055_DO
“I” means “Input”
“Q” means “Output”
“X” means “Boolean” “1” means “Slot 1”
Note:
Double-click this item to modify the variable
name and click “Enter” to accept the setting.
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4.2

i_scale (Conversion Table)

The “i_scale” function can set up to 29 scaling functions to convert values for the AI or AO module that
plugged in the slot 0 to slot 7. See the Chapter4 (P4-1) to add this I/O board.
1. Mouse double click the "i_scale_0" (or "i_scale_1" or "i_scale_2") to open the “Properties” window,
and then to see the setting description.
Note: Using the slot 8 or above No. because the slot 0 to slot 7 are reserved for the real I/O module.

Setting Description

Parameters: (“Ch” means the Ch01 to Ch29, "Ch00” is a reserved item)
Ch_X0_Min_Physical_Val:
The min. value of AI (or AO) boards (X0).
Ch_X1_Max_Physical_Val:
The max. value of AI (or AO) boards (X1).
Ch_Y0_Engineering_Val_For_X0: The engineering value after scaling X0.
Ch_Y1_Engineering_Val_For_X1: The engineering value after scaling X1.
2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.
Notice:
1. If set both value of Ch_X0 and Ch_X1 to "0.0", it means the relative scaling function No. is
disabled.
2. If Ch_X0 is greater than or equal to Ch_X1, the setting is wrong.
3. If Ch_Y0 is equal to Ch_Y1, the setting is wrong.
For example, if the AI board's value is 4 to 20 mA and wish to scale as 0 to 10000, then set Ch_X0 as
"4.0", Ch_X1 as "20.0", Ch_Y0 as "0.0", Ch_Y1 as "10000.0".
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For example, if the AO board's value is -10 to +10 V and their respective engineering value is
-50 to 1200, then set Ch_X0 as "-10.0", Ch_X1 as "+10.0", Ch_Y0 as "-50.0", Ch_Y1 as
"+1200.0".

3. After linking the “i_scale” in the “I/O Boards” window, it will auto add 30 Boolean variables in the
“Variables” window. When the Win-GRAF connects the PAC, it will display the state of each scaling
function.
True: scaling function is ok.
FALSE: scaling function is not enabled or setting error.
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4.3

i_8017HW (8/16 channels AI)

The I-8017HW can be an 8-channel differential or a 16-channel single-ended analog input module (Data
type: "REAL"). The following will describe a 16-channel module, you can see the Chapter4 (P4-1) to add
this I/O board.
Note: Before using the I-8017HW I/O module, it requires to set the Differential or Single-ended
Jumper in the hardware.
1. Mouse double click the "i_8017_16ch" to open the “Properties” window, and then to see the
setting description.

Setting Description

Parameters:
Ch_type: 16#SSRR
SS : Scaling function is defined by the "i_scale" I/O board (see the Section 4.2).
00
means "No scaling".
01 to 29 means "Appling a scaling function No. (01 to 29)".
Setting “SS” as other value will use the default value 00.
RR : Range definition of signals.
05 means "physical input signal is -2.5 to +2.5 Volt".
06 means "physical input signal is -20 to +20 mA".
07 means "physical input signal is -1.25 to +1.25 Volt".
08 means "physical input signal is -10 to +10 Volt".
09 means "physical input signal is -5 to +5 Volt".
Setting “RR” as other value will use the default value 08.
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.
For example, 16#08 means the physical input signal is -10 to +10 V.
Channel value 5.67 means the input signal is 5.67 V.
For example, 16#209 means the physical input signal is -5 to +5 V with the scaling function 2.
Signal 5.67 V will be scaled to an engineering value by the scaling function 2.
For example, 16#1709 means the physical input signal is -5 to +5 V with the scaling function 17.
Signal 5.67 V will be scaled to an engineering value by the scaling function 17.

Noise_Filter_Max: The max. of the physical value to be considered as noise.
The filter will filter out the signal value beyond it, default setting is "9999.9".
For example, set as “7.9”, signal larger than 7.9 V (or 7.9 mA) will be filtered out.
Noise_Filter_Min: The min. of the physical value to be considered as noise.
The filter will filter out the signal value beyond it, default setting is "-9999.9".
For example, set as “1.5”, signal smaller than 1.5 V (or 1.5 mA) will be filtered out.
Note:
If setting Noise_Filter_Min >= Noise_Filter_Max, filter is disabled.
If setting Noise_Filter_Min < -1000 and Noise_Filter_Max > 1000, the filter is disabled.
Sample_Number: The number of sampled data to be averaged as one data.
Default is “1” (range: 1 to 500). Set a bigger value will reduce the sampling rate,
however the signal curve is smoother than setting a small value.
3. After linking the “i_8017_16ch” in the “I/O Boards” window, it will auto add 16 "REAL” input
variables in the “Variables” window. These variables can be used in the program.

You can change the variable
name by double clicking it.
(See the Section 4.1)
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4.4

i_8024 (4-channel AO)

The I-8024W is a 4-channel analog output module (Data type: "REAL") that can be used to output +/- 10
V or 0 to +20 mA signal. See the Chapter4 (P4-1) to add this I/O board.
1. Mouse double-click the "i_8024_AO" to open the “Properties” window and then to see the setting
description.

Setting Description

Parameters:
Ch_type: 16#SSRR
SS: Scaling function is defined by the "i_scale" I/O board (see the Section 4.2).
00
means "No scaling".
01 to 29 means "Appling a scaling function No. (01 to 29)".
Setting “SS” as other value will use the default value 00.
RR: Range definition of signals
30
means "physical output signal is 0 to 20 mA"
33
means "physical output signal is -10 to +10 Volt"
Setting “RR” as other value will use the default value 33.
2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.
For example, 16#33 means the physical output signal is -10 to +10 V.
Channel value 5.67 is to output 5.67 V ; value -3.752 is to output -3.752 V.
For example, 16#133 means the physical output signal is -10 to +10 V with the scaling function 1.
Channel value is a user-defined engineering value will be converted first by the scaling
function 1 (i.e., "Ch01") before output it as -10 to +10 V.
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For example, 16#30 means the physical output signal is 0 to 20 mA.
Channel value 12.5 is to output 12.5 mA ; value 6.27 is to output 6.27 mA.
For example, 16#1730 means the physical output signal is 0 to 20 mA with the scaling function 17.
Channel value is a user-defined engineering value will be converted first by the scaling
function 17 (i.e., "Ch17") before output it as 0 to 20 mA.

3. After linking the “i_8024_AO” in the “I/O Boards” window, it will auto add 4 "REAL” Output variables
in the “Variables” window. These variables can be used in the program.

You can change the variable
name by double clicking it.
(See the Section 4.1)
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4.5

i_87018W (8-channel AI)

The I-87018W is an 8-channel analog input module (Data type: "REAL") that provides thermocouple
input, current input (-20 mA to +20 mA) and voltage input (+/- 15 mV, +/- 50 mV, +/- 100 mV, +/- 500
mV, +/- 1 V, +/- 2.5 V). See the Chapter4 (P4-1) to add this I/O board.
Important Notice:
 I-87018ZW is better than I-87018W / I-87018RW / I-87018PW because
(A) Each channel can use different range type setting.
(B) Accuracy is better and total 10-Channels.
(C) Temperature input with sensor-broken-line detection.
Please visit http://www.icpdas.com/products/Remote_IO/i-87k/i-87018z.htm
 I-87018W does not support sensor-broken line function.
1. Mouse double-click the "i_8018_08ch" to open the “Properties” window, and then to see the setting
description.

Setting Description

Parameters:
Tmp_F: 16#FF
FF: Temperature format, It only apply to the channel type is Thermocouple.
01 means the unit of the input value is Degree Celsius
02 means the unit of the input value is Degree Fahrenheit
Ch0_7_type: 16#RR
RR: Range definition of signals.
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Normal Range: (For mA or Volt)
Type Code

Physical Input Signal

00
-0.015 to +0.015 V
01
-0.05 to +0.05 V
02
-0.1 to +0.1 V
03
-0.5 to +0.5 V
04
-1 to +1 V
05
-2.5 to +2.5 V
06
20 to +20 mA
When I-87018 and I-87018R are connected
to a current source and set to “06” type
code, an optional external 125 Ohm resistor
is required.

Thermocouple Range: (For temperature)
Type Code

Type

Physical Input Signal

0E

J

-210 to +760 °C

0F

K

-270 to +1372 °C

10
T
-270 to +400 °C
11
E
-270 to +1000 °C
12
R
0 to +1768 °C
13
S
0 to +1768 °C
14
B
0 to +1820 °C
15
N
0 to +2320 °C
17
L
-200 to +800 °C
18
M
-200 to +100 °C
19
LDIN43710 -200 to +900 °C
Setting RR as other value will use the default value “05”

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.
For example, 16#05 means the physical input signal is -2.5 to +2.5 V.
Channel value 1.28 means the input signal is 1.28 V.
Channel value -0.752 means the input signal is -0.752 V.
For example, If "Ch0_7_type" set as 16#0F and "Tmp_F" set as 16#01 means the physical input
signal is -270 to +1372 degree Celsius.
Channel value 25.75 means 25.75 degree Celsius.
For example, If "Ch0_7_type" set as 16#10 and "Tmp_F" set as 16#01 means the physical input
signal is -454 to +752 degree Fahrenheit.
Channel value 25.75 means 25.75 degree Fahrenheit.

Note: If using a temperature module with a broken-line detection function (e.g., I-87018ZW), and the
temperature value is greater than "9000.0", it means,
1. The temperature sensor may be broken-line.
2. The temperature sensor may be damaged.
3. The DCON module is not configured well to fit the connected temperature sensors.
4. The ohm measured by the connected sensor is not correct.
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Ch0_scale to Ch7_scale: 16#SS
SS: Scaling function is defined by the "i_scale" I/O board (refer the Section 4.2).
00
means "No scaling".
01 to 29 means "Appling a scaling function No. (01 to 29)"
Setting SS as other value will use the default value 00.
For example, 16#17 means the physical input signal is converted with the scaling function 17.
3. After linking the “i_87018_08ch” in the “I/O Boards” window, it will auto add 8 "REAL” input
variables in the “Variables” window that are available for programming.

You can change the variable
name by double clicking it.
(See the Section 4.1)
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4.6

i_exist (Test if the I/O module exists?)

The “i_exist” is used to check if the I-8K and I-87K series I/O modules exist in the PAC‘s slot 0 to 7.
See the Chapter4 (P4-1) to add this I/O board.
1. Mouse double-click the "i_exist" to open the “Properties” window, and then to see the setting
description.
Note: Using the Slot 8 or above No. because the slot 0 to slot 7 are reserved for the real I/O module.

Setting Description

2. After linking the “i_exist” in the “I/O Boards” window, it will auto add 8 "BOOL” input variables in
the “Variables” window and display the state of the I/O module from slot 0 to slot 7 when
connecting the Win-GRAF PAC.
"TRUE" means the I/O module exists.
"FALSE" means can not find this I/O module.

You can change the variable
name by double clicking it.
(See the Section 4.1)
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4.7

i_8084 (Frequency, UP/Down Counter, UP Counter)

The I-8084W is a 4/8-channel high speed Frequency/Counter (Data type: “DINT”) that can be used to
measure frequency or as a UP/Down Counter or as a UP Counter. The following will describe these three
modes. See the Chapter4 (P4-1) to add this I/O board.

4.7.1

i_8084_freq (8-channel Frequency)

1. Mouse double-click the "i_8084_freq" to open the “Properties” window, and then to see the setting
description.

Setting Description

Parameters:
Ch_Filter: The unit is 0.000001 second (μs), the value can be 0 to 200.
The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend 0: if there is no noise consideration or
need a real-time measurement.) The following setting is recommended:
Max Input Signal (Hz)

Recommend Filter Value

1K
2K
5K
10K
20K
100K
450K
450K

200
100
40
20
10
2
1
0 (without filter)
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Ch_Freq_Timeout:
The unit is 0.001 second (ms), the value can be 20 to 1800. Set as other value will use the
default value 1800. If there is no signal wave input to the I-8084W in the "Ch_Freq_Timeout"
interval, the frequency value of the related channel will be assigned as 0.
For example, if set it as 100 ms and the input is 500 Hz (that means, one signal wave takes
about 2 ms to happen), the frequency is updated normally. When the input frequency drop to 9
Hz (that means, one signal wave take about 111 ms to happen), this "111" exceeds the setting
"100" ms (Freq_Timeout). So the frequency value will be assigned as 0 because there is no
signal wave coming in this 100 ms interval.
When setting as 20 ms, the frequency value below 50 Hz is not detectable (become 0).
When setting as 100 ms, the frequency value below 10 Hz is not detectable (become 0).
When setting as 1800 ms, the frequency value of 0 Hz , 1 Hz to 450 KHz is detectable.

Ch_Low_High_Auto: (recommend setting as “2: Auto”.)
0 means a Low frequency mode.
1 means a High frequency mode.
2 means Auto switching between Low and High frequency mode.
Set as other value will use the default value “2: Auto”.
Mode 2 will auto change the frequency mode. It will auto change to High mode when the input
frequency is larger than 3500 Hz, while auto change to Low mode if input frequency is less than
1000 Hz.
DO NOT set as 1 (High frequency mode) if the input signal is normally less than 1000 Hz, or the
frequency value will be incorrect frequently. Recommended don't set as 0 (Low frequency
mode) if the input signal is normally larger than 3500 Hz.
Min_Update_Interval:
The unit is 0.001 second (ms), the value can be 0, or 20 to 1000.
Default value 0 means "Update frequency every PAC cycle".
Other means "Update frequency when each Interval time reached".
The frequency update time also depends on the Win-GRAF PAC cycle time. If the PAC cycle time
is big, for example 200 ms, then the real frequency update time will become 200 ms when
setting the "Min_Update_Interval" less than 200. Setting bigger "Min_Update_Interval" will get
smooth frequency curve value, however the frequency value is updated slowly.
Signal_Inverted:
0 : input signal is normal (no inverted).
1 : input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW
will be processed as HIGH).
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

3. After linking the “i_8084_freq” in the “I/O Boards” window, it will auto add 8 “DINT” input variables
in the “Variables” window. When the Win-GRAF connects the PAC, it will display the frequency value
for each channel.

You can change the variable
name by double clicking it.
(See the Section 4.1)
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4.7.2

i_8084_cnt_ch04 (4-channel UP/Down Counter)

Note: Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and
"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an
I-8084W.
1. Mouse double-click the "i_8084_cnt_ch04" to open the “Properties” window, and then to see the
setting description.

Setting Description

Parameters:
Ch_Mode: Input mode, can be 0 , 1 and 4. Set other value will use 0.
0: Pulse/DIR mode.
1: UP/DOWN mode.
4: A/B phase (Quard.) mode.
Ch_Filter: The unit is 0.000001 second (μs), the value can be 0 to 200.
The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend 0: if there is no noise consideration or
need a real-time measurement.) The following setting is recommended:
Max Input Signal (Hz)

Recommend Filter Value

1K
2K
5K
10K
20K
100K
450K

200
100
40
20
10
2
1

450K

0 (without filter)
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Signal_Inverted:
0: Input signal is normal (no inverted).
1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW
will be processed as HIGH).
For example:
If setting "Signal_Inverted" as 0 (no inverted) and Ch_Mode is 0 (Pulse/DIR),
the counter value will count up if "DIR" signal is High.
If setting "Signal_Inverted" as 1 (inverted) and Ch_Mode is 0 (Pulse/DIR),
the counter value will count down if "DIR" signal is High.
2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

3. After linking the “i_8084_cnt_ch04” in the “I/O Boards” window, it will auto add one “BOOL” Input
variable (no meaning, always “FALSE”) in the “Variables” window.

4. After linking the “I/O board”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Counter channel of the I-8084W.
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4.7.3

i_8084_cnt_ch08 (8-channel UP Counter)

Note: Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and
"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an
I-8084W.
1. Mouse double-click the "i_8084_cnt_ch08" to open the “Properties” window, and then to see the
setting description.

Setting Description

Parameters:
Ch_Filter: The unit is 0.000001 second (μs), the value can be 0 to 200.
The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend 0: if there is no noise consideration or
need a real-time measurement.) The following setting is recommended:
Max Input Signal (Hz)

Recommend Filter Value

1K
2K
5K
10K
20K
100K
450K

200
100
40
20
10
2
1

450K

0 (without filter)

Signal_Inverted:
0: Input signal is normal (no inverted)
1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will
be processed as HIGH).
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

3. After linking the “i_8084_cnt_ch08” in the “I/O Boards” window, it will auto add one “BOOL” Input
variable (no meaning, always “FALSE”) in the “Variables” window.

4. After linking the “I/O board”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Counter channel of the I-8084W.
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4.8

i_8093 (3-axis High Speed Encoder Module)

The I-8093W is a 3-axis high speed encoder module that can be independently configured as one of the
Quadrant, Pulse/Direction or CW/CCW input mode for each channel. If not familiar with the way to add
the this I/O board, see the Chapter4 (P4-1).
1. Mouse double-click the "i_8093" to open the “Properties” window, and then to see the setting
description.

Setting Description

Parameters:
X_Mode, Y_Mode, Z_Mode:
The input mode of X, Y, Z axis, can be 1, 2 and 3. Set other value will use 1.
1: CW/CCW counting mode.
2: Pulse/Directioncounting mode.
3: A/B phase (quadrant) counting mode.
Signal_Inverted:
0: Input signal is normal (no inverted)
1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will
be processed as HIGH).
For example:
If setting "Signal_Inverted" as 0 (no inverted) and X_Mode is 2 (Pulse/Direction),
the encoder value will increase if "Dirextion" signal is High.
If setting "Signal_Inverted" as 1 (inverted) and X_Mode is 2 (Pulse/Direction),
the encoder value will decrease if "Dirextion" signal is High.
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

3. After linking the “i_8093” in the “I/O Boards” window, it will auto add 3 “BOOL” input variables in
the “Variables” window that are available for programming.
Ch0: Z-index of X axis.
Ch1: Z-index of Y axis.
Ch2: Z-index of Z axis.

4. After linking the “I/O Boards”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Encoder channel of the I-8093W.
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4.9

Using the Count Function for I-8084W, I-8093W, I-87082W, I-87084W,
I-7083 and I-7080 Modules

This section lists the way to use the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET",
"COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to operate the Counter
and Encoder modules. If not familiar with the way to create a program or a function block, see the
Section 2.3.3.
Note:
1. In the following content, we use I-8084W and I-8093W modules as examples.
2. Before using these function blocks, first go to Section 4.7.2 (UP/Down Counter), Section 4.7.3
(UP Counter) and Section 4.8 (Encoder) to link I/O Boards.

4.9.1

COUNTER_START

For example: Using the I-8084W module in the PAC‘s slot2 and start counting the channel 5.
ST program:
IF Start1 = TRUE THEN
Start1 := FALSE ;
TMP_BOOL := Counter_Start (0, 2, 8084, 5) ;
END_IF ;

Note:
First, add two BOOL variables
("Start1", "TMP_BOOL") in the
Variables Area.

LD program:
(“Start1”: boolean, set it to “TRUE” to start counting and then reset “Start1” to “FALSE”.)

Set it to “TRUE” to start counting

Tips:
Press the [F1] key for
the details on settings.

Click to set
“Coil” to “R”.
Reset it to “FALSE”
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Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).
Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).
IO_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".
Channel: (Data type: “DINT”)
The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.
Q: (Data type: “BOOL”)
“TRUE”: OK ; “FALSE”: Error.
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4.9.2

COUNTER_STOP

For example: Using the I-8093W module in the PAC‘s slot1 and stop counting the X-axis.
ST program:
IF Stop1 = TRUE THEN
Stop1 := FALSE ;
TMP_BOOL := Counter_Stop (0, 1, 8093, 0) ;
END_IF ;

Note:
First, add two BOOL variables
("Stop1", "TMP_BOOL") in the
Variables Area.

LD program:
(“Stop1”: Boolean, set it to “TRUE” to start counting and then reset “Stop1” to “FALSE”.)

Set it to “TRUE” to stop counting

Tips:
Press the [F1] key for
the details on settings.

Reset it to “FALSE”

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).
Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).
IO_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".
Channel: (Data type: “DINT”)
The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.
Q: (Data type: “BOOL”)
“TRUE”: OK ; “FALSE”: Error.
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4.9.3

COUNTER_GET

For example: Using the I-8093W module in the PAC‘s slot1 and get the Encoder value of the Z-axis.
ST program:
TMP_BOOL := Counter_Get (0, 1, 8093, 2, Encoder_1) ;

Note: First, add variables in the
Variables Area (see section 2.2.1).
"TMP_BOOL" (BOOL).
“Encoder_1" (DINT).

LD program:

Tips:
Press the [F1] key for
the details on settings.

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).
Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).
IO_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".
Channel: (Data type: “DINT”)
The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.
@Value: (The data type can be “DINT”, “UDINT”, “DWORD”, “LINT” and “ULINT”)
It returns the current counter or encoder value. (Refer the Appendix A for the range of values)
Q: (Data type: “BOOL”)
Counting state. “TRUE”: Counting ; “FALSE”: Stopped.
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4.9.4

COUNTER_STATE

For example: Using the I-8084W module in the PAC‘s slot2 and to get the counting status of the
channel 5.
ST program:
TMP_BOOL := Counter_State (0, 2, 8084, 5) ;

Note: First, add a "TMP_BOOL"
BOOL variable in the Variable Area.

LD program:

Tips:
Press the [F1] key for
the details on settings.

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).
Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).
IO_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".
Channel: (Data type: “DINT”)
The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.
Q: (Data type: “BOOL”)
“TRUE”: OK ; “FALSE”: Error.
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4.9.5

COUNTER_RESET

For example: Using the I-8093W module in the PAC‘s slot5 and reset the Encoder value of the Y-axis
as "0".
ST program:

IF Reset1 = TRUE THEN
Reset1 := FALSE ;
TMP_BOOL := Counter_Reset (0, 5, 8093, 1, 0) ;

Note:
First, add two BOOL variables
("Reset1", "TMP_BOOL") in the
Variable Area.

END_IF ;
LD program:

“Reset1”: BOOL, set it to
“TRUE” to reset the value.

Tips:
Press the [F1] key for
the details on settings.

Reset it to “FALSE”

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).
Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).
IO_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".
Channel: (Data type: “DINT”)
The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.
Value: (The data type can be “DINT”, “UDINT”, “DWORD”, “LINT” and “ULINT”)
The new Counter or Encoder value wish to set.
Q: (Data type: “BOOL”) “TRUE”: OK ; “FALSE”: Error.
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4.10 Ping_ip (Test an Ethernet/Internet Connection)
The "Ping_ip" function is used to test if the connection of the remote Ethernet/ Internet device is
working properly. (It supports a max. of 50 IP settings.) If not familiar with the way to add this I/O board,
see the Chapter4 (P4-1).
1. Mouse double-click the "Ping_ip" to open the “Properties” window, and then to see the setting
description.
Note: Using the slot 8 or above No. because the slot 0 to 7 are reserved for the real I/O module.

Setting Description

Note:
1.
2.
3.
4.
5.

If wish to test the connection between PAC and Internet, please set proper "Gateway" settings.
If test only local Ethernet connection, then "Gateway" may not be necessary.
One PAC can use only one "Ping_IP". (Don't use two or more)
When Ping success, return Boolean channel as TRUE.
When Ping fails, it will try one more time. If still fail, then return Boolean channel as FALSE.

Parameters:
IP_01 to IP_49: (Data type: "STRING")
The IP address of targets. Set as 'N/A' if wish to disable it.
For example, 192.168.1.100 or 52.19.125.242 or N/A.
Interval_01 to Interval_49: (Data type: "DINT")
The unit is second. The interval to send one "ping" command. Value can be 6 to 86,400 seconds.
Setting smaller than 6 will use as 6. Setting greater than 86400 (24 hours) will use as 86400.
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Timeout_01 to Timeout_49: (Data type: "DINT")
The unit is second. The timeout settings of the "ping" command. Value can be 2 to 30 seconds.
Setting smaller than 2 will use as 2. Setting greater than 30 will use as 30.
Note: The "Interval_xx" value should be at least triple of the "Timeout_x" value. Or the PAC will
use the "Interval_x" value as a triple of the "Timeout_x" value.
For example, if "Timeout_00" is set as 10 however "Interval_00" is set as 20, then PAC will
use "Interval_00" as 30.
2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

3. After linking the "Ping_ip" in the “I/O Boards” window, it will auto add 50 “BOOL” input variables in
the “Variables” window. When the Win-GRAF connects the PAC, it will display the online status.
True: The connection is ok.
FALSE: Connection failed or cable problem.

You can change the variable
name by double clicking it.
(See the Section 4.1)
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4.11 I-8088W (8-channel PWM Output Module)
The I-8088W is an 8-channel PWM (Pulse Width Modulation) output module. The duty range (Duty =
High / (High + Low) ) of the PWM output signal can be from 0.1% to 99.9%. Its output frequency in the
Win-GRAF PAC is from 1 Hz to 500 KHz. The I-8088W support two PWM output modes, one is the
“Continuous” mode. It outputs always. The other one is the “Burst” mode. It outputs the required pulse
count and then stop. Please visit http://www.icpdas.com/products/Remote_IO/i-8ke/i-8088w.htm for
other specifications.
Hardware Connection Diagram:
This example uses the I-8084W (Slot 2) to measure the frequency of the I-8088W (Slot 1) PWM output
signal (the I-8084W is not necessary in the actual application). Then, connect the I-8088W’s PWM
output channel 0 (PW0) to the I-8084W’s frequency input channel 0 (C0A+).

The demo program (demo_8088w.zip) that we will describe below is located in the shipment CD
(\Napdos\Win-GRAF\demo-project) , refer the Chapter 12 to restore/open this project and set up the
current PAC‘s IP address.

Right-click (set the IP)
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I/O Boards:
In this case, add the "i_8088" and the "i_8084_freq" to the corresponding I/O slot No. in the "I/O
Boards" window (see the Chapter 4). Then, mouse double-click the Slot No. to open the "Properties"
window and you can see the setting description to set this I/O board.

Double-click it to set
and to see the details.

Double-click it to set up this item.
“00“ means the associate PWM output channel
is triggered by the "i_8088W" function block.

Setting Description

After linking the "i_8088" and the "i_8084_freq" I/O boards, it will auto add related variables in the
"Variables" window (or Variables Area). And, you can also declare all the variables that will be used in
the program here (refer the Section 2.3.1).

To declare all the variables that
will be used in the program.

Double-click it to change its name.
(Refer the Section 4.1)
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"PWM_8088W" Function Block:
Then, using the function block “PWM_8088W” to control the PWM output for each channel, such as the
LD program below.

BOOL, always returns “Ture”
Slot and Chan must
use constant value.

Freq: PWM frequency
(Data type: DINT)
Duty: PWM duty
(Data type: REAL)

State: BOOL, the current working status.
(True: working ; False: stopped)
Num: DINT, it reserved for future usage.

Cnt: DINT，"-1"
(Continuous mode), used to output PWM pulse continuously.
"1 ~ 65535" (Burst mode), used to output the required pulse count and then stop.
Run: BOOL, used to start (True) or stop (False) the PWM output.

Parameters:
Slot:
The used I/O slot No., and it must be a constant value, not a changeable value.
In this case, the value is "1". (Data type: DINT)
Chan:
The used I/O channel No., and it must be a constant value, not a changeable value.
In this case, the value is "0". (Data type: DINT)
Freq:
The PWM output frequency. (Data type: DINT ; Unit: Hz)
The value can be from 1 to 500,000 (i.e., 1 Hz to 500 KHz) .
In this case, the initial value is "100" Hz.
Duty:
The PWM output. (Data type: REAL)
The value can be from 0.001 to 0.999 (i.e., 0.1 % to 99.9 %).
In this case, the initial value is 0.5 (i.e., 50 %).
Cnt:
The output mode (Data type: DINT)
Continuous mode: set it as “-1” (in this case) to output PWM pulse continuously.
Burst mode: it can be from "1" to "65535", to output the required pulse count and then stop.
Run:
Using a BOOL variable to trigger the PWM output. (True: Start ; False: Stop)
State:
The current working status. (Data type: BOOL). (True: working ; False: stopped)
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Test the program:
Before testing, make sure you have set the PAC's IP address and then compile and download this
program to the PAC. (If not familiar with the operation, refer the Section 2.3.4 and Section 2.3.5.)
When connecting with the PAC, the SPY List (refer the Section 11.3) will show that the I-8088W’s PWM
initial frequency ("i8088_Freq0") is 100 Hz, the initial duty cycle ("i8088_Duty0") is 50%, using the
Continuous mode ("i8088_Cnt0" = -1) and the currently measured frequency of the I-8084W is 0 Hz.

Now, set the "i8088_Run0" as "TRUE" to start the PWM output. At this time, the "i8088_State" will
change from "FALSE" to "TRUE" and output a PWM signal to the I-8084W module, and then the value of
the "i8084_Freq0" will change from 0 Hz to 100 Hz.

If set the "i8088_Cnt0" as 500 (Burst mode), the "i8084_Freq0" value will become 0 after the I-8088W
outputs 500 PWM pulses. You can try to change the "i8088_Cnt0" value and then set the "i8088_Run0"
as "TRUE" to view the changes of output.
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Chapter 5

Modbus Master: connecting to Modbus Slave Devices

This chapter lists the way to enable the Win-GRAF PAC as a Modbus Master to connect Modbus
RTU/ASCII Slave or Modbus TCP/UDP Slave devices. If you want to use one XV board in the WP-5xx8,
refer the Section 5.1.6 to Section 5.1.11.

5.1

Enabling the Win-GRAF PAC as a Modbus RTU/ASCII Master

Application Diagram:

(Refer the P1-1 to view all PAC models)

Follow these steps:
1. Mouse click the “Open Fieldbus Configuration” tool button to open “IO Drivers” window.
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2. Click the “Insert Configuration” button on the left of the “IO Drivers” window, then click the
“MOSBUS Master” and “OK” to enable the Modbus Master setting.

3. Click the “Insert Master/Port” button on the left side to open the setting window. Then, select the
“Serial MODBUS-RTU”, set COM Port (e.g., “COM2:9600,N,8,1”) and Delay time (recommended
value: 10 ms, it can be 0 to 10000), and then click “OK”.

If wish to set it as a Modbus ASCII
Master, change the setting to
“ASCII:COM2:9600,N,8,1”
After receiving the respond, waiting for
10 ms to send the next command

Select “Disabled” if you do not want
to use this COM Port setting.
4. Click the “Insert Slave/Data Block” button on the left side to create a data block.
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This table lists five data blocks, and each data block stands for one Modbus Master Request.
Item

Function Code

1

2

Read Input-bits

Read DI data

2

5

Write single coil-bit

Write DO data

3

4

Read Input Registers

Read AI data

4

6

Write single holding register

Write one AO data (16-bit)

5

16

Write Holding Registers

Write multiple AO data (16/32 bits)

5.1.1

Modbus Request

Description

Read DI data

1. Completing all the following settings in the “MODBUS Master Request” window, and then click “OK".

a

b

c

d

e

a. Slave/Unit:
Enter the Net-ID of the Slave device.
(In this case, the Net-ID is “1”).
b. MODBUS Request:
Select “<2> Read Input Bits” option.
c. Base address:
Start from “1” by default.
Nb items:
The number of DI signals to read.
(In this case, the number is “16”).
Note:
If you want to change the “Base address”,
right-click the “MODBUS Master” and
then select the “MODBUS Master
Addresses” to modify the value.

This option can not apply
to the "Read" request.

d. Activation: The way to send the Modbus request.
Periodic: Sending the request periodically.
(In this case, to send once every two seconds.)
“on error” means the next sending time when
an exception occurred (e.g., 15 seconds).
On call:
The request is activated when a program call
to send it
On change: In case of a write request, means that the request is activated each time any variable
changed.
e. Timeout: Set a timeout value. (When time-out occurred, it will show the defined error code.)
(The recommended value for the Modbus RTU/ASCII device is 200 to 1000 ms.
In this case, the value is 250 ms)
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2. Next, open the “Variables” window and then declare variables that are available for the program.

Tips:
Press “F1” key to view the details
on the MODBUS Master settings.

Double click it to open the window.

Declaring 16 variables to read data (Name: “Boo_01 to Boo_16”; Type: BOOL) and one array variable to
record the state of data access (Name: “Status"; Dim.: 5; Type: DINT). Refer the Sectin 2.3.1 for the
way to declare variables, and the figure below shows defined variables.

3. In the "IO Drivers" window like the figure below, drag all required variables in the Variables Area (i.e.,
“Bool_01” to “Bool_16” and “Status”) and drop them to the “Symbol” area in the first data block.
Note: The “Status” is an array variable, so, the Status[0] to Status[4] will show on the “Symbol” area.
Click the “Del” key to delete the Status[1] to Status[4].
4. Next, select “Offset” field from “Boo_01” to “Boo_16” and then click the “Iterate Property” button
on the left side to set the “Offset” value (From: “0”；By: “1”, refer the Section 3.1 – Step8).
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5. In the “Operation” field, set the “Status*0+” as “Error report” which means the return value is an
“Error Code” if a read error occurred and the value will be reset to “0” if read successfully.

3

4

The “Offset” must be “0” when
selecting the“Error report”.

5

You can also press “F1” in this “IO Drivers” window to see details on Modbus Master Configuration.
Error Code

Description

Error Code

Description

0

The communication is OK.

8

Data Parity Error.

1

MODBUS function not supported.

10

Invalid gateway path.

2

Invalid MODBUS address.

11

Gateway target failed.

3

Invalid MODBUS value.

128

Communication timeout.

4

MODBUS Server failure.

129

Bad CRC16.

6

Server is busy.

130

RS-232 communication error.
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5.1.2

Write DO Data

1. Using the same way in the Section 5.1 - Step 4 to create the second data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

a

b

c

d

e

In this example
a. Slave/Unit:
Enter the Net-ID of the Slave device.
(e.g., the Net-ID is “2”).
b. MODBUS Request:
Select “<5> Write single coil bit”.
c. Base address:
Start from “1” by default.
(Refer the Section 5.1.1 to change it.)
d. On call:
The request is activated when a
program call to send it
(Refer the Section 5.1.1 for details)
e. Timeout: Set a timeout value.
When time-out occurred, it will show
the defined error code. (The
recommended value for the Modbus
RTU/ASCII device is 200 to 1000 ms.
In this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Tips:
Press “F1” key to view the details
on the MODBUS Master settings.

Double click it to open the window.
Add two boolean variables in the "Variables" window (refer the Section 2.3.1 for declaring variables).
Variable name

Data type

Description

DO_0

BOOL

Used to Write digital output data.

Act_0

BOOL

In this case, choose the “On call” way to write data that means
using a variable to call it.
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After completing the settings, the defined variables show as below:

3. In the “IO Drivers” window, drag variables - “DO_0”, “Act_0” and “Status” (that created in the
Section 5.1.1) from the Variables Area to the Symbol Area in the second data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status*0+” to “Status*4+", simply press “Del” key to delete “Status[0]” and “Status[2] to [4]".
4. Set the “Operation” field of the “Status*1+” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.
5. Set the “Operation” field of “Act_0” as “Command (one shot)” (that means the request will be sent
only once when “Act_0” is set to “TRUE”. Then, this “Act_0” will auto reset to “FALSE”).
The "Command (Enable)” means the request is sent continuously as long as the “Act_0” is “TRUE”.
So, users can set the “Act_0” to “FALSE” to stop sending command.
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5.1.3

Read AI Data

1. Using the same way in the Section 5.1 - Step 4 to create the third data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".
In this example
a. Slave/Unit:
Enter the Net-ID of the Slave device.
(e.g., the Net-ID is “3”).

a

b. MODBUS Request:
Select “<4> Read Input Registers”.
b

c

d

e

c.

d. Base address:
Start from “1” by default.
(Refer the Section 5.1.1 to change it.)
Nb items:
The number of AI signals to write.
(In this case, the number is “10”).
e.

This option can not apply
to the "Read" request.

d. Periodic: (Refer the Section 5.1.1)
Sending the request periodically.
(In this case, to send once per second.)
“on error” means the next sending
time when an exception occurred
(e.g., 15 seconds).

e. Timeout: Set a timeout value.
When time-out occurred, it will show the defined error code. (The recommended value for the
Modbus RTU/ASCII device is 200 to 1000 ms. In this case the value is 250 ms.)
2. Next, open the “Variables” window and then declare variables that are available for the program.

Tips:
Press “F1” key to view the details
on the MODBUS Master settings.
Double-click it to open this window.
Follow the table below to add six Word (16-bit), one Double integer (32-bit) and one Real (32-bit)
variables. (Refer the Section 2.3.1 for declaring variables).
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Variable name

Data type

Description

Word_1 to Word_6

WORD

Used to Read AI data (16-bit).

Long_1

DINT

Used to Read AI data (32-bit).

Real_1

REAL

Used to Read AI data (32-bit).

Refer the Appendix A for details on data type and ranges. After completing the settings, the defined
variables show as below:

3. In the “IO Drivers” window, drag variables - “Word_1 to Word_6”, “Long_1”, “Real_1” and “Status”
(that created in the Section 5.1.1) from the Variables Area to the Symbol Area in the third data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status*0+” to “Status[4]", simply press “Del” key to delete “Status[0] to [1]” and “Status[3] to [4]".
4. Set the “Operation” field of the “Status*2+” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.
5. Both the “Long_1” and “Real_1” are 32-bit variables and require two Modbus addresses. So, set
their “Storage” column as “DWORD (Low – High)”.

3

4

5
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6. As the figure below, select the "Word_1” to “Word_6” and then click “Iterate property” to set their
Offset value (From: 0；By: 1).

7. Next, double click the Offset field of “Long_1” and “Real_1” items and set their values as “6” and “8”,
then press “Enter” key to complete the settings.
Note: One 32-bit data requires two Modbus addresses. For instance, the Offset value of “Long_1”
is “6” and the next Offset value must be set to “8” (i.e., “Real_1”).

press “Enter”
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5.1.4

Write AO Data (16-bit)

1. Using the same way in the Section 5.1 - Step 4 to create the 4th data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

a

b

c

d

e

In this example
a. Slave/Unit:
Enter the Net-ID of the Slave device.
(e.g., the Net-ID is “3”).
b. MODBUS Request: Select
“<6> Write single holding register”.
c. Base address:
Start from “1” by default.
(Refer the Section 5.1.1 to change it.)
d. On change: In case of a write request,
means that the request is activated
each time any variable changed.
(Refer the Section 5.1.1 for derails.)
e. Timeout: Set a timeout value.
When time-out occurred, it will show
the defined error code. (The
recommended value for the Modbus
RTU/ASCII device is 200 to 1000 ms. In
this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Tips:
Press “F1” key to view the details
on the MODBUS Master settings.
Double-click it to open this window.

Declaring a "WORD" variable.
(Refer the Appendix A for details on data type and ranges ; refer the Section 2.3.1 for operations).
Variable name

Data type

Word_Write_1

WORD

Description
Used to write AO data (16-bit).
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After completing the settings, the defined variables show as below:

3. In the “IO Drivers” window, drag variables - “Word_Write_1” and “Status” (that created in the
Section 5.1.1) from the Variables Area to the Symbol Area in the 4th data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status*0+” to “Status[4]", simply press “Del” key to delete “Status[0] to [2]” and “Status[4]".
4. Set the “Operation” field of the “Status*3+” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.
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5.1.5

Write AO Data (32-bit)

1. Using the same way in the Section 5.1 - Step 4 to create the 5th data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".
In this example
a. Slave/Unit:
Enter the Net-ID of the Slave device.
(e.g., the Net-ID is “4”).

a

b

b. MODBUS Request:
Select “<16> Write Holding Registers”.
c. Base address:
Start from “1” by default.
(Refer the Section 5.1.1 to change it.)
Nb items:
The number of AO signals to write.
(In this case, the number is “2”
because the REAL type requires two
Modbus address).

c

d

d. On change: In case of a write request,
means that the request is activated
each time any variable changed.
(Refer the Section 5.1.1 for details)

e

e. Timeout: Set a timeout value.
When time-out occurred, it will show the defined error code. (The recommended value for the
Modbus RTU/ASCII device is 200 to 1000 ms. In this case the value is 250 ms.)
2. Next, open the “Variables” window and then declare variables that are available for the program.

Tips:
Press “F1” key to view the details
on the MODBUS Master settings.
Double-click it to
open this window.
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Declaring a "Real" variable.
(Refer the Appendix A for details on data type and ranges ; refer the Section 2.3.1 for operations).
Variable name

Data type

Real_Write_1

REAL

Description
Used to write AO data (32-bit).

After completing the setting, the defined variable shows as below:

3. In the “IO Drivers” window, drag variables - “Real_Write_1” and “Status” (that created in the
Section 5.1.1) from the Variables Area to the Symbol Area in the 5th data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status*0+” to “Status[4]", simply press “Del” key to delete “Status[0] to [3]”.
4. Set the “Operation” field of the “Status*4+” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.
5. The “Real_Write_1” is a 32-bit data and required two Modbus addresses. So, set its “Storage” field
as “DWORD (Low – High)”.
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5.1.6

How to use the XV Board?

The XV board belongs to the Modbus Slave I/O board. Before using the I/O board, users must plug it into
the WP-5xx8, and then enable the WP-5xx8 as a Modbus Master (refer the Section 5.1). Please visit the
XV board Selection Guide page to get more details:
www.icpdas.com/root/product/solutions/hmi_touch_monitor/touchpad/xv-board_selection.html

All the Win-GRAF demo programs listed in the following table can be found on the CD-ROM. Refer the
Chapter 12, click the Win-GARF menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo program and to view the details. (CD-ROM:\Napdos\Win-GRAF\demo-project\)
Demo

File Name

Description

XV107, XV107A

demo_XV107.zip

Read 8 DI, Write 8 DO

XV110

demo_XV110.zip

Read 16 DI

XV111, XV111A

demo_XV111.zip

Read 16 DO, Read 1 DO

XV116

demo_XV116.zip

Read 5 DI, Write 6 D0

XV308_1
XV308_2
XV308_3

demo_XV308_1.zip
demo_XV308_2.zip
demo_XV308_3.zip

1. Read 8 AI, Read 8 DI
2. Read 8 AI, Write 8 DO
3. Read 8 AI, Write 4 DO, Read 4 DI

XV310

demo_XV310.zip

Read 4 AI, Write 4 DO, Read 4 DI, Write 4 AO

Common setting:
1. Mouse click the “Open Fieldbus Configuration” tool button to open the “I/O Drivers” window.

If using it as the Modbus
ASCII Master, modify it to
“ASCII:COM0:115200,N,8,1”
2. Double click on “RTU: COM:115200,N,8,1” to
open the “MODBUS Master Port” window.
Note:
All the demo programs listed in above table
enable the WP-5xx8 as a Modbus RTU
Master device and set the "Com. Port" as
"COM0:115200,N,8,1”.
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Configure the AI/AO channel
If you want to use the AI/AO channel of the XV Board (e.g., XV308, XV310) in the WP-5xx8. First, stop
the Win-GRAF driver in the PAC and then configure each AI/AO channel by using
"DCON_Utility_Pro_CE_200.exe".
Using the WP-5238 as an example:
1. Click the "Win_GRAF_WP_5238" (or the small icon on the taskbar) to open the Win-GRAF driver
window, and then click the "End Driver" button.

Stop the Win-GRAF driver

2. Click "My Device" on the desktop and then get into the path "\System_Disk\Tools\dcon_utility_pro"
to run the "DCON_Utility_Pro_CE_200.exe".

3. Click the COM Port button to set the "COM Port" as "COM0", set the "Baud Rate" as "115200" and
set the "Format" as "N,8,1", and then click "OK".
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4. After clicking the Search button, the XV Board (e.g., XV308) will show in the window. Then, double
click this item to get into the setting window.

Double-click

5. In the "Configuration" tab, set the "Data Format" as "Engineering Format" (recommended setting),
set the "Fast Mode" as "Fast Mode" and uncheck the "Reverse DI State (INIT*)".
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6. In the "AI/AI Alarm" tab, to configure the proper ranges and values for each AI channel, and
remenmber to select any AI channel (e.g.,"CH:00") you want to use, then click the "Set Alarm"
button.

XV308:
Type Code

Range

05

+/-2.5 V

06

+/-20 mA

07

+4 mA ~ +20 mA

08

+/-10 V

09

+/-5 V

0A

+/-1 V

0D

+/-20 mA

1A

0 mA ~ +20 mA

Data Format

Minimum

Maximum

Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal

-25000
8000h
-20000
8000h
+4000
0000h
-10000
8000h
-5000
8000h
-10000
8000h
-20000
8000h
0
0000h

+25000
7FFFh
+20000
7FFFh
+20000
FFFFh
+10000
7FFFh
+5000
7FFFh
+10000
7FFFh
+20000
7FFFh
+20000
FFFFh

Note:
1. For easy to use, recommended to use the data format - "Engineering”. (E.g., "+/-2.5 V" will show
as "-25000 to +25000" and "+4 mA to +20 mA" will show as "+4000 to +20000“)
2. When using these "Type Code” - 06, 07, 0D, 1A, please check if the position of eight hardware
jumpers on the XW board are correct.
www.icpdas.com/root/product/solutions/datasheet/hmi_touch_monitor/XV308.pdf
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Note: When using the XV308, you need to click the "Set Power On" and "Set Safe Value" button
(do not choose any DO Status) in the "DO/Alarm" tab.

Do not choose any DO Status.
Then, click the "Set Power On"
and "Set Safe Value" button.

7. Finally, back to the "Configuration" tab and click the "Set Module Configuration" button (Step5) to
finish the AI/AO configuration, and then close the "DCON_Utility_Pro_CE_200.exe". In addition, click
the "Win_GRAF_WP_5238" on the desktop to run the Win-GRAF driver (like Step 1).
Follow the similar way like the steps above to configure the AI/AO of the XV310.
XV310 - Analog Input:
Type Code

Range

05

+/-2.5 V

06

+/-20 mA

07

+4 mA ~ +20 mA

08

+/-10 V

09

+/-5 V

0A

+/-1 V

0D

+/-20 mA

1A

0 mA ~ +20 mA

Data Format

Minimum

Maximum

Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal

-25000
8000h
-20000
8000h
+4000
0000h
-10000
8000h
-5000
8000h
-10000
8000h
-20000
8000h
0
0000h

+25000
7FFFh
+20000
7FFFh
+20000
FFFFh
+10000
7FFFh
+5000
7FFFh
+10000
7FFFh
+20000
7FFFh
+20000
FFFFh
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Note:
1. For easy to use, recommended to use the data format - "Engineering”. (E.g., "+/-2.5 V" will show
as "-25000 to +25000" and "+4 mA to +20 mA" will show as "+4000 to +20000“)
2. When using these "Type Code” - 0, 1, 06, 07, 0D, 1A, please check if the position of eight
hardware jumpers on the XW board are correct.
www.icpdas.com/root/product/solutions/datasheet/hmi_touch_monitor/XV310.pdf
XV310 - Analog Output:
Type Code

Range

0

0 mA ~ +20 mA

1

+4 mA ~+20 mA

2

0V ~ +10 V

3

+/-10 V

4

0 V ~ +5 V

5

+/-5 V

Data Format

Minimum

Maximum

Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal
Engineering
Hexadecimal

0
0000h
+4000
0000h
0
0000h
-10000
8000h
0
0000h
-5000
8000h

+20000
FFFFh
+20000
FFFFh
+10000
FFFFh
+10000
7FFFh
+5000
FFFFh
+5000
7FFFh
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5.1.7

Connecting the XV107/ XV107A (8 DI, 8 DO)

The XV107/XV107A is an 8-channel digital input and 8-channel digital output board. This section
provides a Win-GRAF demo program - "demo_XV107.zip". First, go to Section 5.1.6 for the information
of the XV Board before using it.
Demo description:
This demo added two data blocks. One is used to read 8 DI data and the other is used to write 8 DO
data.
1. Mouse double click the 1st data block (i.e., <2> Read Input Bits) to open the setting window.

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the
“Offset” value for the mapping variable (Date Type: DINT) must set to “0”.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read DI data.

Start from addr. 1 and
read eight data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Write DO data.

Start from addr. 1 and
write eight data.

Write only when data changed.
An exception occurrs if no
respond for 100 ms.
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5.1.8

Connecting the XV110 (16 DI)

The XV110 is a 16-channel digital input board. This section provides a Win-GRAF demo program "demo_XV110.zip". First, go to Section 5.1.6 for the information of the XV Board before using it.
Demo description:
This demo added one data block that used to write 16 DI data.
1. Mouse double click "<2> Read Input Bits" to open the setting window.

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the
“Offset” value for the mapping variable (Date Type: DINT) must set to “0”.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read DI data.

Start from addr. 1 and
read 16 data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
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5.1.9

Connecting the XV111, XV111A (16 DO)

The XV111/ XV111A is a 16-channel digital output board. This section provides a Win-GRAF demo
program - "demo_XV111.zip". First, go to Section 5.1.6 for the information of the XV Board before using
it.
Demo description:
This demo added two data blocks. One is used to write 16 DO data and the other is used to read the DO
status.
1. Mouse double click the 1st data block (i.e., <15> Write Coil Bits) to open the setting window.

Note: The “Offset”value is starting
from “0” and the Modbus address
of a variable is equal to this value
plus 1 (Base address = 1).

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Write DO data.
Start from addr. 1 and
write 16 data.

Write only when data changed.
An exception occurrs if no
respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <1> Read Coil Bits) to open the setting window.

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address).

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read DO data.

Start from addr. 1 and
read one data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

5-25

5.1.10 Connecting the XV116 (5 DI, 6 Relay)
The XV116 is a 5-channel digital input and 6-channel relay output board. This section provides a
Win-GRAF demo program - "demo_XV116.zip". First, go to Section 5.1.6 for the information of the XV
Board before using it.
Demo description:
This demo added two data blocks. One is used to read 5 DI data and the other is used to write 6 DO
data.
1. Mouse double click the 1st data block (i.e., <2> Read Input Bits) to open the setting window.

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the
“Offset” value for the mapping variable (Date Type: DINT) must set to “0”.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read DI data.

Start from addr. 1 and
read five data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Write DO data.
Start from addr. 1 and
write six data.

Write only when data changed.
An exception occurrs if no
respond for 100 ms.
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5.1.11 Connecting the XV308 (8 AI, 8 DIO)
The XV308 is a 8-channel analog input and 8-channel digital input/output board. This section provides
three Win-GRAF demo programs - "demo_XV308_1.zip", "demo_XV308_2.zip" and "demo_XV308_3.zip".
First, go to Section 5.1.6 to view the XV Board instructions and then configure each AI channel by using
"DCON_Utility_Pro_CE_200.exe".
Demo description: (demo_XV308_1)
This demo added two data blocks, one is used to read 8 AI data and the other is used to write 8 DI data.
1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the
“Offset” value for the mapping variable (Date Type: DINT) must set to “0”.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read DI data.

Start from addr. 1 and
read eight data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <2> Read Input Bits) to open the setting window.

Notw: When using the XV308 to read DI data, the address must start from "33".

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read DI data.

Start from addr. 33 and
read eight data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
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Demo description: (demo_XV308_2)
This demo added two data blocks, one is used to read 8 AI data and the other is used to write 8 DO data.
1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the
“Offset” value for the mapping variable (Date Type: DINT) must set to “0”.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read AI data.
Start from addr. 1 and
read eight data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Write DO data.

Start from addr. 1 and
write eight data.

Write only when data changed.
An exception occurrs if no
respond for 100 ms.
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Demo description: (demo_XV308_3)
This demo added three data blocks, the 1st one is used to read 8 AI data, the 2nd one is used to write 4
DO data and the 3rd one is used to read only 4 DI data.
1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

1

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address).

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read AI data.
Start from addr. 1 and
read eight data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.

2. As the figure below, mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to view the
setting window.
3. As the figure below, mouse double click the 3rd data block (i.e., <2> Read Input Bits) to view the
setting window.
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2

3

2. <15> Write Coil Bits:
Write 4 DO data.

Write DO data.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Start from addr. 1 and
write four data.

Write only when data
changed.
An exception occurrs if no
respond for 100 ms.

Read DI data.

Start from addr. 33 and read
only four data in this example.

Read every 50 ms.

3. <2> Read Input Bits, read 4 DI data.
Note:
When using the XV308 to read DI data,
the address must start from "33".
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5.1.12 Connecting the XV310 (4 AI, 2 AO, 4 DI, 4 DO)
The XV310 is a 4-ch analog input, 2-ch analog output, 4-ch digital input and 4-ch digital ouput board.
This section provides a Win-GRAF demo programs - "demo_XV310.zip".
First, go to Section 5.1.6 to view the XV Board instructions and then configure each AI channel by using
"DCON_Utility_Pro_CE_200.exe".
Demo Description
This demo added four data blocks. The 1st one is used to read 4 AI data, the 2nd is used to write 4 DO
data, the 3rd is used to read 4 DI data and the 4th is used to write 2 AO data.
1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

1

Note: The “Offset” value is starting from “0” and the Modbus address for variables is equal to the
“Offset” value plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the
“Offset” value for the mapping variable (Date Type: DINT) must be set to “0”.

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Read AI data.
Start from addr. 1 and
read four data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to view the setting window.

2

The Net-ID of the Slave
device (i.e., XV board).

Write DO data.

Start from addr. 1 and
write four data.

Write only when data changed.
An exception occurrs if no
respond for 100 ms.

3. Mouse double click the 3rd data block (i.e., <2> Read Input Bits) to view the setting window.

3
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The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).
Read DI data.
Note: When using the XV310
to read DI data, the base
address must be set to “33”.

Start from addr. 33 and
read four data.

Read every 50 ms.

An exception occurrs if no
respond for 100 ms.
4. Mouse double click the 4th data block (i.e., <16> Write Holding Registers)

4

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

Write AO data.
Note: When using the XV310
to write AO data, the base
address must be set to “33”.

Start from addr. 33 and
write two data.

Write only when data changed.
An exception occurrs if no
respond for 100 ms.
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5.2

Enabling the Win-GRAF PAC as a Modbus TCP/UDP Master

Application Diagram:

(Refer P1-1 to see the PAC model numbers.)

The Setting Steps:
1. Click the tool icon “Open Fieldbus Configuration” to open the “I/O Drivers” window.

2. Click “Insert Configuration” icon in the left side of the “I/O Drivers” window, and then click “MOSBUS
Master”, then click “OK” to enable a Modbus Master.
Note: One “Modbus Master” can set up multiple Ports (see the next step), can set as a Modbus
Master RTU/ASCII Port (Refer Section 5.1) or a Modbus Master TCP/UDP Port or can set up
not to enable the setting.
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3. Click the tool icon “Insert Master/Port” in the left side, open the setting window and select the
“MODBUS on Ethernet”.
Set up the following items, and then click “OK”.
Address: Fill in the IP Address of the Modbus Slave device (e.g., “192.168.1.100”).
Port:
TCP port Number of the Slave device.
Protocol: If as a Modbus TCP Master, select the “TCP – Open MODBUS”.
If as a Modbus UDP Master, choose the “UDP – Open MODBUS”.
Delay:
Fill in the delay time (e.g., 10 ms, can be 0 ~ 10000).

After received an answer,
wait for 10 ms, and then
send the next request.

If not need the TCP/UDP Port
setting, check “Disabled”.
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4. Click the icon “Insert Slave/Data Block” in the left side to create a “Data Block”.

Read AI Data
5. In the “MODBUS Master Request” setting window, set up the following items, and then click “OK".

a

b

c

d

It‘s not suitable for “Read” commend.

In this example
a. Slave/Unit:
Fill in the Net-ID of the Slave device
(Usually is “1”).
b. MODBUS Request:
Select “<4> Read Input Registers”.
c. Base address:
Default to start from 1.
Nb items:
The AI numbers to read (here is 4).
Note:
If want to change the “Base address”,
please use mouse to right-click the
“MODBUS Master”, and then select
“MODBUS Master Addresses” to
change the value.

e

d. Activation: the sending way of Modbus Request.
Periodic:
Send request periodically. In this case, it
sends request every 1 Sec. “on error”
means that when an error occurs, the next
sending time (in this case, 15 seconds).
On call:
It will send the request once when a
program calls it.
On change: It will send the request once when data is changed.
e. Timeout:

Set up the max. time to wait for the response. If exceeds it, that means an error.
(For Modbus TCP/UDP, recommended: 1000 ~ 3000 ms; this example is 1000 ms)
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6. Open the “Variables” window, set up the variables want to use.

Tips:
press “F1” key to see the setting
method for MODBUS Master.

Double click to open.
Please follow the table to set up 4 WORD (16 bit) variables (refer Section 2.3.1).
Variable Name
Word_1 ~ Word_4
Status

Data Type
WORD
DINT

Dim.
--5

Descriptions
Used to read the AI data (16 bit)
Used to record the read/write status

Refer the Appendix A to see the data types and range of the variables. After setting up, it is as the
picture below.

7. In the “I/O Drivers” window, drag the variables (“Word_1 ~ Word_4” and “Status”) from the
Variables area to the “Symbol” area of the Data Block. Notice: This example shows “Status” is an
Array variable. When drag it to the “Symbol” area, it will become “Status*0+ ~ Status*4+", please
press “Delete” key to delete “Status*1+ ~ *4+".
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8. Set the “Operation” of the “Status*0+” to “Error report” (If reading data fails, its value is an “Error
Code”; when reading data OK, it will reset to “0”.). Press “F1” key to view the setting descriptions for
the Modbus Master. In the title of “Status and command variables”, you can find the details about
this commend and “Error Code”.
9. Select "Word_1 ~ Word_4” and click “Iterate property” to set up the “Offset” value (From: 0; By: 1).

8

9

The setting steps of “Modbus Master Request” for both “Modbus Master RTU/ASCII Port (Section 5.1)”
and “Modbus Master TCP/UDP Port” are the same. Now, we have finished the setting to read AI data.
Please click the item number (link to the Section 5.1.1~5.1.5) in the table below for the setting steps to
read/write other data.
Items Function Code

Modbus Request

Descriptions

1

2

Read Input Bits

Read DI data

2

5

Write single coil bit

Write DO data

3

4

Read Input Registers

Read AI data

4

6

Write single holding register

Write one AO data (16-bit)

5

16

Write Holding Registers

Write multiple AO data (16/32 bits)
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5.2.1

Connecting ET-7000 Series I/O Module

ICP DAS ET-7000 is a series of I/O module supporting Modbus TCP Slave protocol. The Win-GRAF PAC
can enable the Modbus TCP Master to connect the ET-7000 modules. The maximum recommend
amount of the connecting ET-7000 modules depends on the PAC model, such as the XP-8xx8-CE6,
XP-9xx8-CE6, WP-5238 and WP-5248, recommends a maximum of 200; the WP-8xx8, VP-25W8 and
VP-4138 is recommended that no more than 32.
For more information about the ET-7000 series products, please visit the website:
http://www.icpdas.com/root/product/solutions/remote_io/ethernet_io/ethernet_io_selection.html
Use Internet Browser to Set the ET-7000 Modules
Before the first time using the ET-7000, you must set up the ET-7000 by using the Internet Browser.
When the ET-7000 shipping from the factory, the settings are: IP address = 192.168.255.1; Mask =
255.255.0.0. Please set the IP of your PC in the same network (e.g., set the IP to 192.168.255.100, Mask
= 255.255.0.0), then open the browser (such as IE), and enter the IP of the ET-7000 to connect it.
Notice: The Dip Switch on the rear of the ET-7000 must stay in the “Normal” position.

Username: Admin
Password: Admin
(Case sensitive)
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Click “Configuration” > “Module I/O Settings” to set up the range of channels as below, and then click
“Submit”.

Set as “ON" to
enable it.

Set “AI Data Format”
to “ON” (Engineer),
means:
± 2.5: -25000 ~ +25000
± 1 : -1000 ~ +1000
258 : 25.8 (℃)
Users can set the ET-7018Z‘s "AI Data Format" to "ON" (Engineering) for more convenient usage.
For example:
Type Code

Range

04

-1 ~ +1 V

05

-2.5 ~ +2.5 V

18

Type M
Thermocouple
-200 ~ 100°C

Data Format

Minimum

Maximum

Engineering
2’s comp HEX
Engineering
2’s comp HEX
Engineering

-10000
8000h
-25000
8000h
-20000

+10000
7FFFh
+25000
7FFFh
+10000

2’s comp HEX

8000h

4000h

Restore/Open the Demo Project:
The Win-GRAF demo projects in the following sections can be found on the shipping CD, please refer
Chapter 12. Click the menu bar "File" > "Add Existing Project" > "From Zip" can restore/open/check the
demo programs. (CD-ROM:\Napdos\Win-GRAF\demo-project\)
Demo Project
ET-7060
ET-7018Z

File Name
demo_ET7060.zip
demo_ET7018z.zip

Descriptions
Read 6 DIs, write 6 DOs
Read 10 AIs
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1. Click the tool icon “Open Fieldbus Configuration” to open the “I/O Drivers” window.

2. Double click “Open Modbus: IP:502” to open the “MODBUS Master Port” window.
Notice:
All demo projects in this chapter can enable the Win-GRAF PAC as a Modbus TCP Master. Please fill
in the current IP address of your ET-7000, and set "Port" to "502” and "Protocol" to "TCP - Open
Modbus".

Enter the current IP address
of your ET-7000.
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5.2.2

Connecting the ET-7060 (6 DI, 6 Relay)

The ET-7060 is a 6 DI and 6 Relay channels Ethernet I/O module. The Win-GRAF demo project for this
section is "demo_ET7060.zip". Please refer Section 5.2.1 to set up the module channels using the
Internet Browser, and restore/open the demo project.
Demo Descriptions:
This demo creates two Data Blocks, one is used to read 6 DI data, the other is used to write 6 DO data.
1. Double click the first Data Block (<2> Read Input Bits) to open the setting.

Notice: The value of the “Offset” starts from “0”, but the Modbus address of the variable is the “Offset”
value plus 1 (Base address). If set the “Operation” to "Error report”, the “Offset” value of the
variable (Data Type: DINT) must set to “0”.

The Net-ID of the Slave Unit
(ET-7000) is fixed to "1".

Read DI data

Start from the address 1
to read 6 items.

Read once every 50 ms.
If error occurs, wait 5 s to
send the next commend.
If no responds in 500 ms, means error.
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2. Double click the second Data Block (<15> Write Coil Bits) to open the setting window.

The Net-ID of the Slave Unit
(ET-7000) is fixed to "1".

Write DO data.

Start from the address 1
to write 6 items.

Write data, if data is changed.

If no responds in 500 ms, means error.
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5.2.3

Connecting the ET-7018Z (10 AI)

The ET-7018Z is an 10 AI channels Ethernet I/O module. The Win-GRAF demo project for this section is
"demo_ ET7018z.zip". Please refer Section 5.2.1 to set up the module channels using the Internet
Browser, and restore/open the demo project.
Demo Descriptions:
This demo creates one Data Block to read 10 AI data.
1. Double click the first Data Block (<4> Read Input Registers) to open the setting window.

Notice: 1. The value of the “Offset” starts from “0”, but the Modbus address of the variable is the
“Offset” value plus 1 (Base address).
2. If set the “Operation” to "Error report”, the “Offset” value of the variable (Data Type: DINT)
must set to “0”.
3. If AI range is -32768 ~ 32767, please declare the data type as "INT" for the variable.

The Net-ID of the Slave Unit
(ET-7000) is fixed to "1".

Read DI data
Start from the address 1
to read 10 items.
Read once every 50 ms.
If error occurs, wait 5 s to
send the next commend.

If no responds in 500 ms, means error.
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5.3

Connecting the Modbus TCP Slave device has two IP addresses

The previous section lists the way to enable the Win-GRAF PAC as a Modbus TCP Master device, and lists
the way to read/write Modbus TCP Slave device. This section will list the way to create the redundant
"Modbus Master Request", when one IP of the Modbus TCP Slave devices is disconnected, the other IP
can still normally to be read/written data.
Application Diagram:

Modbus TCP Slave
Modbus TCP Master
Follow The Steps:
1. Click the “Open MODBUS:”, and then click the menu bar “Tools” > “Export”.
2. In the “Export Assistant” window, click “Export some project items (XNL)” and “Next”.

2

1

Each Modbus TCP Master can only set to
connect one Slave IP address, so here we
will show the way to copy and generate
the second Modbus Master to connect
the second Slave IP address.

3
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3. Check the “Configurations” and uncheck all other items, and then click “Next”.

4. Browse a suitable path (default in C:\Win-GRAF\Projects) and named for the file (e.g., Master_2.xml),
and then click "Save" button. Finally, click "Finish" to export the settings.
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5. Using the Notepad software to open the file “.xml” that exported in the step 4, and then copy the
content between the <modbus> and </modbus>.

Copy

6. Paste the copied content above the </modbus>, and change the address to the second IP address of
the Modbus Slave device (e.g., “192.168.1.101”), then save and close the file.
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7. Click the Win-GRAF menu bar “Tools” > “Import”.

8. In the “Import Assistant” window, click “Import project items (XNL)” and “Next”.
9. Select the file you want to import (e.g., “Master_2.xml”) and click “Open” button.

8

9
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10. Click “Finish” to finish the import action.

11. In the “IO Drivers” window, there has added a new “Open MODBUS” setting item that includes two
“Modbus Master Request” for using to read the DI and AI. One “Error report” is used to check the IP
connecting status, so please add two “DINT” variables in the Variable area (e.g.,
“ERROR_STATUS11”, “ERROR_STATUS21”) and double click the “Error report” to assign variables.
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Chapter 6
6.1

Retain Variable and Data Storage

Retain Variable

This chapter lists the way to use the "RETAIN_VAR", "RETAIN_ARY", "RETAIN_FLAG_GET",
"RETAIN_FLAG_SET" and "RETAIN_FLAG_CLR” Functions. The Win-GRAF PACs are built-in the Retain
memory for users to store the retain variable data that will not lose due to the PAC shutdown and can
retain the last value at the next time reboot.
In the shipping CD (\Napdos\Win-GRAF\demo-project), you can find the demo project for this chapter
(demo_retain.zip), please refer Chapter 12 to restore this project (Execute File> Add Existing Project >
From Zip) and set the current IP address of your PAC.
Note: Function "Retain_Var()" or Retain_Ary() can only be used in the first PAC Cycle or in the Cycle
that performs the On-line Change. If use them in other Cycle, it will return "FALSE". If the Retain
Variable has not assigned any initial value and the PAC calls the Function, the return value is not
meaningful; users need to assign appropriate initial values to all Retain Variables at least once.
ST Program:
This demo uses Function Retain_Var() and Retain_Ary().
(* "on_line_change_cycle" is declared as DINT
(nonezero means it is in the cycle just after doing on line change).
"retain_done" is declared as BOOL and inited as FALSE.
"tmp_bool" is declared as BOOL.
*)
on_line_change_cycle := GetSysInfo (_SYSINFO_CHANGE_CYCLE) ;
if (retain_done = FALSE) or (on_line_change_cycle <> 0) then
retain_done := TRUE ; (* just do it one time *)
tmp_bool := Retain_Var ( DINT_1 , 1) ; (* retain a DINT variable *)
tmp_bool := Retain_Var ( DINT_2 , 2) ;
tmp_bool := Retain_Var ( REAL_1 , 3) ; (* retain a REAL variable *)
tmp_bool := Retain_Var ( BOOL_1 , 4) ; (* retain a BOOL variable *)
tmp_bool := Retain_Var ( BOOL_2 , 5) ;
(* retain 10 elements of an INT array variable at retain addr starting at 6. *)
tmp_bool := Retain_Ary ( INT_ARY , 6 , 10) ;
(* retain 20 elements of a REAL array variable at retain addr starting at 16. *)
tmp_bool := Retain_Ary ( REAL_ARY , 16 , 20) ;
tmp_bool := Retain_Var ( DINT_3 , 36) ;
(* 64-bit variable can use only addr from 10,001 to 12,000 *)
tmp_bool := Retain_Var ( LINT_1 , 10001) ; (* retain a LINT variable (64-bit) *)
tmp_bool := Retain_Var ( LREAL_1 , 10002) ; (* retain a LREAL variable (64-bit) *)
end_if ;
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You can check/set variables in the "Variables" window, if you are not familiar with the way of the
variable declaration, please refer Section 2.2.2 and Section 2.3.1.

Note: ICP DAS Win-GRAF PAC does not support the "RETAIN variables" Functions in the "Variables"
window, so please refer the five Functions in the following sections to use the Retain Variables.
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6.1.1

RETAIN_VAR (Retain a Variable)

Tips:
Press “F1” key to see the detailed
setting descriptions.
Name:
A variable name (DO NOT use Array variable or String).
Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME,
LINT or LREAL.
Addr:
Data Type: DINT. The address number for retaining the variable, can be 1 to 12,000.
Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.
Note:
1. One Addr can accept only one variable (or one element of the array).
DO NOT assign the same Addr to two variables (or more), or the Retain Value will be wrong.
2. 64-bit data type (LINT or LREAL) can use only the Addr No. from 10,001 to 12,000.
3. Other data type (BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL or TIME)
can use the Addr No. from 1 to 12,000.
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6.1.2

RETAIN_ARY (Retain an Array Variable)

Tips:
Press “F1” key to see the detailed
setting descriptions.

Name[]:
An ARRAY variable name (DO NOT use String).
Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME,
LINT or LREAL.
Addr:
Data Type: DINT. The starting address number for retaining the array variable; can be 1 to 12,000.
Num:
Data Type: DINT. The amount of elements in the Array variable to be retained.
For example:
If there are 100 elements in an Array variable, set "Num" to "1 to 100" is correct, but if set it more
than 100 that is not correct.
If there are 5 elements in an Array variable, set "Num" to "1 to 5" is correct, but if set it more than 5
that is not correct.
Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.

Note:
1. One Addr can accept only one variable (or one element of array).
DO NOT assign the same Addr to two variables (or more), or the Retain Value will be wrong.
2. 64-bit data type (LINT or LREAL) can use only the Addr No. from 10,001 to 12,000.
3. Other data type (BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL or TIME)
can use the Addr No. from 1 to 12,000.
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6.1.3

RETAIN_FLAG_SET/GET/CLR (Set/Get/Clear the Retain Flag)

How to Use:
The "Retain Flag" is a flag (TRUE/FALSE) stored by users in the retain memory. Users can set this retain
flag to indicate "All retain data has been assigned a proper value before". When a PAC starts without
setting a proper value to retain variable before, the data of the retain variable read from the retain
memory is not correct (it is normally a strange value). So users have to assign proper value to all retain
variable at least once to let the application work well. Then after user can call the "Retain_Flag_Set()" to
set the retain flag. It means "All retain data has been assigned a proper value".
To get the state of the Retain Flag, please call "Retain_Flag_Get()".
To clear the state of the Retain Flag, please call "Retain_Flag_Clr()".
ST Program:
(* "on_line_change_cycle" is declared as DINT
(nonezero means it is in the cycle just after doing on line change) .
"retain_done" is declared as BOOL and inited as FALSE .
"tmp_bool", "retain_flag" and "to_set_flag" are declared as BOOL.
*)
on_line_change_cycle := GetSysInfo (_SYSINFO_CHANGE_CYCLE) ;
if (retain_done = FALSE) or (on_line_change_cycle <> 0) then
retain_done := TRUE ; (* just do it one time *)
tmp_bool := Retain_Var( DINT_1 , 1) ; (* retain a DINT variable *)
tmp_bool := Retain_Var( DINT_2 , 2) ;
tmp_bool := Retain_Var( REAL_1 , 3) ; (* retain a REAL variable *)
tmp_bool := Retain_Var( BOOL_1 , 4) ; (* retain a BOOL variable *)
(* ... After doing all the Retain Functions ... *)
retain_flag := Retain_Flag_Get();
if (retain_flag = FALSE) then
(*If Retain variable does not set up any proper value, you can do some proper operation here. *)
(* ... *)
end_if ;
end_if ;
(* When all Retain variables are assigned proper values,
remember to set the "to_set_flag" to "TRUE" for calling "Retain_Flag_Set() once,
so that, when next time you use the "Retain_Flag_Get()", it can return "TRUE".
*)
if (to_set_flag = TRUE) then
to_set_flag := FALSE ;
tmp_bool := Retain_Flag_Set() ;
end_if ;
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LD Program:
(Press “F1” key to see the detailed setting descriptions.)
RETAIN_FLAG_SET: Set the retain flag.

Q: Data Type: BOOL. Always return TRUE.

ST Program:
if to_set_flag then
to_set_flag := FALSE ;
TMP_BOOL := Retain_Flag_Set() ;
end_if ;

RETAIN_FLAG_GET: Get the state of the retain flag.

Q: Data Type: BOOL.
“TRUE”: flag is set;
“FALSE”: flag is not set.

ST Program:
retain_flag := Retain_Flag_Get() ;

RETAIN_FLAG_CLR: Clear the retain flag.

Q: Data Type: BOOL. Always return TRUE.

ST Program:
if to_clr_flag then
to_clr_flag := FALSE ;
TMP_BOOL := Retain_Flag_Clr() ;
end_if ;
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6.2

Retain Variable for WP-5xx8 Only

You can refer the following demo project (demo_wp5_retain.zip) to use retain variables with files in the
\System_disk\Win-GRAF\ .
In the shipping CD (\Napdos\Win-GRAF\demo-project), you can find the demo project for this section
(demo_wp5_retain.zip), please refer Chapter 12 to restore this project (Execute File> Add Existing
Project > From Zip) and set the current IP address of your PAC.
This project includes an ST main program (Main) and 3 ST sub-programs (load_retain, save_retain and
Go_retain).

Limitation :
This project is not good at handling Retain variables which value changes frequently. For example, value
changed about every second or every minute. That is because these retain values of this project are
saved within files in the \System_Disk. The file operations in it consume more CPU time, which will slow
down the PAC performance if retain value changed frequently.

The "demo_wp5_retain" project has the following default values. Please set your own proper initial
values.
MAX_VAR_REAL:
100 (Max. amount for retaining REAL variables)
MAX_VAR_OTHER: 100 (Max. amount for retaining integer+Bool+Timer variables)
Dim of REAL_VAR_now and REAL_VAR_old:
100 ([0..99], the same as the value "MAX_VAR_REAL")
Dim of OTHER_VAR_now and OTHER_VAR_old: 100 ([0..99], the same as the value "MAX_VAR_OTHER")
Note: The bigger the value of the MAX_VAR_REAL and MAX_VAR_OTHER, the larger the PAC cycle time
will be. So it is better to declare just fine value for the MAX_VAR_REAL and MAX_VAR_OTHER.

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

6-7

This project declares the following variables for demo purpose only. Please re-declare your own
variables.
My_REAL_00 ~ My_REAL_07 (Data Type: REAL)
My_DINT_00 ~ My_DINT_05 (Data Type: DINT)
My_BOOL_00 ~ My_BOOL_02 (Data Type: BOOL)
My_Timer_00 ~ My_Timer_05 (Data Type: TIME)
You can see more variables in the "Variables" window.

The “Dim.” must
be the same.

The directory and files for all Retain variables.

"Go_retain" sub-program is used to do the retain operation. Remember to modify this sub-program.
There are 4 sections should to be modified in it. Please search "Add your REAL variables for retain here"
and "Add your integer, BOOL, Timer variables for retain here", and depend on your re-declared variables
to modify your "Go_retain" sub-program.
(* Add your REAL variables for retain here *)
(* ------------------------------------------------- *)
My_REAL_00 := REAL_VAR_now[0] ;
My_REAL_01 := REAL_VAR_now[1] ;
My_REAL_02 := REAL_VAR_now[2] ;
My_REAL_03 := REAL_VAR_now[3] ;
My_REAL_04 := REAL_VAR_now[4] ;
My_REAL_05 := REAL_VAR_now[5] ;
My_REAL_06 := REAL_VAR_now[6] ;
My_REAL_07 := REAL_VAR_now[7] ;
(* ------------------------------------------------- *)

(* Add your integer, BOOL, Timer variables for retain here *)
(* ................................................. *)
My_DINT_00 := OTHER_VAR_now[0] ;
My_DINT_01 := OTHER_VAR_now[1] ;
My_DINT_02 := OTHER_VAR_now[2] ;
My_DINT_03 := OTHER_VAR_now[3] ;
My_DINT_04 := OTHER_VAR_now[4] ;
My_DINT_05 := OTHER_VAR_now[5] ;
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My_BOOL_00 := Any_to_BOOL( OTHER_VAR_now[6] ) ;
My_BOOL_01 := Any_to_BOOL( OTHER_VAR_now[7] ) ;
My_BOOL_02 := Any_to_BOOL( OTHER_VAR_now[8] ) ;
My_Timer_00 := Any_to_TIME( OTHER_VAR_now[9] ) ;
My_Timer_01 := Any_to_TIME( OTHER_VAR_now[10] ) ;
My_Timer_02 := Any_to_TIME( OTHER_VAR_now[11] ) ;
My_Timer_03 := Any_to_TIME( OTHER_VAR_now[12] ) ;
My_Timer_04 := Any_to_TIME( OTHER_VAR_now[13] ) ;
My_Timer_05 := Any_to_TIME( OTHER_VAR_now[14] ) ;
(* ................................................. *)

(* Add your REAL variables for retain here *)
(* ------------------------------------------------- *)
REAL_VAR_now[0] := My_REAL_00 ;
REAL_VAR_now[1] := My_REAL_01 ;
REAL_VAR_now[2] := My_REAL_02 ;
REAL_VAR_now[3] := My_REAL_03 ;
REAL_VAR_now[4] := My_REAL_04 ;
REAL_VAR_now[5] := My_REAL_05 ;
REAL_VAR_now[6] := My_REAL_06 ;
REAL_VAR_now[7] := My_REAL_07 ;
(* ------------------------------------------------- *)

(* Add your integer, BOOL, Timer variables for retain here *)
(* ................................................. *)
OTHER_VAR_now[0] := My_DINT_00 ;
OTHER_VAR_now[1] := My_DINT_01 ;
OTHER_VAR_now[2] := My_DINT_02 ;
OTHER_VAR_now[3] := My_DINT_03 ;
OTHER_VAR_now[4] := My_DINT_04 ;
OTHER_VAR_now[5] := My_DINT_05 ;
OTHER_VAR_now[6] := Any_to_DINT( My_BOOL_00 ) ;
OTHER_VAR_now[7] := Any_to_DINT( My_BOOL_01 ) ;
OTHER_VAR_now[8] := Any_to_DINT( My_BOOL_02 ) ;
OTHER_VAR_now[9] := Any_to_DINT( My_Timer_00 ) ;
OTHER_VAR_now[10] := Any_to_DINT( My_Timer_01 ) ;
OTHER_VAR_now[11] := Any_to_DINT( My_Timer_02 ) ;
OTHER_VAR_now[12] := Any_to_DINT( My_Timer_03 ) ;
OTHER_VAR_now[13] := Any_to_DINT( My_Timer_04 ) ;
OTHER_VAR_now[14] := Any_to_DINT( My_Timer_05 ) ;
(* ................................................. *)
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Test Project:
Before testing, make sure you have already set up the PAC IP and compile/download the project into the
PAC (refer Section 2.3.4 and Section 2.3.5). When connecting with the PAC, all values in the Spy list
(refer Section 11.3) will be "0" (or "FALSE") at the begging, please enter some values at will. When the
value has changed, it will create a text file in the PAC (\System_disk\Win-GRAF\retain_real.txt and
retain_other.txt) and Write data to the files.
Note: The "Save_file_counter" will show the number of times the file is written, if this value is changing
rapidly (e.g., to write several times every second/minute.), it is not suitable for this application
(Because to write into files frequently in the "\System_disk" will reduce the PAC effectiveness.).

It increases 1, if it writes once.
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6.3

Save Data to EEPROM

The Win-GRAF PAC has a built-in EEPROM memory for users to read and write data, which will not lose
data when the PAC shut down. Compared to the read and write of the SRAM, EEPROM has the following
disadvantages:
Note: Some PAC have no EEPROM memory (like the WP-5238, WP-5248). They don't support
EEP_Read() and EEP_Write().
Advantages: Provides another way to save the important data, besides the Retain Variable. (Section 6.1).
Disadvantages: 1. The operation to read/write EEPROM will use much more CPU time (about 5 ~ 50 ms),
but changing to the way of "Retain variable", CPU time is much less than 1 ms.
Therefore, do not use the "EEP_Read" and "EEP_Write" Functions too frequently, or
it will increase the PAC Cycle time.
2. EEPROM has a “write” limitation (depending on the PAC), it is not suitable to write
the same data many times. So, DO NOT call "EEP_Write" Function within each PAC
Cycle to do the “write” operation.
ST Program: (Following will show the safe and dangerous coding ways.)
(* Declare "FIRST_CYCLE" as a “BOOL” variable and has an initial value “TRUE”.
Declare "tmp_bool" as a “BOOL” variable。
Declare "New_Val" and "Old_Val" as “DINT” variables. *)
(* Read the EEPROM once in the first Cycle. *)
if FIRST_CYCLE then
FIRST_CYCLE := FALSE ; (* means it is not the first Cycle any more *)
tmp_bool := EEP_Read ( 1 , New_Val) ;
end_if ;
(* Safe Coding Way: write to the EEPROM only when the value is changed. *)
if New_Val <> Old_Val then
Old_Val := New_Val ;
tmp_bool := EEP_Write ( 1 , New_Val ) ;
end_if ;

(* Dangerous Coding Way: EEPROM may be destroyed very soon. *)
(* Declare "FIRST_CYCLE" as “BOOL” variable and has an initial value “TRUE”.
Declare "tmp_bool" as “BOOL” variable.
Declare "New_Val" and "Old_Val" as “DINT” variables. *)
(* Read the EEPROM once in the first Cycle. *)
if FIRST_CYCLE then
FIRST_CYCLE := FALSE ; (* means it is not the first Cycle any more *)
tmp_bool := EEP_Read ( 1 , New_Val) ;
end_if ;
(*Dangerous Coding Way: Write the "New_Val" value to the EEPROM one time in every Cycle. *)
tmp_bool := EEP_Write ( 1 , New_Val ) ;
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6.3.1

EEP_READ (Read a Value from the EEPROM)

Tip:
Press “F1” key to see the detailed
setting descriptions.

Addr: (Data Type: “DINT”)
Address, can be 1 to 1200. If the variable type of the "@Name" parameter is a 64-bit data (e.g., LINT
or LREAL), the "Addr" can be 1001 to 1200 only.
@Name :
A variable name to store the value from the EEPROM.
(DO NOT use string variable. Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT,
UDINT, DWORD, REAL, TIME, LINT or LREAL.)
Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.
If the type of the "@Name" parameter is REAL or LREAL, will return "Q" as FALSE if the value is NaN
(Not a Number) or other error happens. In the case of NaN, the REAL/LREAL variable will get the
value "0.0".

6.3.2

EEP_WRITE (Write a Value to the EEPROM)

Addr: (Data Type: “DINT”)
Address, can be 1 to 1200. If the variable type of the "Value" parameter is a 64-bit data (e.g., LINT or
LREAL), the "Addr" can be 1001 to 1200 only.
Value :
The value to write to the EEPROM.
(DO NOT use string variable. The value type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD,
DINT, UDINT, DWORD, REAL, TIME, LINT or LREAL.)
Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.
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Chapter 7

Exchange Data between PACs (Data Binding)

"Binding" function is used to exchange data between ICP DAS Win-GRAF PACs, the data transmission is
event triggered. It is much more efficient than polling way. Win-GRAF offers two ways to set up Binding:
 PUBLIC: Publish one PAC’s own data, or for use of VB .net, C#, C or Soft-GRAF HMI in the same
PAC.
 EXTERN: To get data from other PAC.
Application Diagram:
Note:
The max. number of
“Binding” (EXTRN) can be
used by one Win-GRAF
PAC:
XPAC:
Max. 32
WinPAC: Max. 16
ViewPAC: Max. 16
(See P1-1 for details.)

"PUBLIC" Setting Steps:
When the PAC sets up the "PUBLIC" area, means to publish its own data.
1. Mouse right-click on the toolbar "Open Binding Configuration" icon to open the "Binding" window.
2. Click "PUBLIC (: 9000)" to configure the data to be published as PUBLIC; "Address" field needs not
to fill in; "Port" field is fixed to "9000", do not change it.
Open Binding Configuration

"PUBLIC" area
needs not to fill
in the Address.

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

Variable
area

7-1

3. Before setting the data to become public, first you must create the variables want to become
public in the Variable area. Right-click on "Global variables" and press "Ins" key to add the new
variables. In the following table, the variables are used for this example. You can set up your own.
After finished, the screen is as below.

Variables Name

Data Type

Public_BOOL

BOOL

Public_INT

INT

Public_DINT
Public_WORD

DINT
WORD

Public_REAL

REAL

Press "Enter" key

4. Right-click on the "PUBLIC (: 9000)", and then select the variables that you want to publish, and
drag them to the "Name" area. "Identifier" field will automatically generate numbers (if other PAC
wants to access the data, need to set the same ID number).
Note: "PUBLIC" can use up to 8192 variables; "Identifier" number can only be "1 ~ 8192".

If the user want to assign continuous “Identifier”
number, first click “Identifier” field and select
those variables wish to be assigned, and then
click “Iterate property” to set up numbers.

2

1

3
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"EXTERN" Setting Steps:
When the PAC sets up the "EXTERN" area, means will get the data from other external PAC.
5. Click the "Insert Master/Port" icon in the left side, it will show the "Group" window. Follow the
descriptions below to set up this window, and then click "OK“ button.

PAC2

PAC1

Name:
Address:

Port:

Can be modified to the desired name.
Enter the IP address of the PAC which data will be obtained (e.g., "192.168.1.100").
User can enter two IP Addresses (e.g., "192.168.1.100/200.168.1.100"; that PAC must
use two Ethernet Ports), so that when one IP address occurs any problem, it will try to
link the second IP address.
Fixed to use "9000", do not change it.

6. In the variable area, set up the data type you want
to get. (Refer Step 3 - Right click on "Global
variables" and press "Ins" key to add the variables).
The variables that listed in the table are used for
this example. You can set up your own. After
finished, the screen is as below.

Variables Name

Data Type

PAC1_BOOL

BOOL

PAC1_DINT

DINT

PAC1_REAL

REAL

Error_Status

DINT

7. Please drag the variables you need into the "Name" area of the "EXTERN:1".
Note: "Identifier" field will automatically generate numbers, please change them to the same as
the opened IDs of the PAC that you want to get data from.

Variable area
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8. As the picture below, "Error_Status" variable is used to determine the communication status of the
PAC, please set this ID to "0" and then double-click "Destination" field and set it to "Connection
error status".

Note:
a. If "EXTERN" set up two IP addresses (step 5), then the "Error_Status" will return two communication
status. As the following table, use 8 bits to indicate the connection status. The bit 0 ~ 3 represents
the first IP connection status (If all bits are 1, the value is 15); the bit 4 ~ 7 represents the second IP
connection status (If all bits are 1, the value is 240). As long as the value is not equal to “0”, it means
that there are connection errors.
IP2 Connection Status
2
26
25
24
0

IP1 Connection Status
2
22
21
20
0

0

≠0 (1 ~ 15)

IP1 Connection error

≠ 0 (16 ~ 240)

0

IP2 Connection error

≠0

≠0

7

3

Status Descriptions
Connection OK

IP1 and IP2 Connection error

b. The return value of the "Error_Status" is an integer value. The following division operation provides
a way to determine this value. Dividing this value by 16, the quotient represents the IP2 connection
status, and the remainder represents the IP1 connection status. If the values are not equal to “0”, it
means that there is any connection error. For example: If "Error_Status" = 16, divided by 16, the
quotient = 1 (≠ 0, IP2 Connection error) and the remainder = 0 (IP1 Connection OK); If "Error_Status"
= 3, divided by 16, the quotient = 0 (IP2 Connection OK) and the remainder = 3 (≠ 0, IP1 Connection
error);
Notice:
Please ignore the descriptions of the "Connection status" and
"Variable status" in the "Networked applications - Dual
binding on redundant ETHERNET" of the "HTML Help" that
opened when press "F1" key. That explanation is wrong and
does not comply with the ICP DAS Win-GRAF PAC. Please
ignore it.
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Chapter 8

Connecting DCON I/O Modules

The Win-GRAF PAC can connect the ICP DAS "I-7000" and "I-87KW" remote DCON I/O modules via the
COM Port (RS-485). Each PAC can enable up to 16 DCON Ports, and each Port can connect up to 50
remote DCON I/O modules (not recommended over 32). If select the "I-87KW" series I/O modules, it
must be used with the RS-485 I/O Expansion Unit (e.g., I-87K4/5/8/9 or RU-87P4/8). You can view the
detailed product information on the ICP DAS website:
http://www.icpdas.com/root/product/solutions/remote_io/remote_io_products.html

Before connecting "I-7000" or "I-87KW" remote DCON I/O modules, you must use "DCON Utility"
software to configure each module for the Protocol (choose DCON mode), Address (1 ~ 255), Baudrate
(the same with the Win-GRAF PAC, recommended set to 9600), Checksum (usually Disable), Data format
and other Input/Output settings (set according to demand).
Note:
A. When using the AI module of I-7000 and I-87KW, set the Data format to "2's Complement".
E.g. I-7005, I-7013, I-7014D, I-7015, I-7016, I-7017R, I-7018Z, I-7019R, I-7033; I-87005W, I-87013W,
I-87015W, I-87015PW, I-87016W, I-87017W, I-87017RCW, I-87017ZW, I-87017DW, I-87018W,
I-87018RW, I-87018ZW, I-87019RW, I-87019ZW, and other Analog Input modules.
B. When using the AO module of I-7000 and I-87KW, set the Data format to "Engineering"
E.g. I-7021, I-7022, I-7024, I-7024R; I-87024W, I-87024UW, I-87024CW, I-87028UW, I-87028CW,
I-87028VW, I-87028VW-20V, and other Analog Output modules.
"DCON Utility" is an easy-to-use software toolkit that help user search the network, configure the I/O
modules and test the I/O status. Please visit the website to get the software program and user manual:
www.icpdas.com/products/dcon/introduction.htm

The following will introduce the setting method in the Win-GRAF Workbench.
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8.1

Setting "DCON" I/O Boards

"DCON" can be used to enable an RS-485 Port to connect remote DCON I/O modules (e.g., I-7000 series
modules, RU-87P8 I/O Expansion Unit + I-87KW I/O modules, or I-87K8 I/O Expansion Unit + I-87KW I/O
modules). If want to enable more than one DCON Port, please set up multiple "DCON" I/O Boards. (One
PAC can enable up to 16 "DCON".)

1. Click "Open I/Os" of the Win-GRAF tool bar to open the “I/O Boards” setting window.

2. Double click "Slot8" to add "DCON" I/O Boards (Refer Chapter 4), and then double click "DCON" to
open the “Properties” window.
Note: The Slot 0 to Slot 7 are reserved for real I/O modules that plugged into the PAC, and the slot 8
or above are for other usage.

Setting Descriptions

Parameters:
Note: This "DCON" supports only the communication properties "N,8,1". That is "No-parity" , "8
character size" and "1 stop bit" . So please must configure all DCON I/O modules to "N,8,1".
Port:
Baud_rate:

Host_watchdog_Enabled:
Watchdog_timeout:

COM port number (1 ~ 37, depends on the PAC.)
Communication baudrate in bps, can be 1200, 2400, 4800, 9600, 19200,
38400, 57600, 115200 (bps). Set a wrong value will use the default value
9600.
1: enable host-watchdog, 0: disable it.
Set a nonzero value will use the value 1.
Unit: ms, can be 3000 ~ 25500.
Set larger than 25500 will use 25500 ms (25.5 sec).
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Set smaller than 3000 will use 3000 ms (3 sec).
Ignore this setting when "Host_watchdog_Enabled" is 0.
Checksum_enabled:
0: disabled, 1: enabled.
Set a nonzero value will use the value 1.
Delay_ms_between_polls: Unit: ms, default is 0 ms. Valid range is 0 ~ 1000.
Set smaller than 0 will use 0 ms.
Set larger than 1000 will use 1000 ms.
If there is no wireless module connected, set a smaller value.
For instance, set as 0 ~ 10.
If there are wireless modules (e.g., ICP DAS ZigBee Products: ZigBee
Converters or ZigBee I/O modules.) connected, set a bigger value.
For instance, set a value between 30 ~ 100 or other values.
Set larger value will get slower polling efficiency.
3. Double click the item to be set, and then fill in the value.

4. After setting up the "DCON" in the "I/O Boards" window, it will automatically add a "BOOL" input
variable in the "Variables" window. When the Win-GRAF links to the PAC, it will show the COM Port
communication status (TRUE: OK; FALSE: error.).
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8.2

Using I/O Function Blocks

The Win-GRAF supports many ICP DAS DCON remote I/O modules, you can open the "Library Manager"
(Refer Section 1.2.3) or press "F1" key in the "Function and FBs" to view these I/O Function Block
descriptions. This section will introduce "D_7065", "D_7018Z", "D_7083", "D_87084_freq",
"D_87084_cnt4", "D_87084_cnt8", and "DL_100T485" I/O Function Blocks.

In the LD Program - Functional Block area, expand the "ICP DAS - XP-WP-VP" folder of the "Blocks" panel.
There are many Functions and Function Blocks. You can select the desired one, and drag it into the
editing area of the program.

Tips:
Press “F1” to see the setting description.
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8.2.1

“D_7065” Function Block

“D_7065”: Connect a remote I-7065, I-7065D (Power Relay Output Module) or I-7065A, I-7065AD,
I-7065B, I-7065BD (Solid State Relay Output Module).
Note:
1. All connected DCON I/O modules should be configured once by the DCON Utility (see P8-1).
2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.
3. All values of DI channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).
4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7065.zip) in the shipping CD and
see the program and descriptions.
Supposition: Use PAC‘s COM2 to connect the I-7065 (Addr. = 2) with 4 DI and 5 Relay output channels.

If "OK" returns "TRUE".

Declare 9 BOOL variables
(DI & DO of the I-7065).

Input Parameters:
EN:
Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port:
Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr:
Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)
RL_1 ~ RL_5: Data type: BOOL. 5-Ch DO values.
Output Parameters:
OK:
Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
IN_1 ~ IN_4: Data type: BOOL. 4-Ch DI values.
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8.2.2

“D_7018Z” Function Block

“D_7018Z”: Connect a remote I-7018Z module that is a 10-channel Thermocouple analog input module
for measuring voltage, current or temperature with features of individual channel
configuration, open-wire detection and over Voltage protection.
Note:
1. All connected DCON I/O modules should be configured once (e.g., Address, Baudrate, etc.) by the
DCON Utility (see P8-1). Please must configure the data format of AI modules to "2’s complement"
by DCON utility, or the Win-GRAF PAC can not read them well.
2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.
3. All values of AI channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).
4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7018z.zip) in the shipping CD and
see the program and descriptions.
Supposition: Use PAC‘s COM2 to connect the I-7018Z (Addr. = 3) to measure the Celsius temperature.

If "OK" returns "TRUE".

Declare 10 REAL variables
(AI of the I-7018Z).

Input Parameters:
EN:
Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port:
Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr:
Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)
Tmp_F:
Data type: DINT. Temperature Format, can be 1 or 2:
1 : temperature unit in Degree Celsius.
2 : temperature unit in Degree Fahrenheit.
Other value: use it as "1:temperature unit in Degree Celsius".
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Output Parameters:
OK:
Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
V_0 ~ V_9:
Data type: REAL. 10-Ch AI value.
If the channel range type is configured as mV or Volt by DCON utility, the unit of the
returned channel value is Volt.
For example, 0.85421 means 0.85421 V or 854.21 mV.
If the channel range type is configured as mA by DCON utility, the unit of the
returned channel value is mA.
For example, 1.5567 means 1.5567 mA .
If the channel range type is configured as temperature, the value unit is degree.
For example, 25.75 means 25.75 degrees.

Open-wire Detection:
If the returned temperature is greater than "9000.0", it means that
1. The temperature sensor may be broken-line.
2. The temperature sensor may be damaged.
3. The DCON module is not configured well to fit the connected temperature sensors.
4. The ohm measured by the connected sensor is not correct.
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8.2.3

“D_7083” Function Block

“D_7083”: Connect a remote I-7083, I-7083D, I-7083B or I-7083BD module that is a 3-axis, 32 bits
encoder counter.
Note:
1. To get the Encoder value of the I-7083, I-7083D, I-7083B and I-7083BD module, first using "D_7083"
Function Block. Then, using the “Counter_Start”, “Counter_Stop”, “Counter_Get”, “Counter_State”
and “Counter_Reset” Functions (Refer Section 4.9) to operate encoder channels in an I-7083,
I-7083D, I-7083B and I-7083BD module.
2. All connected DCON I/O modules should be configured once (e.g., Address, Baudrate, etc.) by the
DCON Utility (see P8-1). Please must configure the data format of AI modules to "2’s complement"
by DCON utility, or the Win-GRAF PAC can not read them well.
3. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.
4. All values of AI channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).
5. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7083.zip) in the shipping CD and
see the program and descriptions.
Supposition: Use PAC‘s COM2 to connect the I-7083 (Addr. = 4) with 3 DI channels.

If "OK" returns "TRUE".
To read/write/operate
Encoder, refer Section 4.9.
Declare 3 BOOL variables
(Z-index DI of I-7083).
Input Parameters:
EN:
Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port:
Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr:
Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)
Output Parameters:
OK:
Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Z_0 ~ Z_2:
Data type: BOOL. 3-ch Z-index DI value.
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8.2.4

“D_87084_FREQ” Function Block

"D_87084_freq": Connect a remote I-87084W in an I/O Expansion Unit (e.g., I-87K4/5/8/9 or RU-87P4 or
RU-87P8.) to measure 8-ch frequency.
Note:
1. Please MUST configure the I-87084W's frequency data format as "Hex format" by DCON utility (see
P8-1) when using the I-87084W to measure frequency. Or it will not work.
2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.
3. All values of AI channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).
4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_FR.zip) in the shipping CD
and see the program and descriptions.
Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 5) to measure 8-ch frequency.

If "OK" returns "TRUE".

Declare 8 DINT variables
(frequency inputs of the
I-87084W)

Input Parameters:
EN:
Port:
Addr:

Data type: BOOL. TRUE: enable it; FALSE: disable it.
Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

Output Parameters:
OK:
Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Freq_0 ~ Freq_7: Data type: DINT. 8-Ch frequency value, unit is Hz.
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8.2.5

“D_87084_CNT4” Function Block

"D_87084_CNT4": Connect a remote I-87084W in an I/O Expansion Unit (e.g., I-87K4/5/8/9 or RU-87P4
or RU-87P8.) to measure 4-ch counters.
Note:
1. Please MUST configure the I-87084W's counter data format as "Hex format" by DCON utility (see
P8-1) when using the I-87084W to measure counters. Or it will not work.
2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.
3. To get the 4-ch counter value from the remote I-87084W, first using "D_87084_cnt4" Function Block.
Then, using the "Counter_Start", "Counter_Stop", "Counter_Get", "Counter_State" and
"Counter_Reset" Functions (refer Section 4.9) to operate counter channels.
4. All values of AI channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).
5. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_C4.zip) in the shipping CD
and see the program and descriptions.
Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 6) to measure 4-ch counters.

If "OK" returns "TRUE".
To read/write/operate
counter, refer Section 4.9.

Input Parameters:
EN:
Port:
Addr:

Data type: BOOL. TRUE: enable it; FALSE: disable it.
Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

Output Parameters:
OK:
Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
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8.2.6

“D_87084_CNT8” Function Block

"D_87084_CNT8": Connect a remote I-87084W in an I/O Expansion Unit (e.g., I-87K4/5/8/9 or RU-87P4
or RU-87P8) to measure 8-ch counters.
Note:
1. Please MUST configure the I-87084W's counter data format as "Hex format" by DCON utility (see
P8-1) when using the I-87084W to measure counters. Or it will not work.
2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.
3. To get the 8-ch counter value from the remote I-87084W, first using "D_87084_cnt8" Function Block.
Then, using the "Counter_Start", "Counter_Stop", "Counter_Get", "Counter_State" and
"Counter_Reset" Functions (refer Section 4.9) to operate counter channels.
4. All values of AI channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".) .
5. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_C8.zip) in the shipping CD
and see the program and descriptions.
Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 7) to measure 8-ch counters.

If "OK" returns "TRUE".
To read/write/operate
counter, refer Section 4.9.

Input Parameters:
EN:
Port:
Addr:

Data type: BOOL. TRUE: enable it; FALSE: disable it.
Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

Output Parameters:
OK:
Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
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8.2.7

“DL_100T485” Function Block

"DL_100T485": Connect a remote DL-100T485 module to get humidity and temperature value.
Product website: http://www.icpdas.com/root/product/solutions/remote_io/rs-485/dl_series/dl-100t485.html
Note:
1. Please use "DL-100T485 Utility" software in the shipping CD to configure the appropriate parameters
of the module (e.g., Module ID). The TDL-100T485’s default Address (ID) is "1", Baudrate is "9600",
and the Checksum is "Disable".
2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.
3. All values of AI channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".) .
4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\ DEMO_DL_100T485.zip) in the shipping CD
and see the program and descriptions.
Supposition: Use PAC‘s COM2 to connect the DL_100T485 (Addr. = 1) to get humidity and temperature
value.

If "OK" returns "TRUE".

Declare 2 REAL variables
(humidity and temperature
values of the DL-100T485.)
Input Parameters:
EN:
Port:
Addr:

Data type: BOOL. TRUE: enable it; FALSE: disable it.
Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module, can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

Output Parameters:
OK:
Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
RH:
Data type: REAL. The value is "Relative humidity"; unit is 1%.
For example, a value "45.7" means 45.7%.
Temp_C:
Data type: REAL. The temperature value is in "Degree Celsius".
For example, a value "25.7" means 25.7 Degree C.
Temp_F :
Data type: REAL. The temperature value is in "Degree Fahrenheit".
For example, a value "78.26" means 78.26 Degree F.
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Chapter 9

On Line Change

"On Line Change" function allows Win-GRAF PAC change its application to a modified one during the
PAC running time. The modified application must be the same name as the original one that currently
running in the PAC. The "On Line Change" is primarily used for emergency, such as, when the application
is not allowed to be disabled or stopped for a while or cannot find time to replace a new application (for
example, the device needs 24 hours operation and cannot be stopped). Except the above situations, it is
not recommended to use this function! You had better stop the running application, then download the
modified application to the PAC (see Section 2.3.5), which is more safe.

9.1

Limitations of "On Line Change"
Please notice the important limitations before enabling the "On Line Change"!

When On Line change is enabled, you can perform on the fly the following kinds of changes:
Change the code of a program.
 Change the condition of a SFC transition or the actions of a SFC step.


Step

Transitions

Action

Transition 1
Step

Transition 2
Step

Sequential Function
Chart (SFC)

Create, rename or delete global and local variables.
 Create, rename or delete global and local function block instances.
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The following kinds of changes are not allowed:


Create, delete or rename a program. (It will appear a warning message if delete a program.)



Change SFC charts.
Change the local parameters and variables of a UDFB.
Change the type or dimension (or string length) of a variable or function block instance.
Change the set of I/O boards.
Change the definition of RETAIN variables.






In addition, the following programming features that are not safe during a change should not be used:


Pulse (P or N) contacts and coils (edge detection).

 Instead, you must use declared instances of R_TRIG and F_TRIG function blocks.
Rising Pulse Detection
Before Enable

After Enable

P
(False > True)

Decreased Pulse Detection

N
(True > False)



Loops in FBD with no declared variable linked.

 You need to explicitly insert a variable in the loop.
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9.2

Using "On Line Change"

Enable The "On Line Change" Function:
1. Mouse click "Project > Settings..." from the menu bar, then double click "On Line Change" item to set
it "Enabled".

2. Click "Project > Build All Projects" from the menu bar. Must compile the program first, then can set
up the following steps.

This message can be ignored when just
enable On Line Change.
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Setup the Number of Variables:
When the "On Line Change" is enabled, you have to set up the number of variables reserved for the
declaration of the new variables and Function Blocks for future on-line change usage.
3. The same as the step 1, mouse click "Project > Settings..." from the menu bar, then double click on
the "On Line Change" to show the setting window.
Please set the needed new number in the “Value" or “Margin" fields.
Note: If both “Value" and “Margin" have set values, it will use the larger value. In this example,
"Value" is set as "30" and “Margin" is set as "10", then the displayed value x 10% is smaller
than 30, so it will use the larger value "30".
4. Click the needed Variable Type, then click the "Set“ button.
(E.g., Click "BOOL/SINT variables" and "Set" button, then the number become 9 + 30 = 39.)
Note: "STRING buffers (characters)", "FB instance data (bytes – approx.)" and "Complex variables
segment (bytes) " need to set a larger number (This example uses "5000").
5. After setting (as the picture below), click the "X" in the upper right corner to exit the setting.

These 3 Types
need larger
values.

6. Click "Project > Build All Projects" from the menu bar, compile the program again. Then click “On
Line” or click the tool icon

to link to the PAC. (Refer the Section 2.3.5.)
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7.

After successfully link to the PAC, click the tool icon "Download changes" to download the program
to the PAC.
Note: "On Line Change" is only suitable for the program that just has a little change (Do not need
to stop the application). If the program name is different from the running one in the PAC,
the user has to stop and download the program again (refer the Appendix B).

8.

Click on the tool icon "Do On Line change" to execute the program.
Note: After executing the "On Line Change", there are some using restrictions for protecting the
system normal operation (refer the Section 9.1). So, make sure the program is correct, then
perform this function.
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Chapter 10

Data/Type Conversion and Using the PAC Time

10.1 AI Data Conversion
If you are using AI modules in the PAC's Slot 0 to 7 (for example: I-8017HW), and want to convert the AI
input signal (for example: "4 to 20 mA" or "0 to 10 V") to the user engineering value (for example: 0 to
10000), refer the Section 4.3. However, if you are using the remote AI modules (e.g., through PAC's
RS-485 Port to connect to the I-87017ZW or I-7017R module), you can refer the following settings:

Win-GRAF PAC
COMx: RS-485

I-7017R

Data +

Data +

I-87K4 I/O Expansion Unit
+ I-87017ZW
Data +

Data -

Data -

Data -



1. First, connect "i_scale" in the "I/O Boards" window, and double click on "i_scale_x" to open the
Properties window (refer the Section 4.2 for detail steps)
Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale").
2. Set up the number and value of the Conversion Function that need to be enabled.
(E.g., Use Function 1 to convert "4 to 20 mA" into "0 to 10000").
Ch01_X0_Min_Physical_Val:
Ch01_X1_Max_Physical_Val:
Ch01_Y0_Engineering_Val_For_X0:
Ch01_Y1_Engineering_Val_For_X1:

“4.0”
“20.0”
“0.0”
“10000.0”
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3. Edit an ST Program to convert a physical value (e.g., Phy_V[0] to [7]) to an engineering value
(e.g., Eng_V[0] to [7]). (Refer the Section 2.3.3 for detail setting steps.)

(* ii is declared as DINT variable
Phy_V is declared as REAL array with Dim. = 8
Eng_V is declared as REAL array with Dim. = 8

*)

for ii := 0 to 7 do
(* Using conversion function 1 to convert a physical value to an engineering value *)

Eng_V[ii] := Convert_to_Eng (1, Phy_V[ii]);
end_for;

10.2 AO Data Conversion
If you are using AO modules in the PAC's Slot 0 to 7 (for example: I-8024W), and want to convert the
engineering value to the AO output signal (e.g., convert "0 to 20000" to "0 to 10 V"), refer the Section
4.4. However, if you are using the DCON remote AO modules (e.g., through PAC's RS-485 Port to
connect to the I-7024 module), you can refer to the following settings:
1. Connect "i_scale" in the "I/O Boards" window, and double click "i_scale_x" to open the Properties
window (refer the Section 10.1 for detail steps)
Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale").
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2. Set up the number and value of the Conversion Function (e.g., use Function 2 to convert "0 to 20000"
to "0 to 10 V").

Ch02_X0_Min_Physical_Val is set as “0.0”.
Ch02_X1_Max_Physical_Val is set as “10.0”.
Ch02_Y0_Engineering_Val_For_X0 is set as “0.0”.
Ch02_Y1_Engineering_Val_For_X1 is set as “20000.0”.

3. Edit an ST Program to convert an engineering value to a physical value (e.g., Eng_V[0] to [7]).
(Refer the Section 2.3.3 for detail setting steps.)

(* ii is declared as DINT variable.
Phy_V is declared as REAL array with Dim. = 8
Eng_V is declared as REAL array with Dim. = 8 *)

for ii := 0 to 7 do
(* Using conversion function 2 to convert an engineering value to a physical value *)

Phy_V[ii] := Convert_to_Phy (2, Eng_V[ii]);
end_for;
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10.3 Data Type Conversion
When different types of data want to do "+, -, *, /" calculation or ">, <, =, <=, > =, <> (not equal)"
operation, or when the variable types of the parameters in the function are different, you must first use
the type conversion function (in the following table) to convert them into the same data type, then can
use the data normally.
Data Conversion
Functions

Descriptions

Data Conversion
Functions

Descriptions

ANY_TO_BOOL

Convert to Boolean

ANY_TO_REAL

Convert to Real

ANY_TO_SINT

Convert to Short Integer (8-bit)

ANY_TO_LREAL

Convert to Double

ANY_TO_INT

Convert to Integer (16-bit)

ANY_TO_STRING

Convert to String

ANY_TO_DINT

Convert to Long Integer (32-bit –
NUM_TO_STRING
Default)

ANY_TO_LINT

Convert to Large Integer (64-bit)

ATOH

ANY_TO_TIME

Convert to Timer

HTOA

Convert Number to String.
Can set the decimal digital
number after converting
Convert Hexadecimal
String to Integer
Convert Integer to
Hexadecimal String

For example, the following ST program will convert the DINT variable to a Real first, and then do the
calculation.
REAL_Val_1 := ANY_TO_REAL (DINT_Val_1) * 3.5 + 4.8 ;

You can open the "HTML Help" from the menu bar, and enter the searching key word you want to see
the detail setup instructions.
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10.4 BCD Conversion
BCD 4-bit code is used to represent decimal numbers from 0 to 9. Suppose there is a decimal value
"132", if converted to BCD code is "000100110010" and if converted to binary is 10000100 (e.g., 27 + 22 =
128 + 4 = 132).
Decimal
0
1
2
3
4
5
6
7
8
9

3

2
0
0
0
0
0
0
0
0
1
1

BCD
2
21
0
0
0
0
0
1
0
1
1
0
1
0
1
1
1
1
0
0
0
0
2

20
0
1
0
1
0
1
0
1
0
1

Descriptions
0
20 = 1
21 = 2
21 + 20 = 3
22 = 4
22 + 20 = 5
22 + 21 = 6
22 + 21 + 20 = 7
23 = 8
23 + 20 = 9

NOTE:
BCD code can only represent
numbers from 0 to 9.
It can not be used for these six
values (1010, 1011, 1100, 1101,
1110, 1111), and will return "0".

The function table below can be used for BCD (Binary Coded Decimal) value conversion.
Type Conversion
Function

Descriptions

BIN _TO_BCD

Convert Binary to BCD value

BCD_TO_BIN

Convert BCD value to Binary

BIN _TO_BCD:
19(10) = 0001 1001(BCD)
= 24 + 23+ 20 = 16 + 8 + 1 = 25
BCD_TO_BIN:
33(10) = 0010 0001(2) = 21(BCD)
15(10) = 0000 1111(2) = 0(BCD)

You can open the "HTML Help" from the
menu bar, and enter the searching key word
you want to see the detail setup
instructions.
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10.5 Pack/Unpack Integer or Boolean
Unpack Integer to Boolean:
If want to unpack one BYTE (or USINT, range: 0 to 255) to 8 Booleans, you can use "UNPACK8" Function
Block.

If want to unpack one SINT to 8 Booleans, you must first use the ST program "ANY_TO_BYTE ()" to
convert the SINT to be a BYTE type, as follows:

Pack Boolean Into Integer:
If want to pack 8 Booleans into one BYTE (or USINT, range: 0 to 255), you can use "PACK8" Function.
ST Program:
USINT_1 := PACK8 (Bool_0, I Bool_1, Bool_2, Bool_3, Bool_4, Bool_5, Bool_6, Bool_7);
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LD Program:

If want to pack 8 Booleans into one SINT, you must assign a "BYTE" variable to the output(Q) to save the
value temporary, and use a "ANY_TO_SINT" Function to convert BYTE into SINT type, as follows:

Note: If the compiling fails, please click "Project" > "Settings" from the menu bar to check if the setting
of "Complex variables in a separate segment" in the "Runtime" is "Yes".
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10.6 Pack/Unpack BYTE, WORD, DWORD
Pack Two 8-bit Data into One 16-bit Data
If want to pack 2 BYTE (or USINT) into one WORD (or UINT), you can use a "MAKEWORD" Function.
ST Program:
WORD_VAL_1 := MAKEWORD (Hi_byte, Lo_byte);

LD/FBD Program:

If want to pack 2 SINT into one INT, you must first use an ST program "ANY_TO_BYTE ()" to convert SINT
into BYTE, and then use an "ANY_TO_INT" Function to convert the packed WORD into INT type.

Unpack One 16-bit Data to Two 8-bit Data
If want to unpack one WORD (or UINT) to 2 Byte (or USINT), you can use "HIBYTE", "LOBYTE" Functions.

ST Program:
Hi_byte := HIBYTE (WORD_VAL_1);
Lo_byte := LOBYTE (WORD_VAL_1);
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LD/FBD Program:

If want to unpack one INT to 2 SINT, you must first use an ST program "ANY_TO_WORD()" to convert INT
into WORD, and then use an "ANY_TO_SINT" Function to convert the unpacked BYTE into SINT type.

Pack Two 16-bit Data into One 32-bit Data
If want to pack 2 WORD (or UINT) into a DWORD (or UDINT), you can use a "MAKEDWORD" Functions.
ST Program:
DWORD_VAL_1 := MAKEDWORD (Hi_word, Lo_word);
LD/FBD Program:
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If want to pack 2 INT into 1 DINT, you must first use an ST program "ANY_TO_WORD()" to convert INT to
WORD, and then use an "ANY_TO_DINT" Function to convert the unpacked DWORD into DINT type.

Unpack One 32-bit Data to Two 16-bit Data
If want to unpack one DWORD (or UDINT) to 2 WORD (or UINT), you can use "HIWORD", "LOWORD"
Function Blocks.
ST Program:
Hi_word := HIWORD (DWORD_VAL_1);
Lo_word := LOWORD (DWORD_VAL_1);
LD/FBD Program:

If want to unpack one DINT to 2 INT, you must first use an ST program "ANY_TO_DWORD()" to convert
DINT to DWORD, and then use an "ANY_TO_INT" FB to convert the unpacked WORD into INT type.
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10.7 Unpack Variable to Byte Array or Pack Byte Array into Variable
"SerializeOut" Function can unpack a Win-GRAF Variable value to a Byte Array (or USINT Array);
"SerializeIn" Function can pack a Byte Array (or USINT Array) into a Win-GRAF Variable value.
Note: 1. The Dim. of Array must be set as at least "8".
2. This "Serialize" Function can not use the STRING variable.
You can open the "HTML Help" from the menu bar, and enter the searching key word to see the detail
setup instructions.

If the SerializeOut() and SerializeIn() return "0", it means the saving location is wrong or the Array‘s
space is not enough.
Note:
Data Type
Byte
(* Declare TMP_DINT as a DINT,
BOOL, SINT, USINT, BYTE
1
buf as a BYTE Array, Dim. = 10,
DINT_Val as a DINT,
INT, UINT, WORD
2
Word_Val as a WORD,
DINT, UDINT, DWORD, REAL
4
REAL_Val as a REAL *)
LINT, LREAL
8
Example 1
(* To unpack one DINT_Val to 4 Bytes, and save them separately to the buf[2], buf[3], buf[4] and buf[5]
from the location 2 of the BYTE Array in the "Little Endian" sequence. *)

TMP_DINT := SerializeOut (buf, DINT_Val, 2, FALSE) ;

Note: The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low
Byte to the starting address).

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

10-11

Example 2
(* To unpack one Word_Val to 2 Bytes, and save them separately to the buf[0] and buf[1] from the
location 0 of the BYTE Array in the "Big Endian" sequence. *)
TMP_DINT := SerializeOut (buf, Word_Val, 0, TRUE) ;

Note: The last parameter is "TRUE", that means to use the "Big Endian" sequence (To save the High
Byte to the starting address).

Example 3
(* To pack the buf[0], buf[1] , buf[2] and buf[3] in the BYTE Array into one REAL_Val in the "Little
Endian" sequence. *)
TMP_DINT := SerializeIn (buf, REAL_Val, 0, FALSE) ;

Note: The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low
Byte to the starting address).

Example 4
(* To map one DINT_Val to one REAL_Val in the "Little Endian" sequence. *)
TMP_DINT := SerializeOut (buf, DINT_Val, 0, FALSE) ;
TMP_DINT := SerializeIn (buf, REAL_Val, 0, FALSE) ;
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10.8 Get/Set the PAC Time
If you want to get the current time of a Win-GRAF PAC, you can use a "TIME_GET" Function Block.
(Refer the Section 2.2.1)

PAC_Year, PAC_Month,
PAC_Day, PAC_WeekDay,
PAC_Hour, PAC_Minute,
PAC_Second are declared as
DINT

If want to adjust the Win-GRAF PAC time, you can use "TIME_SET" Function Block. (Refer the Section
2.3.6) First, fill the new time to the variables of "new_Year", "new_Month", "new_Day",
"new_WeekDay", "new_Hour", "new_Minute" and "new_Second", then set the "Set_new_time" to
"TRUE" one time.

Set_new_time is declared as BOOL
new_Year, new_Month, new_Day,
new_WeekDay, new_Hour,
new_Minute, new_Second are
declared as DINT
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Chapter 11

Commonly Used Tools and Useful Tips

11.1 Upgrade Win-GRAF Libraries
Users can download the latest version of Win-GRAF libraries (Win-GRAF Lib, e.g., "win-graf-lib-x.xx.zip")
from http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html.
The Win-GRAF Libraries (Including Function, Function Block and I/O Board definitions) are saved in the
folder of “ICP DAS - XP-WP-VP” under the directory of “C:\Win-GRAF\DATA\HWDEF”. In some situations,
you need to upgrade the Win-GRAF Libraries to the new version for supporting more Functions or new
I/O Board. Please follow the steps below:
1. First, close all Win-GRAF Workbench windows.
2. You can compress the original “ICP DAS - XP-WP-VP”
folder and back it up to the other directory (e.g.,
D:\temp\xxx.zip), and then delete the folder.
3. Copy the new “ICP DAS - XP-WP-VP” folder into the
directory “C:\Win-GRAF\DATA\HWDEF”, and
execute the Win-GRAF Workbench again.
Note:
If you want to know the version number of the
Win-GRAF library. As the figure below, open the
"Library Manager" and click "A_Version" in the "I/Os"
tab, and then click "Description" to see the version
number (e.g., "1.01").

Delete the folder after back up.

A

B

C
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11.2 Upgrade Win-GRAF Driver
For updating add-on functions, I/O boards or other purposes, ICP DAS will release a new version of
Win-GRAF drivers in the future. Users can get the latest driver on the website (http://www.icpdas.com/
root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html), and follow the steps
below to upgrade the new driver into the PAC.
Note: The Win-GRAF Driver of the XPAC (XP-8xx8-CE6, XP-9xx8-CE6), WinPAC (WP-8xx8, WP-5xx8) and
ViewPAC (VP-25W8, VP-4138) will be placed in the directory "\System_Disk\Win-GRAF\" inside the PAC.
1. On the desktop of a PAC (use WP-8xx8 in this example), double click on the "Win-GRAF_WP_8000"
icon and then click "End Driver" to stop the currently running driver.

2. On the PC, copy the new driver into the PAC's directory “\Temp\” by using FTP method.
3. On the PAC, copy the new driver from “\Temp\” into “\the System_Disk\Win-GRAF\” directory to
replace the old one, and then reboot the PAC.
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11.3 Spy List
When a program is running, the Spy List lets users quickly know the variable’s value or status.
Sometimes, a program may declare hundreds or thousands of variables, users do not need to look for
them, just simply switch to the pre-created Spy List window to see the wanted information.
Steps:
1. Right-click on the project name (e.g., "Demo01") and select "Insert New Item".
2. Select "Spy List" of the "Watch", then click "Next" to the next step.
3. Then, key in a list name (e.g., "NewSpy1") and press "OK".

2

1

3
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4. Double click "NewSpy1" on the left side to open the setting window and drag the variables you want
to put into the window.

5. When the Win-GRAF and the PAC are connected, the "NewSpy1" window will show the variables
information clearly.
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11.4 Backup/Restore a Win-GRAF Project
Back up A Win-GRAF Project:
1. Mouse right-click on the project name (e.g., "Demo01") and select "Save Project" and then "To Disk".

2. Click on the "Browser" button to assign a directory you want to save the project (e.g.,
D:\Win-GRAF_demo_backup), fill in the project name (e.g., "Demo01_0613"), and then click "OK" to
back up the project.

1
2

Restore A Win-GRAF Project:
1. Copy the previously backed up the project folder (e.g., "Demo01_0613") into
"C:\Win-GRAF\Projects".
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2. Click the menu bar "File" > "Close Project List" to close all opened project windows.

3. Click the menu bar "File" > "Add Existing Project" > "From Disk", select the project you want (e.g.,
"Demo01_0613") in the "C:\Win-GRAF\" directory, and then click "OK" to restore the project.
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11.5 Software Reboot a PAC
Based on some cases, users may want to reboot the PAC in a software way. The Win-GRAF provides a
Function "PAC_Reboot" for users to restart the PAC.
Note: Please DO NOT call this Function in every PAC Cycle, or the PAC will reboot all the time.
Safety Coding:
(* "reset_PAC" is declared as BOOL and has initial "FALSE"
"TMP_BOOL" is declared as BOOL *)
(* ONLY when "reset_PAC" is set to "TRUE", the PAC will reboot *)
if reset_PAC then
reset_PAC := FALSE ;
TMP_BOOL := PAC_Reboot( ) ;
end_if ;

Dangerous Coding:
(* "TMP_BOOL" is declared as BOOL *)
(* Dangerous ! This coding method will let the PAC reboot always and cannot stop. *)
TMP_BOOL := PAC_Reboot( ) ;
If a mistake to reboot the PAC always, turns the rotary switch of the Win-GRAF PAC to "1" and reset it.
Then it will boot up in safe mode. Then you may rename the Win-GRAF application code in the PAC to
an invalid name. Then when the rotary switch is turned back to "0" and reboot, it will boot up normally
(No application). The Win-GRAF application code in the XP-8xx8-CE6, WP-8xx8, WP-5xx8, VP-25W8 and
VP-4138 is "\System_Disk\Win-GRAF\t5.cod".

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

11-7

11.6 Using ST Syntax in LD and FBD
The Win-GRAF Workbench allows users using simple ST syntax in Ladder (LD) and Function Block
Diagram (FBD) to facilitate programming. Before use, go to the menu bar "Project"> "Settings" >
"Runtime", and set the "Complex variables in a separate segment" to "Yes" to enable this function.

Example:
LD Program:
Using division (REAL_VAL/25.5).

FBD Program:
Call a function "ANY_TO_BYTE()" to convert the type from "SINT" to "BYTE".
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11.7 Apply a Recipe in the PAC
Some applications use the pre-defined Recipe and Value for processing different products, and this
Recipe can be mapped to a combination of variables within a Win-GRAF PAC. When one day want to
change the PAC process to produce a different product, you can use the Win-GRAF Workbench to
connect with the PAC and select a new Recipe you want to replace, and then apply it to the PAC.
Steps:
1. Mouse right-click on the project name (e.g., "Test") and select "Insert New Item"; then click on
"Watch" > "Recipe" and "Next" button, fill in the Recipe name (e.g., "NewRecipe1") and then click
"OK".

2

1

3

2. Double click "NewRecipe1" on the left side to open the setting window and drag the variables you
want to put into the window.
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3. Click on the "Insert Column" icon to add the new Recipe, and then fill in the suitable Values.

4. Click on the "On Line" button to connect the PAC. At first the Values are all "0", please select the
product column and then click the icon "Send Recipe" to apply this Recipe into the PAC.

Note: If want to save the Values in
the PAC (e.g. Power off and restart
the PAC, the Recipe can still retain
the previous Values), please refer
the method of using the retain
variables in the Section 6.1.
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11.8 Get the Functions and Function Blocks that Supported by the PAC
In the Win-GRAF Workbench window, user can expand the "All" directory in the "Blocks" panel to see
quite a lot of Functions and Function Blocks, however, some are not supported in the Win-GRAF PAC.
The following will show how to quickly get the Functions or Function Blocks that supported by the PAC.

Project
Name

Expand
"All"
Directory

“Blocks”
Panel

Setting Steps:
1. Make sure the PAC is powered on and connected with a PC via an Ethernet cable.
2. In the Win-GRAF Workbench, right-click on the project name (e.g., "Demo01") and then select
"Configuration", and click on the "Upload" button in the "Select" tab to open the setting window.

Right-click

Click "Upload"
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3. Configure/Select the IP address of the PAC and click on "OK" button, the PAC will upload the
configuration file. Next, key in the file name (e.g., "test.cfg") and click "Save" to save the
configuration file.

Upload the configuration

Setup the IP addr. of the PAC

Save file under C:\Win-GRAF\DATA\CONFIG

Give the file name & save it.

4. Back to the "Configurations" window, the configuration file (test) will show in the list, and then click
"OK" to leave this window.
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5. In the "Blocks" panel, the red Functions and Function Blocks are not supported by this PAC.

Red means PAC
does not support.

“Blocks” Panel
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11.9 Upload the Win-GRAF Source Code
For some applications, users need to get the source code of the Win-GRAF project from the PAC to the
PC, this is called "Upload". This function can prevent the project source code from missing or incomplete
handover from the previous worker, you can still get the project source code inside the PAC.
Enable/Download The Project Source Code:
1. Click on the menu bar "Project" > "Settings" to open the setting window.
2. Double click on the "Download procedure" of the "Debugging" and select "Send source code for
later project upload", and then click "OK ".

Note: When the "Upload" is enabled,
it means to store the source code in
the PAC. If someone gets this PAC, he
may have the opportunity to get your
source code.

3. Click on the menu bar "Project" > "Build All Projects" to compile the program, and then click on the
tool icon
to connect the PAC, and next, download the current project to the PAC. (Refer the
Section 2.3.5 for the detail steps). After downloading, the source code will be stored in the file of the
directory "\Systen_Disk\Win-GRAF\t5.upl" of the PAC. This file will be larger when the project
increases. If the project becomes very large and complex, the file size may reach several hundreds K
Bytes or even more than 1 MB.
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Upload the Porject Source Code:
Please close all opened Win-GRAF windows (Click on the menu bar "File" > "Close Project List").
4. Click on the menu bar "File" > "Add Existing Project" > "From Target", then select the PAC‘s IP
address and set up the upload file name (e.g., "UPL_project1"), and then click "OK" to upload the
file.

Select PAC IP

Set up the upload file name

5. After uploading, click on "OK" button, and then the Win-GRAF will open the project automatically.
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11.10 Set Up the PAC Password
In order to avoid the important program running in the PAC is changed or stopped by an unfriendly
connecting PC, you can set up a password for the PAC to prevent unauthorized operation.
1. Click on the menu bar "Project" > "Settings" to open the setting window.
2. Double click on the "Runtime password" of the "Compiler", set a password, and then click "OK".

Set a password

3. Click on the menu bar "Project" > "Build All Projects" to compile the program again, and then
download the current project to the PAC (Refer the Section 2.3.5 for detail steps.). When the next
time to click the "On Line" icon for connection, it will require the password.

If click "On Line", it need the password.
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Note: After enabling the password, please remember your password, or you will not connect the PAC.
The Only Solution:
1. Connect the PAC with a USB mouse and screen.
2. In the PAC, execute the Win-GRAF Driver and then click on "End Driver" button.
(Refer the Section 11.2).

3. Rename the file "t5.cod" in the directory "\System_Disk\win-graf" (e.g., "t5.cod1") or delete it. Then
reboot the PAC.

Then, it will become "No application" in the PAC. Now, you can connect and download the
application from the Win-GRAF Workbench again.
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11.11 Using Function Block in the ST Program
It is easy to use the Function in the ST program, just call the Function and assign the corresponding
parameters. The example below will open COM3 at the beginning, and then send a String `Hello‘ from
COM3 every 5 seconds.
(* Declare “INIT1” as BOOL and has initial value TRUE,
Declare “TMP_BOO” as BOOL, “TMR1” as TIME *)

IF

INIT1 THEN
INIT1 := FALSE ;
TMR1 := T#0s ;
TSTART (TMR1) ;
END_IF;
IF COM_Status(3) = FALSE THEN
TMP_BOO := COM_open (3, `19200,N,8,1’) ;
END_IF ;
IF TMR1 >= T#5s THEN
TMR1 := T#0s ;
COM_send_str (3, `Hello: ’) ;
END_IF;

To use a Function Block in the ST, you must first declare an Instance Variable of the Function Block in the
variable region, after that, the using steps are similar to the steps of using the Function, as follows:
The following code can unpack one Byte to become 8 BOOLs:
1. Declare "MyUnpack" variable as "UNPACK8" (FB Instance) and "IN" variable as "BYTE".

2. Edit an ST program.
MyUnpack(IN) ;
Q0 := MyUnpack.Q0 ;
Q1 := MyUnpack.Q1 ;
Q2 := MyUnpack.Q2 ;
Q3 := MyUnpack.Q3 ;
Q4 := MyUnpack.Q4 ;
Q5 := MyUnpack.Q5 ;
Q6 := MyUnpack.Q6 ;
Q7 := MyUnpack.Q7 ;
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11.12 How to Protect Your Win-GRAF Program to Avoid Unauthorized
Copied?
When you finish a Win-GRAF application development and prepare for delivery to the customer, please
think about the possibility that your Win-GRAF application in the PAC may will be copied into another
same model PAC?! Be careful! Someone else may steal your hard outcome! The following provides a
simple and easy way to protect your application.
Note: If you give the Win-GRAF application Source Code to the customer, then sorry, the following
method will not protect your program from stolen. Because having the Source Code, anyone can
modify the code and apply into another PAC.
Each ICP DAS Win-GRAF PAC has a Serial Number that has 8 Bytes (also known as 64-Bit), and each PAC
has the different and unique Serial Number. Therefore, you can use this serial number combine with
your own algorithm to generate a password, and pre-store this password in the PAC's file. Then, verify
this password in your application. If not passed, the application will not be allowed to execute.
The steps are as follows:
This example uses two Win-GRAF projects, one is "demo_passwd" used to generate a PAC password and
save it into the PAC's file; the other is "demo_my_ap" application that has been developed and ready to
ship to the customer. Before shipping a PAC to the customer, user needs to download the project
"demo_passwd" into the PAC and runs it once to generate a unique password for that PAC. Then,
downloads the project "demo_my_ap" into the same PAC, and then can ship the PAC to the customer.
After that, if someone copies the Win-GRAF application in this PAC to another same type of PAC and the
operation will fail because of the password validation failure.
There are two example projects (demo_passwd.zip and demo_my_ap.zip) in the shipment CD
(\Napdos\Win-GRAF\demo-project), please refer the Chapter 12 to restore the projects (Execute File >
Add Existing Project > From Zip) and set up the IP address of the current PAC.

Variables Area
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"demo_passwd" Project:
This program first uses "PAC_SN" Function to read out the Serial Number, and then uses a user-defined
algorithm to generate a password. Finally, save the password to an address within the PAC's file (user
can decide where you want to store).
Variable Declaration:

ST Program:
(* This "demo_passwd" example will generate a password by the 8-Byte Serial Number of the PAC
and save it into the EEPROM of the PAC *)
(* Declare "No_0" ~ "No_7" and "password" variables as DINT.
Declare "INIT" variable as BOOL and has Initial value TRUE. *)
(* Operations in the first PAC Cycle *)
if INIT then
INIT := FALSE ; (* No more first cycle *)
(* Get the hardware serial number *)
PAC_SN( No_0, No_1, No_2, No_3, No_4, No_5, No_6, No_7) ;
(* Please use your own algorithm to generate a password. This example generate only one
password. You may change it to generate some passwords. *)
password := (No_0 * No_1) + (No_2 * 12345) + No_3 + (No_4 * No_5) + No_6 + No_7 ;
(* save the password in a file "my_product.pwd" in the \System_Disk\Win-GRAF *)
file_name := '\System_Disk\Win-GRAF\my_product.pwd' ;
file_id := f_wopen( file_name ) ;
if file_id = 0 then
(* failed , do nothing *)
else
(* open file ok, save the password into it *)
fm_write( file_id , Any_to_String(password) ) ;
f_close( file_id ); (* close file *)
end_if ;
end_if ;
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"demo_my_ap" Project:
This project first uses "PAC_SN" Function to read out the Serial Number, then calculates the password,
and then compares the password that read from the PAC's file to check if the password correct.

(Note: Refer the Section 2.1.2 to arrange the programs in the execution order.)
Variable Declaration:

ST Program - Main:
(* This "demo_my_ap" example can read the password from the EEPROM of the PAC, and check if
match with the result that calculated from the user’s own algorithm. *)
(* Declare "No_0" ~ "No_7", "password" and "PAC_password" variables as DINT.
Declare "INIT" variable as BOOL and has initial value TRUE.
Declare "password_ok" variable as BOOL *)
(* Operations in the first PAC cycle *)
if INIT then
INIT := FALSE ; (* No more first cycle *)
(* get the hardware serial number *)
PAC_SN( No_0, No_1, No_2, No_3, No_4, No_5, No_6, No_7) ;
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(* Please use your own algorithm for the "PAC_password" value *)
PAC_password:= (No_0 * No_1) + (No_2 * 12345) + No_3 + (No_4 * No_5) + No_6 + No_7 ;
(* Read the password value from a file "my_product.pwd" in \System_Disk\Win-GRAF *)
file_name := '\System_disk\Win-GRAF\my_product.pwd' ;
file_id := f_ropen( file_name ) ;
if file_id = 0 then
(* can not open file, set password to 0 *)
password := 0 ;
else
(* open file ok, read the password *)
if f_eof( file_id ) then
(* reach the end of file *)
else
(* hasn't reached the end of file , read a string form it *)
Tmp_string := fm_read( file_id ) ;
(* Convert a string to a DINT value *)
password := Any_to_DINT(Tmp_string) ;
end_if ;
f_close(file_id) ; (* close file *)
end_if ;
(* check if the password is correct? *)
password_ok := FALSE ; (* set it as "FALSE" in the beginning *)
if password = PAC_password then
password_ok := TRUE ; (* the password is correct *)
end_if ;
end_if ;

LD Program – LD2
If the "password_ok" is “FALSE“, it means the password is incorrect, then will exit the program. Only
when the password is correct can the program execute continuously, and then your application can be
protected from the unauthorized access.

This example uses only one
"LD2" program, if your
application as well as other
programs, please add the
"password_ok" checking code
for each program.
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Chapter 12

Demo Project Descriptions

There are some demo projects in the Win-GRAF shipping CD (CD-ROM: \Napdos\Win-GRAF\
demo-project) which some of them will be introduced in the following sections.
Before using the demo projects, follow the steps below:
1. Click on the menu bar "File" > "Add Existing Project" > "From Zip" to open a project (e.g.,
"demo_tmr1.zip").

Note!
Please close the current "project List"
before restoring the demo projects in the
CD-ROM. (Click on the menu bar: "File" >
"Close Project List")

CD-ROM:
\Napdos\Win-GRAF\demo-project

2. Double click "Main" to open the ST program, and can view/add variables in the variable area.
3. Mouse right-click on the project name (“demo_tmr1“), and select "Communication Parameters" to
set up the IP Address of your PAC. (Refer Section 2.3.5)
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12.1 Timer Operations
12.1.1 Start, Stop and Reset the Timer
Refer P12-1 to open the project ("demo_tmr1.zip"), and can view/add variables in the variable area.
ST Program:
(* Declare “START_tmr”, “STOP_tmr”, “RESET_tmr”, “LED1”, “LED2” as BOOL
Declare “TMR1” as TIME *)
(* Set START_tmr as TRUE to start ticking Timer TMR1 *)

IF START_tmr THEN
START_tmr := FALSE ;
TSTART (TMR1) ;
END_IF;
(* Set STOP_tmr as TRUE to stop ticking Timer TMR1 *)

IF

STOP_tmr THEN
STOP_tmr := FALSE ;
TSTOP (TMR1) ;
END_IF;

(* Set RESET_tmr as TRUE to reset TMR1 to a value T#0s *)

IF

RESET_tmr THEN
RESET_tmr := FALSE ;
TMR1 := T#0s ;
END_IF;

(* Let LED1, LED2 ON during TMR1 = 3 ~ 10 second *)

LED1 := FALSE ;
LED2 := FALSE ;
IF (TMR1 >= T#3s) and (TMR1 <= T#10s) THEN
LED1 := TRUE ;
LED2 := TRUE ;
END_IF;
(* Reset TMR1 as 0 when reachs 15 second *)

IF

TMR1 >= T#15s THEN
TMR1 := T#0s ;
END_IF;
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12.1.2 Periodic Operations
Refer P12-1 to open the project ("demo_tmr2.zip"), and can view/add variables in the variable area.
Function "BLINK" plus Function Block "F_TRIG" can produce a Pluse TRUE at regular intervals, so it can
be applied in the periodic operations.
LD Program:

Type: BOOL

ST Program:
IF pluse1 THEN
(* do periodic operations here *)


END_IF;

The "BLINK" and "F_TRIG" above will produce a Pluse TRUE every two seconds, but this method has a
drawback:

pluse1
2 Sec

2 Sec

If the interval time of the period is shorter (e.g., 100 ms per period or less; or the PAC Cycle Time is
larger, such as 20 ~ 50 ms, generally 3 ~ 15 ms), then the period operations will be inaccurate. For
example, to do a periodic operation every 50 ms, as compared to 250 ms or 2 seconds, the interval time
of 50 ms is very close to the PAC Cycle Time, if using Function Blocks "BLink" plus "F_TRIG", it is easy to
accumulate the output delay time, therefore the final operation time will become inaccurate.

: Cycle time
(3 ~ 15 ms)

Delay: 5 ms 10 ms …….

pluse
50 ms

50 ms

Tolerance will increase.
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To improve the situation above, the following coding method will be more accurate:
(Tolerance will not increase.)
Refer P12-1 to open the project ("demo_tmr3.zip"), and can view/add variables in the variable area.
ST Program:
(* Declare “INIT” as BOOL and has initial value TRUE
Declare “TMR1”, “TMR1_next” as TIME *)

IF INIT THEN
INIT := FALSE ;
TMR1 := T#0s ;
TMR1_next := TMR1 + T#50 ms ;
TSTART (TMR1);
END_IF;
IF TMR1 >= TMR1_next THEN
IF TMR1 > T#10h THEN
TMR1 := T#0s ;
TMR1_next := T#0s ;
END_IF;
TMR1_next := TMR1_next + T#50 ms ;

When the timer reach T#23h59m59s999ms,
the value will overflow.
Therefore, please reset it automatically to
"0" after 10 or 18 hours.

(* Do periodic operations here *)


END_IF;
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12.1.3 Detect the Steady ON or Steady OFF Signal
"TON" Function Block can detect the steady "ON" signal. (Keeps "ON" for a minimum period of time.)

PT: Programmed Time
ET: Elapsed Time
As the picture above, this function can detect the steady "ON" signal that keep at least 2 seconds.
ON

ON

2 sec

IN_1

2 sec
ON

ON

OUT_1
"TOF" Function Block can detect the steady "OFF" signal. (Keeps "OFF" for a minimum period of time.)
that can keep "OFF" for a period of time.

PT: Programmed Time
ET: Elapsed Time
As the picture above, this function can detect the steady "OFF" signal that keep at least 3 seconds.
ON

ON

2 sec

IN_1

2 sec
ON

ON

OUT_1

IN_1

OFF

OFF

OFF

3 sec

3 sec

OUT_1
OFF

OFF
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12.1.4 Keep Outputting ON for Some Time after Triggering
"TP" Function Block can keep outputting "ON" for some time after triggering (e.g., from OFF to ON).

PT: Programmed Time
ET: Elapsed Time
As the picture above, after triggering, it can keep outputting "ON" signal for 10 seconds.

IN_1
10 sec

10 sec

ON

ON

10 sec

OUT_1

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

12-6

12.2 Operations of Serial Port Communication
Users can directly operate the serial port (e.g., RS-232, RS-485 or RS-422 Port) to achieve some specific
communication protocol. The following Functions can be used to directly operate the serial port.
Functions

Descriptions

COM_open

Open a serial COM port.

COM_close

Close a serial COM port.

COM_clear

Clear the input buffer of a serial COM port.

COM_test

Test if any data received in the input buffer of a serial COMM port.

COM_send

Command a serial COM port to send 1~500 bytes.

COM_send_str

Command a serial COM port to send a String.

COM_recv

Receive bytes from the input buffer of a serial COM port and save
them in a byte array.

COM_status

Get the current status of a serial COM port.

Please refer Section 1.2.3 to open the Library Manager and find the detail Function descriptions.
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12.2.1 Send a String by COM Port
Refer P12-1 to open the project ("demo_com_port1.zip"), and view/add variables in the variable area.
ST Program: This program can send a String every 2 seconds by the PAC COM1 (parameters:
`9600,N,8,1‘) (e.g., < CNT1 = 1 > or < CNT1 = 25 >).
(* Operations in the first PAC cycle *)

if INIT then
INIT := FALSE ; (* No more first cycle *)
CNT1 := 0 ;
TMR1 := T#0s ;
TMR1_next := TMR1 + T#2s ;

Declare “INIT” as BOOL and has initial value TRUE;
“Port_OK” as BOOL ;
“CNT1” as DINT ;
“TMR1”, “TMR1_next” as TIME
“Port_number” as DINT and has initial value “1”

(* start ticking TMR1 *)

tStart(TMR1) ;
end_if ;
(* if the status of COM port becomes FALSE(not open), open it *)

if COM_Status(Port_number) = FALSE then
(* open a serial COM port *)

Port_OK := COM_open(Port_number, '9600,N,8,1' ) ;
end_if ;
(* when time reached , ... *)

if TMR1 >= TMR1_next then
(* to prevent TMR1 overflow (means reach T#23h59m59s999ms) *)

if TMR1 > T#10h then
TMR1 := T#0s ;
TMR1_next := T#0s ;
end_if ;
(* Set new TMR1_next *)

TMR1_next := TMR1_next + T#2s ;
(* Send a string from COM port *)

COM_send_str( Port_number, '<CNT1=' + Any_to_STRING(CNT1) + '>' ) ;
(* reset CNT1 when reach 100 *)

CNT1 := CNT1 + 1 ;
if CNT1 >= 100 then
CNT1 := 0 ;
end_if ;
end_if;
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12.2.2 Request/Answer the Device by COM Port
If an application needs to use RS-232/485/422 Port to get the data from other devices, the steps are as
the following request and answer:

Win-GRAF PAC
1. Send a command to request the Device.
3. Check if receive the complete reply?
(If yes, do the proper operations and
wait for a while, and then return to
the step 1 to send the next command.)

1

Device
2. Check if receive a complete query?
(If yes, reply an answer to the
Win-GRAF PAC.)

2

4. Wait for the next command,
and if receive a command
then go to the step 2.

Refer P12-1 to open the project ("demo_com_port2.zip"), and view/add variables in the variable area.
Note: Double click “Action” will first open a “Notes” window, then click “Action” icon to see the code.

Notes

Double click

Action

You can click the “Variables” tag to open the Variables window.
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In this example, the Win-GRAF PAC sends a string 'QUESTION?' by COM3 to the device, and then wait for
the reply and does operations. After the operations, waits 2 seconds, and then sends the same
command 'QUESTION?', and repeated.
SFC Program:
( Declare "Port_OK" as BOOL ; "NUM1" as DINT ; "ByteAry" as BYTE and Dim. = "200" ;
“Port_number” as DINT and has initial value "3" )

Action(P) :
(* if port is not open, open it *)
1

if COM_status(Port_number) = FALSE then
Port_OK := COM_open(Port_number, '9600,N,8,1' ) ;
end_if ;
End_Action ;
Port_OK ;

2

(Open COM3 as `9600,N,8,1‘)

(If succeeds, do the next.)

Action(P) :
(* Clear input buffer *)
3

COM_clear(Port_number) ;
(* Send 'QUESTION?' by COM3 *)

(In this example, clear input buffer of
COM3 first, and then send a
command 'QUESTION?'.)

COM_send_str(Port_number, 'QUESTION?' ) ;
End_Action ;

GS3.T >= T#250ms ;
4

(After sending query, wait for 250 ms to allow the device’ reply Bytes
are safely delivered to the Win-GRAF PAC. Do not set the time too
short, or cannot receive a full reply.)

Action(P) :
(* receive reply from COM3,max. 200 bytes in this example*)
5

NUM1 := COM_recv(Port_number, ByteAry, 0, 200) ;
(* do operations if protocols is correct *)

if NUM1 = 10 then
(* ... *)

end_if ;
End_action ;
GS5.T >= T#2 ;

6

1

(When done, wait 2 seconds and then
return to the step 1 to send the next
query command.)

(Put the received Byte into ByteAry[]
and check if the number is correct?
If yes, do the operations the
application needed.)
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12.2.3 Wait Data Coming from Remote Device by COM Port
This way is common in the general store or supermarket, such as using the barcode readers. After
reading the barcode of the product, it will send the barcode data to the Win-GRAF PAC's COM Port
(RS-232/485/422), and need not to reply any messages.

Win-GRAF PAC
2. If receives the complete data from device,
do operations.
3. When done, wait for the next data coming.

1

Device
1. After triggering, send data to
the Win-GRAF PAC

Refer P12-1 to open the project ("demo_com_port3.zip"), and view/add variables in the variable area.

ST Program:
(* operations in first PAC cycle *)

if INIT then
INIT := FALSE ;
T1 := T#0s ;
STEP1 := 0 ;
end_if ;

Declare "INIT" as BOOL and has initial value TRUE;
"Port_OK" as BOOL ;
"STEP1", "NUM1" as DINT ;
"T1" as TIME ;
"ByteAry" as BYTE and Dim. = "200" ;
“Port_number” as DINT and has initial value "3".

(* if port is not open, open it *)

if COM_status(Port_number) = FALSE then
Port_OK := COM_open( Port_number , '9600,N,8,1' ) ;
end_if ;
(* If open port fail, exit this ST program *)

if Port_OK = FALSE then
return ;
end_if ;
CASE STEP1 OF
(* if there is at least 1 byte coming *)

0:
if COM_test(Port_number) then
STEP1 := 1 ;
T1 := T#0s ;
Tstart(T1) ;
end_if ;

STEP1 = 0, means waiting, and will test if COM3 has data?
If returns TRUE, means COM3 has data.
Then set STEP1 to "1", T1 to "0" and start timing.
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(* wait 250 ms, then receive all bytes form COM port *)

1:
if T1 >= T#250ms then
Tstop(T1) ;
T1 := T#0s ;
STEP1 := 0 ;

STEP = 1: means the data is sending in, and will wait 250 ms
to receive all data and put them into an array. The waiting
time concerns the device specifications and the Baud Rate.
If set the time too short, may receive data incompleted.
Remember to set STEP1 to "0" to wait for the data coming
next time.

(* receive max. 200 bytes *)

NUM1 := COM_recv(Port_number , ByteAry , 0 , 200 ) ;
(* do proper operations if protocol is correct ,
here assume correct protocols has 25 bytes in this example*)

if NUM1 = 25 then
(* ... *)

end_if ;

When receive data, check if data is correct?
If yes, do the operations the application needed.

end_if ;
END_CASE ;
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12.2.4 Report Data Periodically to Remote Device by COM Port
If wants to periodically report data to other devices by RS-232/485/422 Port, do as follows.

Win-GRAF PAC

Device

Every period time (e.g., 5 sec), put the
data to be sent into array (Type: BYTE)
and send data by Function COM_send.



Check if receive the complete
and correct data?
And then do proper operations.

Refer P12-1 to open the project ("demo_com_port4.zip"), and view/add variables in the variable area.
SFC Program: (Refer Section 12.2.2 to open the "Action" window.)
(Declare “Port_OK“ as BOOL ; "TMP_DINT" as DINT ; "ByteAry" as BYTE and Dim. = 100 ;
“Port_number” as DINT and has an initial value "2".)

Action(P) :
(* if port is not open, open it *)
1

if COM_status(Port_number) = FALSE then
Port_OK := COM_open( Port_number , '19200,E,8,2' ) ;
end_if;
End_Action ;
(If succeeds, do the next.)

Port_OK ;

2

Action(P) :
3

(* prepare ByeAry[] to be sent *)
(* ... *)
(* Send it, here send 20 bytes *)

TMP_DINT := COM_send(Port_number , ByteAry , 0, 20) ;
End_Action ;

GS3.T >= T#5s ;

4

1

(Open COM2 as `19200,E,8,2‘)

(After 5 seconds,
return to the step 1 to
send the next data.)

(The sent data concers with
your application, please
use COM_send to send
data after the data is
ready. Max. 500 Bytes )

(If wants to send String, can use the Function
COM_send_str(). Max. 255 Bytes, and can not
has "0" in the Byte of the String, because "0"
means the end of the String, but it can be the
Character `0‘.)
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12.3 Read/Write Data from/to a File in The PAC
The Win-GRAF Workbench provides the following Functions to enable sequential read/write operations
in disk files of the Win-GRAF PAC.
Functions

Descriptions

Please click the menu bar "Help" > "Topics" and type
the searching key word “File” to see more detail
information in the topic of the “File Management
functions”.

F_ROPEN

Open a file for reading.

F_WOPEN

Create or reset a file and open it for writing.

F_AOPEN

Create or open a file in append mode.

F_CLOSE

Close an open file.

F_EOF

Test if the end of file is reached in a file open for read.

FA_READ

Read a DINT integer from a binary file.

FA_WRITE

Write a DINT integer to a binary file.

FM_READ

Read a STRING value from a text file

FM_WRITE

Write a STRING value to a text file.

FB_READ

Read binary data from a file.

FB_WRITE

Write binary data to a file.

F_EXIST

Test if a file exists.

F_GETSIZE

Get the size of a file.

F_COPY

Copy a file.

F_DELETE

Remove a file.

F_RENAME

Rename a file.

Refer Section 1.2.3 to find the detailed descriptions for the following Functions.
F_dir
F_cp_dir
F_del_dir

Create a directory.
Copy all files in a directory to another directory (exclude files
in sub-directories).
Delete a directory and all files inside it (exclude
sub-directories and files inside sub-directories).

Note: The Win-GRAF PAC of ICP DAS does not support Functions “F_SAVERETAIN” and
“F_LOADERETAIN”.
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12.3.1 Write Data to a File in the PAC
Refer P12-1 to open the project ("demo_file1.zip"), and can view/add variables in the variable area.
ST Program: This program can be used to write 10 "REAL" values to a file in the PAC.
(* This "demo_file1" project will save 10 REAL value to a file
in the \System_Disk\Real_data1.txt .

File Format :
Each row contains one REAL value and ends with <CR><LF> characters. Like:
1.08
2.786
38.45
41.5
59.875
60.76
71.23
80.5
99.8
100.7

*)

(* Variables declaration:
Write_File
: BOOL
Tmp_string
: String, len=255
File_ID
: DINT
REAL_val[0..9] : REAL
ii
: DINT
File_Status
: String, len=128 *)

Because the size of \System_Disk\ is small,
recommend you may change the directory
to below (Depends on your application):
WP-8xx8, WP-5xx8, VP-25W8, VP-4138:
\Micro_SD\ or
XP-8x48-CE6, XP-9xx8-CE6:
\System_Disk2\

(* Set Write_File as TRUE to write data to the file *)
if Write_File then

Write_File := FALSE ;
File_ID := F_Wopen( '\System_Disk\Real_data1.txt' );
if File_ID = 0 then
(* Can not open file in write mode *)
File_Status := 'Can not open file in write mode !' ;
else
(* open file in write mode ok, save REAL[0] ~ [9] to file ,
each row contains 1 REAL value and end with <CR><LF> *)
File_Status := 'Open file ok.' ;
for ii := 0 to 9 by 1 do
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Tmp_string := Any_to_string( REAL_val[ii] ) ;
FM_write( File_ID , Tmp_string ) ;
end_for ;
If want to save data to Integer, use the code:
Tmp_string := Any_to_string( DINT_val[ii] ) ;
and declare Variable “DINT_val” as DINT and
Dim. at least "10" for this example.

(* close the file *)
F_close( File_ID ) ;

end_if ;
end_if ;
Test Program:
In this example, when the "Write_File" is set to "TRUE", the values will be written into the file
\System_Disk\Real_data1.txt in the PAC.
1. Please set up IP configurations (Refer P12-1), compile and download the program to the PAC.
(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to
Section 2.3.4 , Section 2.3.5)
2. Click "NewSpy1" to open a Spy List and fill in the values to be written, and then set the "Write_File"
become "TRUE" to Write data. (If OK, "File_Status" will show "Open file ok".)
1.1

1.2

2.2

2.1
2.3

3. In the PAC, open the file "Real_data1.txt", can see the values filled in the step 2.
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12.3.2 Read Data from a File in the PAC
Refer P12-1 to open the project ("demo_file2.zip"), and can view/add variables in the variable area.
ST Program: This program can be used to read 10 "REAL" values from a file in the PAC.
(* this "demo_file2" project will read 10 REAL value from a file
in the \System_Disk\Real_data2.txt .
File format :
Each row contains one REAL value and ends with <CR><LF> characters. Like:
1.08
2.786
38.45
41.5
59.875
60.76
71.23
80.5
99.8
100.7
*)

(*
Variables Declaration:
Write_File
: BOOL
Tmp_string
: String, len=255
File_ID
: DINT
REAL_val[0..9] : REAL
ii
: DINT
File_path
: String, len = 128, initial val = '\System_Disk\Real_data2.txt'
File_Status
: String, len=128
*)
Because the size of \System_Disk\
is small, recommend you amy
(* Set Read_File as TRUE to read data from the file *)
change the directory to below
if Read_File then
(Depends on your application):

Read_File := FALSE ;
(* Check if file exists *)
if F_exist( File_path ) = FALSE then
(* file doesn't exist *)
File_Status := 'File "' + File_path +'" does not exist !' ;
else

WinPAC, ViewPAC Series:
\Micro_SD\ or
XPAC Series:
\System_Disk2\

(* file does exist , open it in read mode *)
File_ID := F_Ropen( File_path );

if File_ID = 0 then
(* open file in read mode fail *)
File_status := 'Can not open File "' + File_path +'" !' ;
else
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(* open file in read mode ok, read REAL[0] ~ [9] from file ,
each row contains 1 REAL value and end with <CR><LF> *)
File_status := 'Open File "' + File_path +'" Ok .' ;
for ii := 0 to 9 by 1 do
(* test if the end of file is reached in a file open for read *)
if F_EOF( File_ID ) then
(* reach the end of file, exit "for loop" *)
exit ;
end_if ;
(* read one row in the file as a string *)
Tmp_string := FM_READ( File_ID ) ;
(* convert the string to become REAL value *)
REAL_val[ii] := Any_to_REAL( Tmp_string ) ;

end_for ;
(* close the file *)
F_close( File_ID ) ;

end_if ;
end_if ;
end_if ;

If want to read Integer, use the code below:
DINT_val[ii] := Any_to_DINT( Tmp_string ) ;
and declare Variable “DINT_val” as DINT and
Dim. at least "10" for this example..

Note: In this example, when the "Read_File" is set to "TRUE", it will read the file in the PAC
"\System_Disk\Real_data2.txt", please make sure the file already exists in the PAC.
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Test Program:
1. Please set up IP configurations (Refer P12-1), compile and download the program to the PAC.
(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to
Section 2.3.4 , Section 2.3.5)
2. Click "NewSpy1" to open a Spy List and set the "Read_File" to "TRUE" to read the data. (If OK,
"File_Status" will show "Open File "\System_Disk\Real_data2.txt" Ok.")

1.1

1.2

2.3

2.1
2.2

Note: There is one another file operation example listed in the Section 6.2. It handles many data in the
file, you may refer it.
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Chapter 13 VB.net 2008 Program Running in WP-8xx8 Access to
Win-GRAF Variables
This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008
development tool. There are some sample programs in the WP-8xx8 CD-ROM.
VB .NET example:
CD-ROM : \napdos\Win-GRAF\demo-project\vb.net_2008_demo\
demo_vb01 : Digital I/O demo with one I-87055W in slot 0 of the WP-8xx8.
demo_vb02 : Analog I/O demo with one I-87024W in slot 1, one I-8017HW in slot 2.
demo_vb03 : Read/Write Win-GRAF internal integers, timers & real variables. (No I/O)
demo_vb04 : Read/Write Win-GRAF internal String variables. (No I/O)
Win-GRAF example:
CD-ROM : \napdos\Win-GRAF\demo-project\
"demo_vb01.zip", "demo_vb02.zip", "demo_vb03.zip", "demo_vb04.zip"

13.1 Add an Existing Win-GRAF Project from a ZIP
Please follow these steps to restore the Win-GRAF project.
First Click “File” -> “Add Exiting Project” -> “FromZip…”. Then choose the Win-GRAF project zip file which
you would like to restore. After restoring the project, you have to build the project, and then download
it to the PAC.
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13.2 Publishing the Win-GRAF Variable for .NET and Soft-GRAF HMI
If users wish to use .NET program to Read/Write the Win-GRAF variables. Except for String variable all of
the variables need to use the "Open Binding Configuration" function to set an address. The following
demonstrates how to publish Win-GRAF variable:
1. Click “Open Binding Configuration” on the toolbar to open the “Binding” setup window.
2. Click "PUBLIC (:9000)". Keep the "Address" value is blank and "Port" value is fixed to 9000.
Open Binding Configuration

Keep "Address" value blank.

Variable Area

3. Before publishing these variables, make sure you have declared them in the Variables Area. Click
“Global variables” and press the “Ins” key to insert a new variable. The following table demonstrates
variables using in the “Test_3” project and you can declare them according to the needs of your
application.
Variable name

Type

Public_BOOL

BOOL

Public_INT

INT

Public_DINT

DINT

Public_WORD

WORD
REAL

Public_REAL

Enter key
4. As the figure below, click on "PUBLIC(:9000)" and drag all the needed variables to the "Name" area.
The "Identifier" will generate an address number automatically. If any other VB or .NET program
wants to use these public variables, it must set to the same address number (ID).
NOTE:
The "PUBLIC" allows to use up to 8192 variables, and the "Identifier" number JUST can be 1 to 8192.
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The following procedure will show you how to use the “pub_string” function to publish the Win-GRAF
String variable in the ST program.
Syntax:
Pub_string(Address, String_val) ;
Address: The public address number, and its range can be 1 to 1024
String_val: The name of String variable.
Variables description:
Name

Type

Description

Init

BOOL

Set the initial value as TRUE.

Tmp_val

BOOL

TRUE: Binding succeeds.
FALSE: Binding fails.

msg1

STRING, Length is 100

msg2

STRING, Length is 32

msg3

STRING, Length is 60

String variable for demo purpose.
NOTE: The String length could be 1 to 255.

ST program:
If init then
Init := false;
(*add address 1 for share string val *)
Tmp_val := pub_string(1,msg1);
(*add address 2 for share string val *)
Tmp_val := pub_string(2,msg2);
(*add address 3 for share string val *)
Tmp_val := pub_string(3,msg3);

End_if;
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13.3 Create a new VB.NET project
1. First, run Microsoft Visual Studio .NET 2008 software, and then choose “File” > “New Project”.

2. Click “Smart Device” on the left, and then select “.NET Framework 3.5” and “Smart Device Project”.
Entering a proper project name and click “OK”.

2
1
3

3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 3.5”, then
click “OK”.
2

1
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13.3.1 Add Project Reference
The “UserShareNet.dll” library contains all functions of data exchange with Win-GRAF variables. Before
you use the “UserShareNet” keyword in the program, you must add the “UserShareNet.dll” into the
reference list of your project.
1. Copy the “UserShareNet.DLL” from Win-PAC’s shipment CD (\napdos\Win-GRAF\WP-8xx8\
vb.net_2008_demo\wp_vb01\vb01\) to your project folder (e.g., “C:\project1\”)
2. Right click on the project name (e.g., “project1”) in the
“Solution Explorer” window, and then select “Add
Reference …”.

Right click

3. Click the “Browse” tab and select the “UserShareNet.dll” from your project location.

The current project is located in "C:\project1".

Note: You may copy the “UserShareNet.dll” from the CD-ROM to your current project path first.
Then add it to the project reference.

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

13-5

4. When “UserShareNet.dll” is added, please double click on “My Project” to check if the
“UserShareNet.dll” is well added.

Double click

5. Right-click on the “Form1.vb” and select “View Code” from the pop-up. Move cursor to top and
insert the “Option Explicit On” and “Imports UserShareNet” in the first two statements.

Right
Click

Then you can design all required objects and actions inside your VB Forms.
(Refer the Chapter 13.5 for more information about using functions in the “UserShareNet.dll”.)
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13.4 Compiling the Application
When you have finished writing a program, you can build (compile) an application by the following
steps.
1. Remember to save at any time for safety.

2. Then compile (Build) the project. The result is listed in the “Error List” windows at the bottom.

3. You can find the execution file in
<Your VB.net Project folder> \bin\Release\ <project_name>.exe
Please copy this execution file to the WP-8xx8’s \System_Disk\Win-GRAF\ path to run it.

Note:
The user may copy the VB.net execution file to another path to run it, but there should contain at
least two DLL files with it or it cannot run correctly.
For ex, the project1.exe can run in the \Micro_SD\ folder if there are three files in it. The
“project1.exe” , “UserShareNet.dll” and “Quicker.dll” . (The “UserShareNet.dll” and “Quicker.dll”
can be copied from the Win-GRAF PAC’s “\System_disk\Win-GRAF\” path)
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13.5 UserShareNet.dll
This section we will focus on the description of the application example of UserShareNet.dll functions.
There are some functions that can be used to read/write data from/to the Win-GRAF soft-logic. The
functions of UserShareNet.dll can be divided into as listed below:
1.
2.
3.
4.
5.
6.
7.
8.

R/W Boolean
R/W 8-bit Integer
R/W 16-bit Integer
R/W 32-bit Integer
R/W 64-bit Integer
R/W 32-bit Float
R/W 64-bit Float
R/W String

※ Refer the “Appendix A” to get familiar with the definition of Win-GRAF variables.

13.5.1 R/W Boolean Functions
■ Set_BOOL
Description:
This function is to set a value to a Win-GRAF Boolean variable.
Syntax:
UserShare.Set_BOOL ( iUserAddress As System.UInt16 , ByVal iStatus As byte) as Byte
Parameter:
iUserAddress : Address of the Variable (1 to 8192)
iStatus :
Set the status. For instance, iStatus = 1 for True, iStatus = 0 for False
Example:
‘Set the Win-GRAF BOOL variable with address 1 to True.
UserShare.Set_BOOL(Convert.ToUInt16(1), 1)
Demo program:
CD-ROM: \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb01
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■ Get_BOOL
Description:
This function is to get the value from a Win-GRAF BOOL variable.
Syntax:
UserShare.Get_BOOL ( iUserAddress As System.UInt16 , ByRef iStatus As byte)
Parameter:
iUserAddress : Address of the Variable (1 to 8192)
iStatus :
Get the variable value , iStatus = 1 for True, iStatus = 0 for False
Example:
‘Get the value of Win-GRAF BOOL variable with address 1.
Dim iStatus As Byte
UserShare.Get_BOOL(Convert.ToUInt16(1), iStatus)

Demo Program:
CD-ROM:
\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb01
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13.5.2 Integer R/W Functions
■ Set_SINT ■ Set_INT ■ Set_DINT ■ Set_LINT
Description:
These functions are to set 8-bit Integer, 16-bit Integer, 32-bit integer & 64-bit Integer value to Win-GRAF
integer variables.
Syntax:
UserShare.Set_SINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As SByte) As Byte
UserShare.Set_INT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As Short) As Byte
UserShare.Set_DINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As Integer) As Byte
UserShare.Set_LINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As long) As Byte

Parameter:
iUserAddress : Address of Variable. (1 to 8192)
iStatus :
the value of 8-bit Integer, 16-bit Integer, 32-bit Integer or 64-bit Integer.
Example:
‘Set a 32-bit integer value “1234567” to the Win-GRAF DINT variable with address “1”.
UserShare.Set_DINT(Convert.ToUInt16(1), Convert.ToInt32(1234567) )
‘Set a 16-bit integer value “-1234” to the Win-GRAF INT variable with address “2”.
UserShare.Set_INT(Convert.ToUInt16(3), Convert.ToInt16(-1234) )
‘Set a 64-bit Integer value “123456789012345” to the Win-GRAF LINT variable with address “3”.
UserShare.Set_LINT(Convert.ToUInt16(3), Convert.ToInt64(123456789012345) )
‘Set a 8-bit Integer value “125” to the Win-GRAF SINT variable with address “4”.
UserShare.Set_SINT(Convert.ToUInt16(3), Convert.ToSByte(125) )
Demo Program:
CD-ROM:
1. \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02 for R/W analog I/O
2. \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03 for R/W internal long integer,
Timer and Real (floating-point) values.
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■ Get_SINT ■ Get_INT ■ Get_DINT ■ Get_LINT
Description:
These functions are to get 8-bit integer, 16-bit integer, 32-bit integer & 64-bit integer value from
Win-GRAF integer variables.
Syntax:
UserShare. Get_SINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As SByte) As Byte
UserShare. Get_INT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Short) As Byte
UserShare.Get_DINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Integer) As Byte
UserShare. Get_LINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As long) As Byte

Parameter:
iUserAddress : Address of Variable (1 to 8192)
iStatus :
Get the 8-bit integer, 16-bit integer, 32bit-integer or 64-bit integer value.
Example:
Dim Dlong_val As Int64
Dim short_val As Int16
Dim long_val As Int32
Dim Sbyte_val as byte
‘Get 64-bit integer value from the Win-GRAF LINT variable with address “7”.
UserShare.Get_LINT(Convert.ToUInt16(7), Dlong_val)
‘Get 32-bit integer value from the Win-GRAF DINT variable with address “8”.
UserShare.Get_DINT(Convert.ToUInt16(8), long_val)
‘Get 16-bit integer value from the Win-GRAF INT variable with address “9”.
UserShare.Get_INT(Convert.ToUInt16(9), short_val)
‘Get 8-bit integer value from the Win-GRAF SINT variable with address “10”.
UserShare.Get_SINT(Convert.ToUInt16(9), sbyte_val)
Demo program:
CD-ROM:
1. R/W analog I/O :
\napdos\Win-GRAF\demo-project\vb.net_2008_demo \demo_vb02
2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03
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13.5.3 R/W Real Variable Functions
■ Get_REAL ■ Get_LREAL
Description:
These functions are to get 32-bit REAL and 64-bit double from the Win-GRAF REAL/LREAL variable.
Syntax:
UserShare. Get_REAL (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Single) As Byte
UserShare. Get_LREAL(ByVal iUserAddress As System.UInt16 , ByRef iStatus As Double) As Byte

Parameter:
iUserAddress : Address of Variable (1 to 8192)
iStatus :
Get the 32-bit REAL or 64-bit double value.
Example:
Dim float_val As Single
Dim double_val As Double
‘Get 64-bit double value from the Win-GRAF LREAL variable with address “7”.
UserShare.Get_LREAL(Convert.ToUInt16(7), double_val)
‘Get 32-bit REAL value from the Win-GRAF REAL variable with address “8”.
UserShare.Get_REAL(Convert.ToUInt16(8), float_val)
Demo program:
CD-ROM:
1. R/W analog I/O:
\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02
2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03
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■ Set_REAL ■ Set_LREAL
Description:
These functions are to set 32-bit REAL and 64-bit double value to the Win-GRAF REAL/LREAL variable.
Syntax:
UserShare. Set_REAL (ByVal iUserAddress As System.UInt16, ByVal iStatus As Single) As Byte
UserShare. Set_LREAL(ByVal iUserAddress As System.UInt16, ByVal iStatus As Double) As Byte

Parameter:
iUserAddress : Address of Variable. (1 to 8192)
iStatus :
Set the 32-bit REAL or 64-bit double.
Example:
‘Set a 64-bit double value “11234.234567” to the Win-GRAF LREAL variable with address “1”.
UserShare.Set_LREAL(Convert.ToUInt16(7),Convert.ToDouble(11234.234567))
‘Set a 32-bit REAL value “123.12” to the Win-GRAF REAL variable with address “8”.
UserShare.Set_REAL(Convert.ToUInt16(8), Convert.ToSingle (123.12))
Demo program:
CD-ROM:
1. R/W analog I/O : \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02
2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03
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13.5.4 R/W String Variable Functions
■ Get_STRING
Description:
This function is to get a Win-GRAF String variable.
Syntax:
UserShare. Get_STRING (ByVal iUserAddress As System.UInt16, ByVal msg() As Byte) As Byte

Parameter:
iUserAddress : Address of Variable (1 to 1024)
msg() :
Get the string value.
Example:
Dim str_val As String
Dim msg() As Byte
‘Get String value of the Win-GRAF String variable with address “7”.
UserShare.Get_STRING(Convert.ToUInt16(7),msg )
str_val= byte_array_to_unicode(msg)
Private Function byte_array_to_unicode(ByVal buf() As Byte) As String
Dim tmpmsg As String
If buf.Length > 255 Then
Return Nothing
End If
tmpmsg = System.Text.Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length)
Return tmpmsg
End Function
Demo program:
CD-ROM:
1. R/W String variable:
\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb04
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■ Set_STRING
Description:
This function is to set a String value to the Win-GRAF String variable.
Syntax:
UserShare. Set_STRING (ByVal iUserAddress As System.UInt16, ByVal msg() As Byte) As Byte

Parameter:
iUserAddress : Address of Variable. (1 to 1024)
msg() :
the string value.
Example:
Dim str_val As String=”Hello World”
Dim msg() As Byte
msg= unicode_to_byte_array(str_val)
‘Set a string value “Hello World” to the Win-GRAF String variable with address “7”.
UserShare.Set_STRING(Convert.ToUInt16(7),msg )
‘Convert String to byte array.
Private Function unicode_to_byte_array(ByVal msg As String) As Byte()
Dim tmpbuf() As Byte
If msg.Length > 255 Then
Return Nothing
End If
tmpbuf = System.Text.Encoding.GetEncoding("UTF-8").GetBytes(msg)
Return tmpbuf
End_Function
Demo program:
CD-ROM:
1. R/W String variable:
\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb04
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13.5.5 How to use VB.NET R/W to Win-GRAF String Variable
Before .NET program write to Win-GRAF String variable. The String-type has to convert to byte array. If
you need to read Win-GRAF String variable. Then you have to convert byte array to String. There is a
VB.NET example to show how to convert each other.
(Encode :UTF-8 )：
Convert String to byte array
Private Function unicode_to_byte_array(ByVal msg As String) As Byte()
Dim tmpbuf() As Byte
If msg.Length > 255 Then
Return Nothing
End If
tmpbuf = System.Text.Encoding.GetEncoding("UTF-8").GetBytes(msg)
Return tmpbuf
End Function
Convert byte array to string
Private Function byte_array_to_unicode(ByVal buf() As Byte) As String
Dim tmpmsg As String
If buf.Length > 255 Then
Return Nothing
End If
tmpmsg = System.Text.Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length)
Return tmpmsg
End Function
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Chapter 14 C# .net 2008 Program Running in WP-8xx8 Access to
Win-GRAF Variables
This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008
development tool. There are some sample programs in the Wp-8xx8 CD-ROM.
C# demo:
CD-ROM : \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\
demo_CSharp01 : Digital I/O demo with one I-87055W in slot 0 of the Wp-8xx8.
demo_CSharp02 : Analog I/O demo with one I-87024W in slot 1 and one I-8017HW in slot 2.
demo_CSharp03 : Read / Write Win-GRAF internal integers, timers and real variables. (No I/O)
demo_CSharp04 : Read/Write Win-GRAF internal String variables. (No I/O)
Win-GRAF demo:
CD-ROM : \napdos\Win-GRAF\demo-project\
"demo_vb01.zip", "demo_vb02.zip", "demo_vb03.zip", "demo_vb04.zip"

14.1 Add an Existing Win-GRAF Project from a ZIP
Please refer the Chapter 13.1

14.2 Publishing the Win-GRAF Variable for .NET
Please refer the Chapter 13.2

14.3 Create a New C# Project
1. First, users need to open Microsoft Visual Studio .NET 2008 software. And then in the menu of “File”,
please run the “New Project” .
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2. Check the “Smart Device” on the left, then selecting the “.NET framework 3.5” and “Smart Device
Project”. Then entering a proper project name and the last click on “OK”.

3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 3.5”,
then click on “OK”.
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14.3.1 Add C# Project Reference
The “UserShareNet” library contains all modules’ functions. Before you use the “UserShare” keyword in
the program, you must add the “UserShareNet.dll” into the reference list of your application.
1. Copy the “UserShareNet.DLL” from WP-8xx8 CD-ROM:
\napdos\Win-GRAF\WP-8xx8\CSharp.net_2008_demo\demo_CSharp01\ to your project folder(ex:
C:\project1\)
2. Right click on the Project name on the right
hand side , then select “Add Reference …”

Right Click

3. Click the “Browse” button. Select the “UserShareNet.dll” from your project location.

Change folder to your current project Path.
(Ex: "C:\project1")

Note: You may copy the “UserShareNet.dll” from the CD-ROM to your current project path first.
Then add it to the project reference.
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4. When “UserShareNet.dll” are added, you can see them in the solution explorer as below.

5. Right-click on the “Form1.cs” and select “View Code” from the pop-up. Move cursor to top and
insert the “using UserShareNet;” in the first statements.

Then you can design all required objects and actions inside your C# Forms.
(Refer the Section 14.5 for more information about using functions in the “UserShareNet.dll”.)
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14.4 Compiling the Application Program
When you have finished writing a program, you can build (compile) an application by the following
steps.
1. Remember to save at any time for safety.

2. Then compile (Build) the project . The result is listed in the “Error List” windows at the bottom.

3. You can find the execution file in
<Your C# .net Project folder> \bin\Release\ <project_name>.exe

Please copy this execution file to the WP-8xx8’s \System_Disk\Win-GRAF\ path to run it.

Note:
The user may copy the C#.net execution file to another path to run it, but there should contain at least
two DLL files with it or it cannot run correctly. For ex, the project1.exe can run in the \Micro_SD\ path if
there are three files in it. The “project1.exe”, “UserShareNet.dll” and, “Quicker.dll” .
(The “UserShareNet.dll” and “Quicker.dll” can be copied from the Win-GRAF PAC’s
“\System_disk\Win-GRAF\” path)
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14.5 UserShareNet.DLL
This section we will focus on the description of the application example of UserShareNet.DLL
functions. There are some functions that can be used to read/write data from/to the Win-GRAF
variable. The functions of UserShareNet.DLL can be divided into as listed below
1.
2.
3.
4.
5.
6.
7.
8.

R/W Boolean
R/W 8-bit Integer
R/W 16-bit Integer
R/W 32-bit Integer
R/W 64-bit Integer
R/W 32-bit Float
R/W 64-bit Float
R/W 32-bit String

※ Refer the “Appendix A” to get familiar with the definition of Win-GRAF variables.

14.5.1 R/W Boolean Functions
■Set_BOOL
Description:
This function is to set a value to a Win-GRAF Boolean variable.
Syntax:
UserShare.Set_BOOL(ushort iUserAddress, byte iStatus)
Parameter:
iUserAddress : Address of Variable (1 to 8192)
iStatus :
Set the status. For instance, iStatus = 1 for True, iStatus = 0 for False
Example:
// Set the Win-GRAF BOOL variable with address 1 to True.
UserShare.Set_BOOL(Convert.ToUInt16(1), 1);
Demo program:
CD-ROM : \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp01
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■Get_BOOL
Description:
This function is to get the value from a Win-GRAF BOOL variable.
Syntax:
UserShare.Get_BOOL(ushort iUserAddress, out byte iStatus)

Parameter:
iUserAddress : Address of Variable. (1 to 8191)
iStatus :
Get the variable status , iStatus = 1 for True, iStatus = 0 for False.
Example:
Byte iStatus=0;
// Get the value of Win-GRAF BOOL variable with address 1.
UserShare.Get_BOOL(Convert.ToUInt16(1),out iStatus);
Demo program:
CD-ROM: \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp01
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14.5.2 R/W Integer Functions
■ Set_SINT ■ Set_INT ■ Set_DINT ■ Set_LINT
Description:
These functions are to set 8-bit Integer, 16-bit Integer, 32-bit integer & 64-bit Integer value to Win-GRAF
integer variables.
Syntax:
UserShare.Set_SINT(ushort iUserAddress , sbyte iStatus)
UserShare.Set_INT(ushort iUserAddress , short iStatus)
UserShare.Set_DINT(ushort iUserAddress, int iStatus)
UserShare.Set_LINT(ushort iUserAddress, long iStatus)
Parameter:
iUserAddress : Address of Variable. (1 to 8192)
iStatus :
Set the 8-bit Integer, 16-bit Integer, 32-bit Integer or 64-bit Integer.
Example:
// Set a 32-bit integer value “1234567” to the Win-GRAF DINT variable with address “1”.
int temp1=1234567;
UserShare.Set_DINT(Convert.ToUInt16(1), temp );
// Set a 16-bit integer value “-1234” to the Win-GRAF INT variable with address “2”.
short temp2= -1234;
UserShare.Set_INT(Convert.ToUInt16(2), temp2 );
// Set a 64-bit Integer value “123456789012345” to the Win-GRAF LINT variable with address “3”.
long temp3=123456789012345;
UserShare.Set_LINT(Convert.ToUInt16(3), temp3 );
// Set a 8-bit Integer value “125” to the Win-GRAF SINT variable with address “4”.
Sbyte temp4=125;
UserShare.Set_SINT(Convert.ToUInt16(4), temp4 );
Demo program:
CD-ROM:
1. R/W analog I/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02
2. R/W internal Boolean ,long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03
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■ Get_SINT ■ Get_INT ■ Get_DINT ■ Get_LINT
Description:
These functions are to get 8-bit integer, 16-bit integer, 32-bit integer & 64-bit integer value from
Win-GRAF integer variables.
Syntax:
UserShare.Get_SINT(ushort iUserAddress, out sbyte iStatus)
UserShare.Get_INT(ushort iUserAddress, out short iStatus)
UserShare.Get_DINT(ushort iUserAddress, out int iStatus)
UserShare.Get_LINT(ushort iUserAddress, out long iStatus)
Parameter:
iUserAddress : Address of Variable (1 to 8192)
iStatus :
Get the value of Win-GRAF integer variables.
Example:
Int64 Dlong_val;
Int16 short_val;
Int32 long_val ;
sbyte sbyte_val;
// Get 64-bit integer value from the Win-GRAF LINT variable with address “7”.
UserShare.Get_LINT(Convert.ToUInt16(7),out Dlong_val);
// Get 32-bit integer value from the Win-GRAF DINT variable with address “8”.
UserShare.Get_DINT(Convert.ToUInt16(8),out long_val);
// Get 16-bit integer value from the Win-GRAF INT variable with address “9”.
UserShare.Get_INT(Convert.ToUInt16(9),out short_val);
// Get 8-bit integer value from the Win-GRAF SINT variable with address “10”.
UserShare.Get_SINT(Convert.ToUInt16(9),out sbyte_val)
Demo program:
CD-ROM:
1. R/W analog I/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02
2. R/W internal Boolean, long integer, Timer and Real (floating-point) values:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03
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14.5.3 R/W Real variable Functions
■ Get_REAL ■ Get_LREAL
Description:
These functions are to get 32-bit REAL and 64-bit double from the Win-GRAF.
Syntax:
UserShare. Get_REAL (System.UInt16 iUserAddress, out float iStatus)
UserShare. Get_LREAL(ByVal iUserAddress As System.UInt16 , out Double iStatus)
Parameter:
iUserAddress : Address of Variable (1 to 8192)
iStatus :
Get the 32-bit REAL or 64-bit double value.
Example:
float float_val;
double double_val;
// Get 64-bit double value from the Win-GRAF LREAL variable with address “7”.
UserShare.Get_LREAL(Convert.ToUInt16(7),out double_val);
// Get 32-bit REAL value from the Win-GRAF REAL variable with address “8”.
UserShare.Get_REAL(Convert.ToUInt16(8),out float_val);
Demo program:
CD-ROM:
1. R/W analog I/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02
2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_ demo_CSharp03
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■ Set_REAL ■ Set_LREAL
Description:
These functions are to set 32-bit REAL and 64-bit double value to the Win-GRAF REAL/LREAL variable.
Syntax:
UserShare. Set_REAL ( ushort iUserAddress , float iStatus )
UserShare. Set_LREAL( ushort iUserAddress , Double iStatus)

Parameter:
iUserAddress : Address of Variable. (1 to 8192)
iStatus :
Set the 32-bit REAL or 64-bit double.

Example:
// Set a 64-bit double value “11234.234567” to the Win-GRAF LREAL variable with address “7”
UserShare.Set_LREAL(Convert.ToUInt16(7),Convert.ToDouble(11234.234567));
// Set a 32-bit REAL value “123.12” to the Win-GRAF REAL variable with address “2”.
UserShare.Set_REAL(Convert.ToUInt16(8), Convert.ToSingle (123.12));

Demo program :
CD-ROM:
1. R/W analog I/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02
2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03
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14.5.4 R/W String variable Functions
■ Set_STRING
Description:
This function is to get a Win-GRAF String variable.
Syntax:
UserShare.Set_STRING (ushort addr , Byte [] msg)

Parameter:
addr : Address of Variable (1 to 1024)
msg[] : Get the string value.
Example:
String str_val;
Byte[] msg;
// Get the String value of the Win-GRAF String variable with address “7”.
msg= unicode_to_byte_array(str_val);
UserShare.Set_STRING(Convert.ToUInt16(7),msg );
//Convert String to byte array.
private byte[] unicode_to_byte_array(string msg)
{
byte[] tmpbuf;
if (msg.Length > 255)
return null;
tmpbuf = Encoding.GetEncoding("UTF-8").GetBytes(msg);
return tmpbuf;
}

Demo program:
CD-ROM:
1. R/W String variable :
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp04
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■ Get_STRING
Description:
This function is to set a String value to the Win-GRAF String variable.
Syntax:
UserShare.Set_STRING (ushort addr , Byte [] msg)
Parameter:
addr : Address of Variable. (1 to 1024)
msg[] : Set the string value.
Example:
String str_val= “Hello World”;
Byte[] msg;
// Set a string value “Hello World” to the Win-GRAF String variable with address “7”.
UserShare.Get_STRING(Convert.ToUInt16(7),msg );
str_val= byte_array_to_unicode(msg);
//Convert byte array to String
private string byte_array_to_unicode(byte[] buf)
{
string tmpmsg;
if (buf.Length > 255)
return null;
tmpmsg = Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length);
return tmpmsg;
}
Demo program:
CD-ROM:
1. R/W String variable : \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp04
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14.5.5 How to Use C# to Convert Win-GRAF String Variable
Before .NET program write to Win-GRAF String variable. The String-type has to convert to byte array.
(According your .NET program Encode. Ex: UTF-8) If you need to read Win-GRAF String variable. Then
you have to convert byte array to String. There is an C# example to show how to convert each other.
Example (Encode is UTF-8):
//Convert String to byte array
private byte[] unicode_to_byte_array(string msg)
{
byte[] tmpbuf;
if (msg.Length > 255)
return null;
tmpbuf = Encoding.GetEncoding("UTF-8").GetBytes(msg);
return tmpbuf;
}
//byte array to string
private string byte_array_to_unicode(byte[] buf)
{
string tmpmsg;
if (buf.Length > 255)
return null;
tmpmsg = Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length);
return tmpmsg;
}
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Chapter 15 Using Soft-GRAF HMI in the Win-GRAF PAC
This chapter list the way to run Soft-GRAF HMI in the Win-GRAF PAC. The Soft-GRAF is a software which
allows user to create colorful HMI. User can easily edit HMI screen by mouse dragging and dropping the
object and run both HMI and Win-GRAF softlogic in the same Win-GRAF PAC.
※Note: Please refer the ISaGRAF FAQ 146 to get more information about using Soft-GRAF.
ISaGRAF FAQ146:
http://www.icpdas.com/faq/isagraf/146.htm

15.1 Restore the Win-GRAF Project
Please copy all demo programs into your PC.
CD-ROM of Win-GRAF PAC: \napdos\Win-GRAF\demo-project\Soft-GRAF-demo\
Demo project for both Win-GRAF and Soft-GRAF:
Win-GRAF demo

Soft-GRAF demo

demo_soft-graf1
demo_soft-graf2
demo_soft-graf3
demo_soft-graf4
demo_soft-graf5
demo_soft-graf6
demo_soft-graf7
demo_soft-graf8

demo01
demo02
demo03
demo04
demo05
demo06
demo07a demo07b
demo08

Description

Demonstrate Soft-GRAF basic HMI object.

Picture and animation picture (.gif).
Trend graph and gauge.
Alarm
Data logger

You may restore the “demo_soft_graf01.zip” to your Win-GRAF workbench to get familiar with it. Then
download to the Win-GRAF PAC. If you have no idea how to restore the Win-GRAF project. Please refer
the Section 13.1.

15.1.1 Install the Soft-GRAF Studio
Please download the “faq146_demo.zip” from the ISaGARF FAQ146 web page.
http://www.icpdas.com/faq/isagraf/146.htm

Click here to download

After unzip the file, please copy the “Soft-GRAF Studio” folder into “D:\”. Then, it becomes
“D:\Soft-GRAF Studio”.
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15.1.2 Download the Soft-GRAF HMI Project to the Win-GRAF PAC
Executes the “Soft-GRAF Studio.exe” from the “D:\Soft-GRAF Studio”. Then click the “open project” on
the upper left screen. Open the “demo01.sof”.

Click “project” -> “IP Setting”. Setup the IP address of the Win-GRAF PAC.

Click “download” to download HMI project to the Win-GRAF PAC. If download success, you can see HMI
on the Win-GRAF PAC screen.
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15.2 How to Develop Soft-GRAF HMI
Before user develops Soft-GRAF HMI, users have to publish Win-GRAF project variables. Then, Soft-GRAF
HMI could read/write the Win-GRAF variables. Please refer the Section 13.2 to get information about
publishing Win-GRAF variables.
Win-GRAF

Soft-GRAF

The left example shows a
Win-GRAF variable “LED_01”
with address “11” is published.
If user wish to use Soft-GRAF
to read/write this variable.
Then user has to set “NetWork
Address” to 11 in Soft-GRAF
Studio object. (This Soft-GRAF
HMI object is “g_B_Led”. )

There is another setting in the Win-GRAF workbench before user develops Soft-GRAF HMI. User needs
to add “Soft-GRAF” in the Win-GRAF “IO boards”. The following steps demonstrate how to add it.
Click “Open I/Os” on Win-GRAF toolbar.

Click Slot 8 or larger slot NO. (suggest value is 9) position. Then click “Select” button. Finally, mouse
double click “Soft-GRAF” in the dialog.
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Double Click

After adding “I/O boards”, please compile the Win-GRAF project. Then download to the Win-GRAF PAC.
Then users can start to develop your Soft-GRAF HMI.
※Note: Please refer ISaGRAF FAQ146 chapter 1.2 to get more details about Soft-GRAF Studio.
ISaGRAF FAQ146:
http://www.icpdas.com/faq/isagraf/146.htm
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Chapter 16 Redundancy
16.1 Features and Architecture
The following ICP DAS Win-GRAF PACs support redundancy:
XP-8xx8-CE6 ; XP-9xx8-CE6 ; WP-5248
One redundant system is composed by two Win-GRAF PACs that one PAC’s rotary switch is set to 7
(means Main-PAC) and the other one is set to 9 (means Backup-PAC). When one of them is damaged or
crashed or need to release its control-right by user-defined event, the PAC control-right will
automatically switch to the healthy one.
Features of the Win-GRAF redundancy
1. Better safety:
There are three communication cables (LAN1, LAN2 and Alive Port) connected between two PACs.
The redundant system will still control the process well, even if one or two cables are broken or
disconnected. As long as one of the three communication cables is fine, the Win-GRAF redundant
PACs can still work well with the process.
2. Unique Public IP:
The Win-GRAF redundant system provides a unique public IP address for SCADA/HMI to access it
without needing to determine which one is the Active IP.
3. Easy maintenance:
If one of the redundant PACs is damaged someday after starting the process, you can remove the
damaged one (Note: Do not shutdown or dismounting the other healthy PAC, keep it running). And
then take another spare Win-GRAF PAC with the same model (or a repaired PAC) without
downloading the Win-GRAF application, simply adjust its rotary switch to a proper position and then
connect all required communication cables (e.g., LAN1, LAN2, Alive port and I/O). Make sure that the
original, healthy PAC is still working properly and then power up the spare PAC. Then, the healthy
PAC will automatically copy the Win-GRAF app and all its redundant data to that new PAC which is
just online. It is easier for maintenance and installation, the operator don’t have to worry about
whether to install the Win-GRAF app because the healthy PAC will automatically do it for the new
online PAC.
Exception: Except the Win-GRAF app if there are a few apps, such as the C, VB.net, C# app or
Soft-GRAF HMI app, running in the redundant system, these apps need to pre-installed to the spare
Win-GRAF PAC (or a repaired PAC) before installing this PAC to the redundant system.
4. Easy to design the application:
The user has to do is design the application program. Not necessary to specify what data should be
redundant between two PACs. The Win-GRAF redundant system will automatically deliver them to
the other PAC.
5. Users can design some safety in the app:
For example, if the Active PAC’s LAN1 is disconnected (causes the SCADA unable to connect to) or a
RS-485 Port is disconnected or damaged, and so on. The user’s app can test these events and then
switch control right to the other healthy PAC.
6. I/O Redundancy:
If the user chooses iDCS-8830 series I/O, both the PAC and I/O modules can support redundancy.
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The architecture of the Win-GRAF redundant system (using XP-8xx8-CE6 as an example):
Note: The Win-GRAF redundant PACs support RS-485/RS-422 expansion boards (I-8142i/ I-8144i)
plugged into their local slot. Please don‘t use other kinds of I/O modules.
LAN1
1. Two PACs without I/O modules:

Rotary switch
COM4 (RS-232/485)
COM2 (RS-232)
COM3 (RS-485)
LAN2

Note: LAN1: Normal Ethernet Cable, LAN2: Ethernet Crossover Cable, Alive Port: RS-232 Crossover Cable.
2. Two PACs are equipped with DCON I/O modules:

Note: LAN1: Normal Ethernet Cable, LAN2: Ethernet Crossover Cable, Alive Port: RS-232 Crossover Cable.
COM3, COM4 (RS-485): Data+ to Data+ ; Data- to Data- .
3. Two PACs are equipped with Modbus TCP I/O modules:

Note: LAN1: Normal Ethernet Cable, LAN2: Ethernet Crossover Cable, Alive Port: RS-232 Crossover Cable.
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4. Two PACs are equipped with iDCS-8830 I/O modules:
This type of achievement provides both CPU and I/O module redundancy.

Note: LAN1 (PAC), LAN1 (iDC-8830), LAN2 (iDC-8830): Normal Ethernet Cable.
LAN2 (PAC): Ethernet Crossover Cable, Alive Port: RS-232 Crossover Cable.
Note: Each pair of redundant I/O modules that plugged into the iDCS-8830 must have the same model
numbers.

5. Two PACs are equipped with other Modbus RTU/ASCII I/O modules:

Note: LAN1: Normal Ethernet Cable, LAN2: Ethernet Crossover Cable, Alive Port: RS-232 Crossover Cable.
COM3, COM4 (RS-485): Data+ to Data+ ; Data- to Data- .
6. It can also equip with two (or more) kinds of I/O modules such as item (2) to (5).

The Win-GRAF redundant system is composed by two PACs. Users need to set one PAC’s rotary switch
to 7 (called Main-PAC) and set the other one to 9 (called Backup-PAC). Do not use two Main PACs or
two Backup PACs to make up a redundant system.
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16.2 Important Communication Ports and Installation Notes
The Win-GRAF redundant PACs require the following three communication ports to communicate with
each other.
1. Alive Port:
The Win-GRAF redundant PACs use one RS-232 Port as the Alive Port (also called Heart-beat Port).
This Alive Port must use a RS-232 crossover cable (or NULL Modem Cable), which link with each
other as the following figure.
Main-PAC
RXD
TXD
GND

Alive Port
(RS-232)

Backup-PAC
RXD
TXD
GND

The different PAC uses different Alive Port like below:
XP-8xx8-CE6: COM5 ; XP-9xx8-CE6: COM5 ; WP-5248: COM1
2. Replication Port:
The Win-GRAF redundant PACs use their Ethernet Port (LAN2) as a Replication Port. Both PAC's LAN2
ports use an Ethernet crossover cable to transfer redundant data. Do not use any Ethernet Switch or
Hub between them, otherwise it may cause an error or timeout. The LAN2 ports are based on fast
Ethernet and dedicated Ethernet ports in order to avoid collisions. So don‘t connect any external
devices, Switches, and Hubs to these two PAC’s LAN2.
Main-PAC (LAN2)

The LAN2 port uses an Ethernet crossover
cable connected directly between two
PAC. (Do not use a normal Ethernet cable).

Backup-PAC (LAN2)

3. Public IP Port:
The Win-GRAF redundant PAC’s Ethernet Port (LAN1) must connect an Ethernet Switch via a normal
Ethernet cable. After that, it can be used to communicate with SCADA/HMI or connect and control
external Modbus TCP I/O modules, devices or other Ethernet devices. The LAN1 port can switch its IP
address automatically. If the PAC is Active, the LAN1 IP address will switch to the "Active_IP" address
which defined in the user’s Win-GRAF project. And if the PAC is Passive, the LAN1 IP address will
switch to the "Active_IP+1" address automatically. The SCADA/HMI can use the "Active_IP" address
to communicate with the Win-GRAF redundant system.
When
switching

Addr. 1
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PAC Installation Notes (Very Important):
1. Before power up PACs, make sure one PAC‘s rotary switch is set to 7 and the other one is set to 9.
The redundant system will be crazy due to the wrong settings.
2. When installing the Win-GRAF redundant system at the application field, make sure the following
three cables are connected properly (connect all required cables, such as RS-485) before power up
PACs. If user power up PACs before connecting these three communication cables, the redundant
system will be out of control.
A. Connect both PAC’s Alive ports by using a crossover cable.
B. Connect both PAC’s LAN2 ports by using an Ethernet crossover cable.
(Do not use any Ethernet Switch/Hub between LAN2 ports.)
C. Connect both PAC’s LAN1 ports to an Ethernet switch by using a normal Ethernet cable.
3. If only one healthy PAC of the redundant system is working properly at the application field, do not
power-off or shut it down. Before user power up the other PAC that will be installed into the system,
follow the step1 and step2 as mentioned above to set up it first.

Connect to
Active IP

Only the Active PAC (i.e., PAC got the control-right) can run the Win-GRAF application. The Passive PAC
will not run the Win-GRAF application. It simply receives the redundant data from the Active PAC and
wait for getting control-right in the future.
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16.3 Description of Demo Programs
The shipping CD of the Win-GRAF PAC provides these three demo programs – "demo_RDN_1.zip",
"demo_RDN_2.zip" and "demo_RDN_3.zip" – related to the redundant system. Refer Chapter 12 to
restore these files into the Win-GRAF Workbench.
Project Name

Description

demo_RDN_1

Two XP-8xx8-CE6 PACs, using their COM3 to connect three DCON I/O modules.

demo_RDN_2

Two XP-8xx8-CE6 PACs without connecting any I/O module.

demo_RDN_3

Two XP-8xx8-CE6 PACs, using their LAN1 to connect a ET-7050 (Modbus TCP I/O
module) through one Ethernet switch.

The following sections will describe the "demo_RDN_2" program.

16.3.1 "I/O Board" Settings
demo_RDN_2, demo_RDN_3:
To use redundancy in the PAC, first link the "i_redundancy" in the "I/O Board" window.
(Refer Chapter 4).

Note: DO NOT set the last digit value
of the "Active_IP" as 0 or 254 or
255. It should be in 1 to 253.
Note:
Using the Slot 9 or later.

Refer the description for more details.

Parameters:
Active_IP: The redundant system provides a public IP address for some HMI/SCADA to
communicate. (Note: DO NOT set the last digit value of the "Active_IP" as 0 or 254 or
255. It should be in 1 to 253.)
Passive_IP: Auto, means the LAN1 IP address of the current Passive PAC, it will be automatically
set as Active_IP +1 (e.g., if the "Active_IP" is set as "192.168.71.37", the "Passive_IP"
will automatically set as "192.168.71.38“)
Mask:
The most common settings are either 255.255.255.0 or 255.255.0.0 (depends on the
network environment).
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After linking the “i_redundancy” in the “I/O Boards” window, it will auto add 12 "BOOL” input channels
in the “Variables” window that can be used to display the current state of the redundant system.

Double-click it to add a variable
name to each channel.

Ch.0 (is_Main_Active):

Is the Main-PAC (rotary switch: 7) active now?
TRUE: Active , FALSE: Passive
Ch.1 (is_Backup_Active):
Is the Backup-PAC (rotary switch: 9) active now?
TRUE: Active , FALSE: Passive
Ch.2 (is_Main_ready):
Is the Main-PAC ready?
If Ch.2 returns FALSE. The possible reason could be the following.
(1) The Ethernet cable (LAN2) between Main and Backup PAC is broken.
(2) The Main PAC is dead or damaged.
(3) The rotary switch of the Main PAC is not set at 7.
Ch.3 (is_Backup_ready):
Is the Backup-PAC ready?
If Ch.3 returns FALSE. The possible reason could be the following.
(1) The Ethernet cable (LAN2) between Main and Backup PAC is broken.
(2) The Main PAC is dead or damaged.
(3) The rotary switch of the Main PAC is not set at 9.
Ch.4 (is_first_cycle_just_after_switch): For Active PAC only.
True: Now is in the first cycle just after switching.
False: Now is not in the first cycle after switching.
Ch.5 (is_Main_LAN1_ok): Is the LAN1 port of the Main-PAC ok?
TRUE: OK , FALSE: Fail or Ethernet cable is disconnected.
Ch.6 (is_Backup_LAN1_ok): Is the LAN1 port of the Backup-PAC ok?
TRUE: OK , FALSE: Fail or Ethernet cable is disconnected.
Ch.7 (is_Alive_port_ok):
True : The communication of the Alive Port is ok.
False: The communication of the Alive port fails or
the Passive PAC is dead or damaged.
Ch.8 (is_Passive_ready):
Is the Passive PAC ready now?
If Ch.8 returns FALSE. The possible reason could be the following.
(1) The Ethernet cable (LAN2) between Main and Backup PAC is broken.
(2) The Passive PAC is dead or damaged.
(3) The rotary switch setting of the Passive PAC is incorrect.
Ch.9 (is_Active_LAN1_ok): Is the LAN1 port of the Active-PAC ok?
TRUE: OK , FALSE: Fail or Ethernet cable is disconnected.
Ch.10 (is_Passive_LAN1_ok): Is the LAN1 port of the Passive-PAC ok?
TRUE: OK , FALSE: Fail or Ethernet cable is disconnected.
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demo_RDN_1: To connect DCON I/O modules via PAC‘s COM3 (RS-485).

Connect DCON I/O modules by
PAC‘s COM3 and the Baud rate
is 9600.

Setting Description

Open COM3 and set the
timeout as 30 seconds.

Setting Description

"i_redundancy_rs485" is used to
check if the RS-485 port of the
Passive PAC can receive data.

Important Notice:
1. Please must also use the "i_redundancy" or the "i_redundancy_rs485" will not work.
2. The "i_redundancy_rs485" will only open the related RS-485 ports to receive data in the passive PAC.
It doesn't send any data.
3. The "i_redundancy_rs485" is used to detect whether the Passive PAC‘s RS-485 port can receive data.
Parameters:
Ch00_Port_No ~ Ch15_Port_No :
The used RS-485 port number of the Passive PAC. Can be 0 or 1 to 33 depends on the PAC model.
Set 0 means disable it.
Ch00_Timeout ~ Ch15_Timeout :
The unit is second. Can be 1 to 60 seconds.
If there is no data received in the timeout interval of the related RS-495 port, the status will reset as
FALSE.
16-ch Boolean Inputs :
It used to represent state of RS-485 ports in the passive PAC.
TRUE : The related RS-485 port open ok and can receive data.
FALSE: The related RS-485 port open fail or receive no data in the timeout interval.
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16.3.2 Declaring Variables (demo_RDN_2)
Users can view or add variables in the "Variable" window (refer Section 2.3)。
Name

Data Type

Description

Year1

DINT

Month1

DINT

Day1

DINT

WeekDay1

DINT

Hour1

DINT

Minute1

DINT

Second1

DINT

Set_new_time

BOOL

Year_to_set

DINT

Month_to_set

DINT

Day_to_set

DINT

Hour_to_set

DINT

Minute_to_set

DINT

Second_to_set

DINT

DINT_1

DINT

DINT_2

DINT

REAL_1

REAL

REAL_2

REAL

TMR_1

TIME

TMR_2

TIME

retain_done

BOOL

on_line_change_cycle

DINT

tmp_bool

BOOL

TRUE: Retain variables are well set up;
FALSE: Not set up yet.
Non-zero, means this is the first cycle just after On-Line
change.
It used to return the Retain status.

TMR_1_last_state

BOOL

TRUE: Ticking ; FALSE: Sleeping.

TMR_2_last_state

BOOL

TRUE: Ticking ; FALSE: Sleeping.

To_tick_TMR_1

BOOL

Set it as TRUE to start TIMER1.

To_tick_TMR_2

BOOL

Set it as TRUE to start TIMER2.

To_stop_TMR_1

BOOL

Set it as TRUE to stop TIMER1.

To_stop_TMR_2

BOOL

Set it as TRUE to stop TIMER2.

Used in the “PAC_Time” program:
They are used to get the PAC’s system time.

Set it as "TRUE" to set up new system time.

Used in the “PAC_Time” program:
They are used to set the PAC’s system time.

Used in the "Retain_and_timer" program:
Set them as retain variables.

Timer
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16.3.3 Introduction of the "demo_RDN_2" Demo Program
LD Program – “PAC_Time”
It used to get/set the system time of PAC.

LD Program – “RDN_control”
When an error occurs on the Active PAC’s LAN1 and if the Passive PAC is ready and its LAN1 is healthy,
then the Active PAC will wait for a short time to reboot, and then the other PAC will take the
control-right.

ST Program – "Retain_and_timer"
(* "on_line_change_cycle" is declared as DINT (nonezero means it is in the cycle jsut
after doing on line change) .
"retain_done" is declared as BOOL and inited as FALSE .
"tmp_bool" is declared as BOOL. *)
on_line_change_cycle := GetSysInfo (_SYSINFO_CHANGE_CYCLE) ;
if (retain_done = FALSE) or
(is_first_cycle_just_after_switch = TRUE) or
(on_line_change_cycle <> 0) then
retain_done := TRUE ; (*just do it one time *)
tmp_bool := Retain_Var( DINT_1 , 1) ; (* retain a DINT variable *)
tmp_bool := Retain_Var( DINT_2 , 2) ;
tmp_bool := Retain_Var( REAL_1 , 3) ; (* retain a REAL variable *)
tmp_bool := Retain_Var( REAL_2 , 4) ;
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(* if Retain variables havn't been inited yet, use default value *)
if (DINT_1 < -1000000) or (DINT_1 > 1000000) or
(DINT_2 < -2000000) or (DINT_2 > 2000000) or
(REAL_1 < -9.9E10) or (REAL_1 > 9.9E10) or
(REAL_2 < -9.9E10) or (REAL_2 > 9.9E10) then
DINT_1 := 0 ;
DINT_2 := 0 ;
REAL_1 := 0.0 ;
REAL_2 := 0.0 ;
end_if ;
end_if ;
(* is_first_cycle_just_after_switch :
TRUE : just in the cycle after switching.
FALSE : other cycle *)
if is_first_cycle_just_after_switch then
(* The Timer ticking state is not auto-redundant. So we have to process them here.
Ticking timer in the cycle just after switching if its last state is "ticking" *)
if TMR_1_last_state then
tStart(TMR_1) ;
end_if ;
if TMR_2_last_state then
tStart(TMR_2) ;
end_if ;
end_if ;
(* Timer operation *)
if To_tick_TMR_1 then
To_tick_TMR_1 := FALSE ;
tStart(TMR_1) ;
TMR_1_last_state := TRUE ;
end_if ;
if To_tick_TMR_2 then
To_tick_TMR_2 := FALSE ;
tStart(TMR_2) ;
TMR_2_last_state := TRUE ;
end_if ;
if To_stop_TMR_1 then
To_stop_TMR_1 := FALSE ;
tStop(TMR_1) ;
TMR_1_last_state := FALSE ;
end_if ;
if To_stop_TMR_2 then
To_stop_TMR_2 := FALSE ;
tStop(TMR_2) ;
TMR_2_last_state := FALSE ;
end_if ;
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16.4 Test Demo Programs
demo_RDN_2: Two PAC (XP-8xx8-CE6) without connecting any I/O modules.

(Rotary Switch)

1. Hardware installation (using XP-8xx8-CE6 as an example):
Refer Section 16.2 – PAC Installation notes, make sure three communication ports of the PAC have
been connected properly and the rotary switch is set to 7 (Main-PAC) or 9 (Backup-PAC).
2. If there is no redundancy app in the redundant system yet (that is, no control-right switching
procedures), start the Main-PAC (7) first and then start the Backup-PAC (9), in that case the Active
PAC will be the Main-PAC.
(Later, users can run the Win-GRAF driver on a PAC‘s monitor to see which one is the Active PAC.)
PAC side:

This PAC is the Active PAC.
(It will appear blank if this is
the Passive PAC.)
Win-GRAF Driver

(1) First, look up the LAN1 IP address of the current Active PAC (factory defaults: IP=192.168.255.1,
Mask=255.255.255.0, refer Section 1.3), and make sure that your PC is on the same network
domain (e.g., IP=192.168.255.x).

The LAN1 IP and Mask
of the Active PAC.
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(2) At the first time to download the Win-GRAF redundancy application, users Must modify the
communication IP address (refer Section 2.3.5 - “Communication Parameters") to the LAN1 IP
address of the current Active PAC.

Communication IP address.

3. Recompile the "demo_RDN_2” project and then download it to the Active PAC (refer Section 2.3.4
and Section 2.3.5 for details). After that, the LAN1 of the Active PAC will be automatically set as the
Active IP (i.e., "192.168.71.37" in this example program, refer Section 16.3.1) and the LAN1 of the
Passive PAC will be set as the Active IP + 1 (i.e., "192.168.71.38") automatically.

The LAN1 IP and Mask of the Active PAC
after running the "demo_RDN_2”.

The LAN1 IP and Mask
of the Passive PAC.

4. Right now, Win-GRAF will show "Communication error" because the current Active PAC IP (e.g.,
192.168.71.37) and the communication IP settings on the workbench (e.g., 192.168.255.1) are not
on the same network domain. So, stop the connection and change the communication IP of this
"demo_RDN_2” project to "192.168.71.37" (refer Section 2.3.5 “Communication Parameters") and
then check if the PC’s IP is on the same network domain (e.g., "192.168.71.x"). Then, this project will
always link to the Active PAC whenever user want to debug it or change it.

Stop the connection.

Communication IP.
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5. After re-connecting with the PAC, click "NewSpy1" to open the spy list window and you can see the
current Active PAC is the Main-PAC.
Note:
Don‘t switch control-right if the Passive
PAC is not ready (i.e., "is_Passive_ready"
= FALSE) because it cannot receive the
redundant data from the Active PAC.
The user can click the "Redundancy"
button () to switch control-right for
testing.

The Main-PAC is active.
The Main-PAC and Backup-PAC
are ready and their LAN1 are
working properly.
The Alive Port (RS-232)
communication is ok.
The Passive PAC is ready.
The Active and Passive PAC’s
LAN1 are working properly.

6. Enter values for "DINT_1", "DINT_2", "REAL_1" and "REAL _1" variables and then set the
"To_tick_TMR_1" and "To_tick_TMR_2" as TRUE (it will auto reset to FALSE) to start the "TMR_1"
and "TMR_2" ticking. Now, the status of TIMER will change from FALSE to TRUE.

Enter a value

Set them to“TRUE”
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7. Make sure the Passive PAC is ready (i.e., is_Passive_Ready is TRUE), remove the LAN1 cable of the
Main-PAC or turn off and on (restart) the Main-PAC. Wait for a short time (refer the “RDN_control”
program), the Main-PAC will automatically reboot and give control-right to the Backup-PAC, Now.
Then, the Active PAC belongs to the Backup-PAC and all the values you set before still exist and the
Timer is still ticking.

Backup PAC
is active.

(Note: After that, plug in the LAN1 cable of the Main-PAC and then later both the status of
"is_Main_LAN1" and "is_Passive_LAN1" variables will become "TRUE".)

demo_RDN_3:
Two XP-8xx8-CE6 PACs, using their LAN1 to connect a ET-7050 (Modbus TCP I/O module) through the
Ethernet switch.

Addr. 1

1. Refer the ET-7000 manual to set up the IP address and required settings (refer Section 5.2.1).
Manual: http://ftp.icpdas.com/pub/cd/6000cd/napdos/et7000_et7200/document/
2. Open and download the "demo_RDN_3" project. Before downloading, set the communication IP
(refer Section 2.3.5 “Communication Parameters") to the current LAN1 IP of the Active PAC (refer
Section 16.4 – Test demo programs - step 2 to 4).
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In the "I/O Drivers" window, here we enable a Modbus TCP Master to connect an ET-7050 module
(Modbus TCP Slave, Addr. = 1) and create some data blocks to read/write the DI and DO data (refer
Section 5.2). Users can open this "demo_RDN_3" project for more details.

To enable a Modbus TCP Master to
connect an ET-7050 module and
create some data blocks to read/write
the DI/DO data, refer the Section 5.2.

3. Click "NewSpy1" to open the spy list, now the Main-PAC is Active.

The Main-PAC is Active.

It allows to switch PAC control-right
only when the Passive PAC is ready.

4. Enter some values for these retain variables (DINT_1, DINT_2, REAL_1 and REAL_2) and set
"To_tick_TMR_1" as "TRUE" to start Timer. If set "ET-7050_Dox" as " TRUE", the
"ET-7050_DOx_ReadBack" will return "TRUE". If disconnect the Ethernet cable from the ET-7050
module, the "ET-7050_COM_error" will return a non-zero value that means communication error.
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5. Make sure the Passive PAC is ready (i.e., "is_Passive_Ready" is "TRUE"), remove the LAN1 cable from
the Main-PAC or turn it off and on (restart), and wait a short time (refer the “RDN_control” program),
the Main-PAC will automatically reboot and give control-right to the Backup-PAC.

Now, the Backup PAC is Active.

Plug in the Main-PAC’s LAN1
cable to return "TRUE".

After switching control-right to the
Backup PAC, all retains value are not
changed and the timer is still ticking.

Non-zero means error.

Set "ET-7050_Dox" as "TRUE",
the "ET-7050_DOx_ReadBack"
will return "TRUE" if the
ET-7050 communication is ok.

demo_RDN_1: Two XP-8xx8-CE6 PACs, using their COM3 to connect three DCON I/O modules.

(9600,8,N,1 No Checksum)
(Data format: 2's compliment)
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In the "demo_RDN_1" demo program (as the figure above), before linking "I-7000" and "I-87KW" DCON
remote I/O modules, users need to configure each of I/O modules by using "DCON Utility". Refer the
descriptions in Chapter 8 and visit the "DCON Utility" web page to download the software and user
manual: www.icpdas.com/products/dcon/introduction.htm
Please restore and open this demo program for more details and refer Section 16.3.1 for "I/O Board"
settings.

16.5 What Kinds of Data Can be Automatically Backed up to the Passive
PAC?
In the Win-GRAF redundant system, not all of the data in the Active PAC can be automatically backed up
to the Passive PAC.
What Can be Backed Up Automatically:
1. The user’s Win-GRAF applications.
2. The execution step of programs.
3. Value of variables.
4. Private data of Function Block instance.
5. The PAC’s RTC (Real Time Clock) time.
6. Retain memory.
7. Schedule-control configuration (refer Chapter 17).
What are NOT Backed Up Automatically?
The following are the most common items that cannot be automatically backed up to the Passive PAC.
1. The status of Timer variable (Ticking or Sleeping).
2. Files in the Active PAC (e.g., files located in the path "\system_disk" or "\Micro_SD", or files not
belong to the Win-GRAF applications, such as C, VB.net, C#, and Soft-GRAF applications). These files
cannot be backed up automatically. So all of them should be pre-installed in a spare (or repaired)
PAC before mounting this PAC in the redundant system).
(Exclusive of user designed Win-GRAF application and schedule-control configuration, which can be
backed up automatically.)
3. If using the COM_OPEN() function to open the serial port, it will not be automatically opened again
after switching PAC control-right.
4. The PAC‘s EEPROM memory cannot be backed up automatically.
All the items which unable to back up automatically, users can use the following similar procedures to
deal with them. (Refer the "Retain_and_timer" program in the "demo_RDN_2" project)
if is_first_cycle_just_after_switch then
(* Just in the cycle after switching. *)
………
end_if ;
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Chapter 17 Schedule Control

Introduction:
All Win-GRAF WinCE series PAC support the Schedule-Control function. One PAC can control max. 10
Targets (devices) with specified schedule configurations. Each schedule Target (device) contains three
variables to be controlled – one BOOL variable, one DINT variable and one REAL variable. ICP DAS
provides a free software – “Schedule-Control Utility”. User can use this software to edit /modify the
schedule configurations easily in PC or in PAC.
Driver version of Win-GRAF PAC:
The Win-GRAF PAC supports Schedule-Control in the below driver version and the new version.
WinCE PAC

Win-GRAF PAC

Driver Version

ViewPAC

V-25W8, VP-4138

1.02

WP-8000

WP-8148, WP-8448, WP-8848

1.02

WP-5000

WP-5238, WP-5248

1.01

XP-8000-CE6

XP-8048-CE6, XP-8348-CE6, XP-8748-CE6

1.01

XP-9000-CE6

XP-9148-CE6, XP-9348-CE6, XP-9748-CE6

1.01

You may download newer Win-GRAF driver at
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-dri
ver.html
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17.1 Install the Schedule-Control Utility and Restore the Win-GRAF Demo
Project
There is one Win-GRAF-PAC-CD in the Win-GRAF PAC package box. The Schedule-Control Utility file
name is “Schedule_in_PC.exe” in the “CD:\napdos\Win-GRAF\Tools_Utility\” path.
Please copy this Schedule-Control Utility (“Schedule_in_PC.exe”) to your PC. Recommend to copy it to
the directory of your Win-GRAF project. For instance, copy it to
“D:\Schedule-Control\Station1\Schedule_in_PC.exe “, then run this “Schedule_in_PC.exe” file.
Then we will see the following windows (Click New > Target 1).

There is one another Schedule-control utility, however it is set up in the PAC (not in the PC). It is
“Schedule_in_PAC.exe”. You can find it in the “\System_Disk\Win-GRAF\” path of the Win-GRAF
WinCE PAC.
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Restore Win-GRAF demo project :
The Win-GRAF demo project for the Schedule-Control is “demo_schedule.zip”. It is in the
“\napdos\Win-GRAF\demo-project\” path of the Win-GRAF-PAC-CD. Restore it to the PC / Win-GRAF
workbench by the following way.
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17.2 Introduction of the “demo_schedule” project
This “demo_schedule” project shows the way to do schedule-control. Please prepare one Win-GRAF PAC
(like VP-25W8 or WP-8448) . One PAC can control schedules of max. 10 Targets (Target 1 to Target 10) .
Each Target contains one BOOL, one DINT and one REAL variable.
Settings in the “I/O boards” window :
To enable schedule-control in the Win-GRAF PAC, first click the “Open I/Os” to add one “Schedule” (add
it in the slot number 8 or bigger number). There is a “Password” parameter in its “Properties” window.
The “Password” is for the “Schedule-Control Utility” running in PC to identify the authorization when
connecting the Win-GRAF PAC. It is set as 0 in this demo project. After adding the “Schedule” in the “I/O
boards”, we can find 10 BOOL input channels in the “variables” window. These 10 channels return the
state of the schedule-control of the Target 1 to 10. TRUE means the Target has the schedule-control
enabled by the “Schedule-Control utility”. FALSE means not enabled.

I/O Board – Schedule has 10 BOOL
inputs. They indicate if the released
Target 1 ~ 10 has enable the
schedule-control or not.

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

17-4

Variable declaration:
Click the “Variables” to view all variables in this demo project.

The above variables - "Target_01_BOOL ~ Target_10_BOOL” , “Target_01_DINT ~ Target_10_DINT” and
“Target_01_REAL ~ Target_10_REAL” - will be controlled by the Win-GRAF PAC. They represent these
variables belong to the 10 Targets .
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To be controlled correctly by the schedule configurations, these variables that described as above should
be dragged into the “Punlic” area of the “Binding” window and then be assigned with correct “Identifier”
number from 5001 to 5030.

User may select the
“Identifier” field of
Target_01_... ~
Target_10_... variables.
Then, click “Iterate
property” to assign
continuous number.
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17.3 Edit schedule configurations by the Schedule-Control Utility
Here shows a simple example to use the Schedule-Control Utility, refer the Section 17.5 for details.
1. Execute the Schedule-Control Utility (Schedule_in_PC.exe) in the PC.
(Click “New” and click “Target 1” to open the Schedule setting window for the “Target 1”).

2. Enable/Set the Season and Schedule Date.
(1) Check “Target 1 ” box to enable and set
the Target 1.
(2) Click “Season Always”.
(3) Check “Season Always” box to enable it.
(4) Click “Normal Day” item (Normal day is usually used for Monday ~ Friday.)
(5) Check “Normal Day” box to enable it and then set proper settings (e.g. Monday ~ Friday).
(6) Click “Schedule 1” to set the schedule period for the “Schedule 1”.

1

The “*”
means that
item is
enabled.

3
2

5

6

4

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

17-7

3. Set the Schedule Period
After selecting "Schedule 1" in the step2 – (6), do the following steps.
(1) Check “01” to enable the setting for the No. 01 Time Period of the Schedule 1.
(A) Set up the time as the figure below, or the time which easily for testing.
(B) Set up the Boolean, Integer, Real variables to the values that you want to control, or follow
the setting in the figure below.
(2) Check “02” to enable the setting for the No. 02 Time Period, such as the step (1).
Each schedule can set up a max. of 15 Time Periods.
After completing the settings, click “Save and exit” to save and exit this window.

4. Then, it will go back to the previous setting window as the figure below. And, the “*” symbol show
on the screen means the season or schedule has been configured.
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7

6
5

出現星號 * 表示已設定

5. “Default Value” (in the upper right) is for the default setting. If the current date is not found in any
Schedule setting or the date is found, however, its time period is not found in the related Schedule
1 ~ 5, the Target device will be controlled follow the “Default Value”. The “Default Value” in this
demo project is “Boolean: OFF, Integer: 0, Real: 0.0” .
Advantage of the Default Value:
Utilizing the "Default Value" can reduce the amount of the Periods setting in the Schedule 1 ~ 5.
Ex: The following example sets 5 Periods in the Schedule 1.
(1) 00:00 ~ 08:00 OFF 0 0.0
(2) 08:00 ~ 09:50 ON 0 0.0
(3) 09:50 ~ 10:00 OFF 0 0.0
(4) 10:00 ~ 11:50 ON 0 0.0
(5) 11:50 ~ 24:00 OFF 0 0.0
If utilize the "Default Value" as "OFF, 0, 0.0", the user just needs to set 2 Periods as below.
(1) 08:00 ~ 09:50 ON 0 0.0
(2) 10:00 ~ 11:50 ON 0 0.0
6. After completing all settings, click “Save to PC” to save a configuration file in PC.
(This demo uses “test1.txt”)
7. Click “Back” to return to set up other Targets. (This demo sets Target 1 only)
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17.4 Testing this demo
This section shows the way to implement the Win-GRAF project and schedule configuration in the
Win-GRAF PAC. Then testing the schedule control.
1. Download the “demo_schedule” project to the PAC by the Win-GRAF workbench.
(For more information, refer the Section 2.3.5)
2. Download the schedule configuration to the PAC by the Schedule-Control Utility.
(1) Click “Send to Controller”.
(2) Assign the PAC’s IP address (remember to fill in your PAC’s IP address)
Set a password (This demo uses “0”)
Check “Remember Password” can remember this password
Click “OK” to send the schedule setting to the PAC.
(3) If success, it will pop up a “Send file success” window.

1

2

3

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

17-10

3. Test the Win-GRAF project:
Click “On Line” to connect the PAC by the Win-GRAF workbench, then open the “NewSpy1” window.
If the connection is fine, we can see variables - Target_01_xxx ~ Target_10_xxx are controlled
properly by the schedule configurations which is set by the “Schedule-Control Utility”.
The user may use the “Schedule-Control” Utility to modify the schedule configurations and then
download to the Win-GRAF PAC to see if those variables are controlled well.

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

17-11

17.5 Configurations of the Schedule-Control Utility
17.5.1 Address for each Target Variables
The Schedule-Control Utility can configure max. 10 Target ‘s schedule. Each Target contains one BOOL
variable, one DINT variable and one REAL variable.
To enable the schedule-control in the Win-GRAF PAC, first add a “Schedule” in the “I/O boards” windows
(refer Section 17.2). The user can declare all required variables in the “Variables” window, and add these
variables in the “Binding" window and then assign correct “Identifier” number 5001 ~ 5030 (refer
Section 17.2 - Variable declaration). After downloading the Win-GRAF project to the PAC, the scheduling
will control these variables well.
Address

Type

5001

BOOL

5002

DINT

5003

REAL

5004

BOOL

5005

DINT

5006

REAL

5007

BOOL

5008

DINT

5009

REAL

5010

BOOL

5011

DINT

5012

REAL

5013

BOOL

5014

DINT

5015

REAL

Description
BOOL, DINT and REAL
variable controlled
by Target 1

BOOL, DINT and REAL
variable controlled
by Target 2

BOOL, DINT and REAL
variable controlled
by Target 3

BOOL, DINT and REAL
variable controlled
by Target 4

BOOL, DINT and REAL
variable controlled
by Target 5

Address

Type

5016

BOOL

5017

DINT

5018

REAL

5019

BOOL

5020

DINT

5021

REAL

5022

BOOL

5023

DINT

5024

REAL

5025

BOOL

5026

DINT

5027

REAL

5028

BOOL

5029

DINT

5030

REAL
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Description
BOOL, DINT and REAL
variable controlled
by Target 6

BOOL, DINT and REAL
variable controlled
by Target 7

BOOL, DINT and REAL
variable controlled
by Target 8

BOOL, DINT and REAL
variable controlled
by Target 9

BOOL, DINT and REAL
variable controlled
by Target 10
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17.5.2 Target Configuration
Every Win-GRAF WinCE PAC can control maximum 10 “Target” (Target 1 to Target 10) devices. First,
execute the Schedule-Control Utility and click “New” to create a new configuration file, the Targets will
show as 10 buttons (See the figure below). The default Target names are “Target 1” ~ “Target 10”. One
Target can set up the schedules to fit different Seasons. The Target button will show a “*” to distinguish
it is enabled.
Addition to “New” a configuration file, the user can open an existing file in PC or get from the PAC.
New:
Create a new file.
Open from PC:
Open an exist configuration file from PC.
Get from Controller: Get an existing configuration file from PAC (required enter the PAC 's IP and
password) and then to show on the PC.

Change the Target Name to meet the needs of the field:
User can change the name of the Target, Season or other items to fit for the equipment at the
application field. Please create a text file named “Label_Name.txt” (as the figure below) and save it in
the same folder with the Schedule-Control Utility “Schedule_in_PC.exe” (Such as
D:\Schedule-Control\Station1\Label_Name.txt).
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Notes for creating the file “Label_Name.txt”:
1. If this file does not exist, the Target will show an English default name (e.g., Target 1, Target 2).
2. In this file, the text after " : " is the Target name that you want to change.
(E.g., “工廠”, the spaces will be erased.)
3. This file must save as the “Unicode” format. User can create and edit it by the MS Notepad or other
editors, but must select the “Unicode” format when save it.
4. In the PAC, copy this file into the same folder with the Schedule-Control Utility. That is
“\System_Disk\Win-GRAF\”
5. User can change the Season, Normal day, Holiday, Schedule and other item’s name by the same
way.
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17.5.3 Season Configuration
Each “Target” (1 ~ 10) includes the “Season Always”, “Season 1”, “Season 2”, “Season 3” and “Season 4”
setting items. The user can enable or disable each item according to application needs.
The Searching Priority of Seasons:
1. PAC will first search the Season 4 (if it is enabled)
If found the current date in the Season 4, then do the Boolean/Integer/Real control.
2. If not found, then search the Season 3, Season 2…, at last search the Season 1.
3. If not found, then search the Season Always to do its control.
4. If not found the current date in this Target, then do the “Default Value” control.

6

5

4

3

2

1

Season Setting:
Season 1 ~ 4 need to set its “Date Period” (i.e.," From" Year/Month/Day, “To” Year/Month/Day).
Note 1: The Date Periods of the 4 Seasons must not overlap, but can cross the year-end.
Note 2: The Periods of Season 1 ~ 4 need not in a date order (e.g., Season 1’s date period can be later
than Season 2), but not overlap each other.
Note 3: If the "Every Year" is checked, the system diagnoses the overlap of Month/Day only, not the
year. If the "Every Year" is not checked, it will diagnose the “From” Year/Month/Day should be
earlier than the “To” Year/Month/Day, and the Year must not earlier than 2013.
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For example:
1. The Correct Setting: User can check “Every Year”, so that the setting will be used for every year.
Season 1

2013/01/01 ~ 2013/03/31

Season 2

2013/04/01 ~ 2013/07/15

Season 3

2013/07/16 ~ 2013/09/30

Season 4

2013/10/01 ~ 2014/01/18 (can cross the year-end)

2. The Wrong Setting: Because 2013/03/16 ~ 2013/03/31 overlaps in the Season 1 and Season 2
Season 1

2013/01/01 ~ 2013/03/31

Season 2

2013/03/16 ~ 2013/07/15

Season 3

2013/07/16 ~ 2013/12/31

Season 4

Disabled

3. The Correct Setting: The Season 1 is later than other Seasons, but the Periods don’t overlap.
Season 1

2014/01/19 ~ 2014/03/31

Season 2

2013/04/01 ~ 2013/07/15

Season 3

2013/07/16 ~ 2013/09/30

Season 4

2013/10/01 ~ 2014/01/18
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17.5.4 Normal Day / Holiday / Special Day Configuration
There are Normal day, Holiday 1, Holiday 2 and Special day in each Season.

Normal day

The normal days usually are Monday ~ Friday.
When enabled, the user must select one of the Schedule options (1 ~ 5).

Holiday 1

Holiday 1 (e.g., normally are Saturday or Sunday).
When enabled, the user must select one of the Schedule options (1 ~ 5).

Holiday 2

Holiday 2 (e.g., Some cases need 2nd different Holiday, such as Monday).
When enabled, the user must select one of the Schedule options (1 ~ 5).

Special Day

Used for special Holidays or for the make-up workdays, such as 10/10, 7/4, 10/1,
12/25, and so on. One Season can set up maximum 50 Special days.
When enabled, the user must select one of the Schedule options (1 ~ 5).

B

A

A. The Searching Priority of Normal Day / Holiday / Special Day:
The PAC will first search “Special day”. If the date is not found in this Special day setting, then
search “Holiday 2”, then “Holiday 1”, and then “Normal day”.
B. Default Value for Boolean / Integer / Real:
Each Target must set the default value for the Boolean, Integer and Real variables. The default value
is mainly set to use when the PAC cannot find the current date in any “Date Period” in the enabled
“Season 1 ~ 4” and “Season Always”, or the current date is found, however cannot find the current
time in any “Time Period” in the related Schedule 1 to Schedule 5. Then the PAC follows the setting
of the Default Value. Usually, the Default Value of Boolean is set to be “OFF”, the Integer and Float
value are set to be “0”. User can set the different Default Value by the case.
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C. Date Setting for Normal day / Holiday 1 / Holiday 2:
Note that NO OVERLAP. For example,
The Correct Setting:
Normal day

Monday，Tuesday，Wednesday，Thursday，Friday

Holiday 1

Sunday，Saturday

Holiday 2

Disabled

The Wrong Setting: (Because “Friday” overlaps in the setting of “Normal day” and “Holiday 2”.)
Normal day

Monday，Tuesday，Wednesday，Thursday，Friday

Holiday 1

Saturday

Holiday 2

Sunday，Friday

D. Date Setting for Special Day:
The “Special day” is for special schedule, such as the special holidays or make-up workdays. Each
Season can set maximum 50 Special days. The searching priority of the “Special day” is higher than
the priority of Holiday 2 and Holiday 1 and Normal day. Each enabled “Special day” date must select
a Schedule number (1 ~ 5) to be applied.

2
3

1

4

5
7
6

8
9
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17.5.5 Schedule Configuration
Each Season can set up maximum 5 Schedules (Schedule 1 ~ 5), and each Schedule can set up maximum
15 Time Periods. The time unit is “minute”, in the range of “00:00 ~ 24:00”.

EX: The following setting is correct.
No.

Time Period

Boolean

Integer

Real

01

00:00 ~ 08:00

OFF

100

30

02

08:00 ~ 12:00

ON

150

25.5

03

12:00 ~ 13:00

OFF

120

27

04

13:00 ~ 17:00

ON

150

25.5

05

17:00 ~ 24:00

OFF

100

30
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The Searching Priority of Time Period:
The searching priority of the Time Period in the schedule is in the order from the largest number to the
smallest number.
For example, the following table shows five Time Periods settings .
No.

Time Period

Boolean

Integer

Real

01

00:00 ~ 08:00

OFF

100

30

02

08:00 ~ 12:00

ON

150

25.5

03

12:00 ~ 13:00

OFF

120

27

04

13:00 ~ 17:00

ON

150

25.5

05

17:00 ~ 24:00

OFF

100

30

1. The searching will in the order from No. 5 to No. 1 (05 , 04 , 03 , 02 , 01). If the Time Period
overlaps, the PAC will follow the larger number setting to control the schedule.
2. If the PAC cannot find the current time in any Time Period in the “15” ~ “01”, it follows the
setting of "Default Value".
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17.5.6 Save and Send to the PAC
When complete the configurations, please save and then send it to the PAC:

1. Click “Save to PC” to save the configuration file (“ *.txt ”).

2. Click “Send to Controller” to send the configuration file to the linked PAC. Please assign the PAC IP
address and set up the password. Check the “Remember password” can save the password for
speeding the next sending process.

PAC IP address
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17.5.7 Time Synchronization
If the PAC has not synchronized the system time after working a long period (e.g. one year), the time
may be differ over 10 seconds to a few minutes. For the time synchronization of the controller, the
Schedule-Control Utility provides a function to set the PAC time from the PC.

Steps:
1. Your PC must connect to an Ethernet Switch and then to the Win-GRAF PAC by using
Ethernet cables.
2. Click “Controller Time Synchronization” button.
3. Set a new date, hour, minute and second.
4. Click “Set new Controller time” button to set the new time to the PAC.

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

17-22

17.5.8 Schedule-Control Utility in PAC Site
The configuration process in the PAC side is similar as the process in the PC side, just a little bit different
on the screen. Please refer the Section 17.5.2 ~ 17.5.6.
1. Target Configuration:

2. Season Configuration:

Win-GRAF User Manual, V 1.01, Oct. 2014 by ICP DAS

17-23

3. Special Day Configuration:

4. Schedule Configuration:
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17.5.9 Using Schedule-Control in the Soft-GRAF
The Soft-GRAF Studio supports Schedule-Control Utility since Version 1.09.
The user just needs to fill “201” in the “To Which page” of the “g_ToPage” Object, and then, when the
user clicks the “g_ToPage” button on the HMI page in the PAC, the Schedule-Control Utility will be
executed.

For more Soft-GRAF Studio information, please refer to FAQ-146 at the ISaGRAF FAQ web site:
ICP DAS Web > Product > Solutions > Soft PLC, ISaGRAF & Soft-GRAF HMI > ISaGRAF >
Download – FAQ > FAQ-146 .
There is a Soft-GRAF demo project “demo_soft_graf_schedule.zip” in the Win-GRAF-PAC-CD ‘s
“\napdos\Win-GRAF\demo_project\Soft-GRAF-demo\” path. The user may copy it to the PC and then
unzip it. Then run the Soft-GRAF Studio to open it and download this demo project to the Win-GRAF
PAC .
Note: PAC should run the Win-GRAF project “demo_schedule” (it enables “soft_GRAF” in the “I/O
boards” window), or the Soft-GRAF studio can not download the “demo_soft_graf_schedule” to
that PAC.
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Appendix A

Data types and Ranges

Users can specify the data type of variables in the Variables Area (refer the Section 2.2.1) or in the
Variables window (refer the Section 2.2.2).

Below are the available basic data types and ranges:
Data types
BOOL (*)

Size in-bits
---

Range of Values
TRUE, FALSE

SINT

8-bits (Small int, signed)

-128 to +127

8-bits (Unsigned small int)

0 to +255

16-bits (Int, signed)

-32768 to +32767

16-bits (Unsigned int)

0 to +65535

32-bits (Double int, signed)

-2147483648 to +2147483647

32-bits (Unsigned double int)

0 to +4294967295

64-bits (Large int, signed)

-263 to +(263-1)

64-bits (Unsigned large int)

0 to +(264-1)

REAL (*)

32-bits (Floating point)

±3.4×10-38 to ±3.4×1038

LREAL

64-bits (Floating point)

±1.7×10-308 to ±1.7×10308

STRING (*)

A max. of 255 characters

---

USINT
BYTE
INT
UINT
WORD
DINT (*)
UDINT
DWORD
LINT
ULINT

LWORD
Note: All the Win-GRAF PAC does not support the “ULINT” and “LWORD” data type.

TIME (*)
32-bits
(*): The commonly used data type.

T#0ms to T#23h59m59s999ms
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Appendix B

Troubleshooting while On-Line the PAC

If the error message is showing up (as the screenshot below) after connecting to the Win-GRAF PAC,
refer the following content to solve the problem.
 The “Bad version!” error message:
It means that the compiled version between the PC and the PAC is different. The most common
reason is that users have modified and re-compiled the program.
To solve the problem
1. Click the “Stop application” button to stop the running program.

2. Click the “Download” button to download the program again.

3. The “RUN” message means that the program is working properly.
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 The “Communication error” error message:
A communications failure has occurred between the PC and the PAC.

To solve the problem
1. Make sure your Win-GRAF PAC is started, and the network communication between the PC and the
PAC is functioning properly.
2. Make sure the IP setting of the Win-GRAF project is the same as the PAC IP (refer the Section 2.3.5,
in this example, the IP address is “192.168.255.1:502”).
3. Make sure the network communication of your PC is working.
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Appendix C

Enable the Screen Saver of WinCE PAC

Please set the following two items to enable the screen of WinCE PAC.
1. Choose “Control Panel” > “Power” > “Schemes”, and set the “Power Scheme” as “AC Power”, set the
“User Idle” and the “System Idle” to the same value (or set the “System Idle” value larger than the
“User Idle” value).
2. Then, remember to run “WinPAC Utility” > “File” > “Save and Reboot” to save the settings and auto
reboot the PAC.
Using the WP-8xx8 as an example:
If users do not touch the screen or button until the time out (e.g., 1 minute), the WP-8xx8 will turn off
the backlight for enabling the screen saver. Whenever users touch the screen or button, the WP-8xx8
will turn on the backlight again.
The way to disable the screen saver is to set the “User Idle” and the “System Idle” as “Never”, and then
remember to run “WinPAC Utility” > “File” > “Save and Reboot” to save the settings and auto reboot the
PAC.

1
3

2
3.1

3.2
3.3

4

5
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Appendix D

Using Expansion RS-232/485/422

The Win-GRAF PAC (See P1-1) expand more COM port in its slot No. 0 to 7 by using following modules.
I-8112iW :
I-8114iW :
I-8114W :
I-8142iW :
I-8144iW :

2-port Isolated RS-232 module
4-port Isolated RS-232 module
4-port RS-232 module
2-port Isolated RS-422/RS-485 module
4-port Isolated RS-422/RS-485 module

Note: The WP-5xx8 does not support
XW-5xx series XW-board.
(This PAC can not expand COM port.)

Using the WP-8xx8 as an example:
Before using these modules, please configure them by using the “WinPAC Utility”. First, plug the module
in the WP-8xx8’s slot 0 to 7 (It is better to be in slot 0 to 3), and then run the “WinPAC Utility”.






Click the “Multi-serial port wizard” tab.
Check the“USE COMx” option. (Note: The Win-GRAF doesn’t support “USE MSA/MSBx”)
Click the “Slot scan” button, and then the current found serial-port expansion module will be listed
on the left. (The earlier COM port setting is listed on the right if you have already set it before.)
Click the “Set” button to refresh the new setting like the figure below.
Click [File] > [Save and Reboot] to save the new setting and auto reboot the WP-8xx8.

2

1

2.2

2.3

2.1
Select “USE COMx” option

3
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After the configuration succeeds, the COM port No. for the expansion is COM6 to COM37 in the
Win-GRAF definition. (In this case, it expands the COM6 to COM9).

Pin Assignment:
I-8112iW
2-port Isolated RS-232

I-8142iW

I-8114iW
4-port Isolated RS-232

I-8114W
4-port RS-232

I-8144iW
I-8142iW (2-port Isolated RS-422/485)
RS-485 port1: (D1+ , D1-)
RS-485 port2: (D2+ , D2-)
RS-422 port1: (TxD1+ , TxD1-, RxD1+, RxD1-)
RS-422 port2: (TxD2+ , TxD2-, RxD2+, RxD2-)
I-8144iW (4-port Isolated RS-422/485)
RS-485 port1: (D1+ , D1-)
RS-485 port2: (D2+ , D2-)
RS-485 port3: (D3+ , D3-)
RS-485 port4: (D4+ , D4-)
RS-422 port1: (TxD1+ , TxD1-, RxD1+, RxD1-)
RS-422 port2: (TxD2+ , TxD2-, RxD2+, RxD2-)
RS-422 port3: (TxD3+ , TxD3-, RxD3+, RxD3-)
RS-422 port4: (TxD4+ , TxD4-, RxD4+, RxD4-)
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Appendix E Enabling a Serial Port for Connecting the
Win-GRAF Workbench
(In this section we use the WP-8xx8 as an example to show the way to enable the serial port for
connecting the WinGRAF Workbench and this way is also applied to other Win-GRAF PACs.)
The Win-GRAF PAC’s Ethernet Port is typically enabled for the Win-GRAF Workbench to debug or
download or upload the project. If users want to enable a serial port (i.e., RS-232 or RS-485) for doing
these operations, follow the way as below:
Method 1:
When the Win-GRAF PAC is turned on, it will try to read a “Extra_Ports.txt” file in the path
“\System_Disk\Win-GRAF\”, and the contents are shown like below.

COM1:19200,N,8,1

It means to enable the COM1 and
the Baud Rate is 19200 bps

If you want to enable the COM2 and its Baud Rate is 9600 bps, modify the contents as below.

COM2:9600,N,8,1

So, put this text file to the path “\System_Disk\Win-GRAF\” by FTP and then reboot the PAC.
Disable the COM Port:
If you want to cancel this COM Port setting, simply delete the “Extra_Ports.txt” file in the PAC
( \System_Disk\Win-GRAF\Extra_Ports.txt) and then reboot the PAC.
Method 2:
Users can find out a "demo_extra_port" demo program in the shipment CD. First, restore this zip file
(refer the Chapter 12) and then mouse double click "ST1" to modify this program. Finally, compile and
download this program to the PAC (refer the Section 2.3.5).

In this example, it writes the string ‘COM1:19200,N,8,1’
into the file, which means to enable the COM1 and its
Baud Rate is 19200 bps. Change the COM Port number
and baud rate to whatever you want to use and compile
this program again.
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Test the program:
1. After connecting the Win-GRAF PAC, set the variable -"Create_extra_port" as "TRUE" in the Spy list.
In this example, it will add a file -"Extra_Ports.txt" into the path "\System_Disk\Win-GRAF\" and the
content is “COM1:19200,N,8,1”.
2. Set the"Reset_PAC" variable as "TRUE", and then the PAC will auto reboot and apply the setting.

Double-click

In the Win-GRAF Workbench, if you want to connect to the Win-GRAF PAC through the serial port. Refer
the Section 2.3.5 – Step 1 to 2, and select the "Serial link" option for connecting the PAC via COM Port.

Select the available COM Port
number on your PC. In this
example, Baudrate = 19200 bps.

Disable the COM Port:
If you want to cancel this COM Port setting, simply set the
"Delete_extra_port" variable as "TRUE", it will delete the
“Extra_Ports.txt” in the path (PAC: \System_Disk\Win-GRAF\).
Then, set the "Reset_PAC" variable as "TRUE" to auto reboot
the PAC.
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Appendix F Pin Assignment of PAC’s Serial Ports
WP-8448/8848:
Pin assignment of COM1 to COM4.
COM1: RS-232

COM2: RS-485

COM3: RS-232/485

COM4: RS-232

Note: WP-8148 has no COM3, COM4.
XP-8048-CE6/8348-CE6/8748-CE6:
Pin assignment of COM1 to COM5.
COM1: RS-232

External COM1 for XP-8048-CE6 only;
The COM1 of XP-8348-CE6/8748-CE6 is for internal communications
with I-87KW modules in slots only.

COM2: RS-232

COM3: RS-485

COM4: RS-232/485
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COM5: RS-232

VP-25W8, VP-4138:
Pin assignment of COM2 and COM3.
VP-25W8
COM2 : RS-485

VP-4138
COM3 : RS-232

COM2 : RS-485
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COM3 : RS-232

